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Notice
Every effort was made to ensure that the information in this book was complete and
accurate at the time of printing. However, information is subject to change.

Federal Communications Commission (FCC)
Electromagnetic Interference Information
This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference, in which case the
user will be required to correct the interference at his own expense.

Canadian Department of Communications (DOC)
Interference Information
This digital apparatus does not exceed the Class A limits for radio noise emissions set
out in the radio interference regulations of the Canadian Department of Communications.

Le Présent Appareil Numérique n’émet pas de bruits radioélectriques dépassant les
limites applicable aux appareils numériques de la class A prescrites dans le Règlement
sur le brouillage radioélectrique édicté par le ministère des Communications du Canada.

Trademarks
MERLIN LEGEND is a trademark of AT&T in the U.S. and other countries.
Support Telephone Number
AT&T provides a toll-free customer Helpline (1-800-628-2888) 24 hours a day
(U.S.A. only). Call the Helpline, or your authorized dealer, if you need assistance when
installing, programming, or using the system.
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CUSTOMER WARNING

This manual is designed for use by qualified service technicians
only. Technician qualification includes completion of an AT&T
hands-on instructor-led course covering installation and
maintenance for this product. Installation or maintenance of this
product by anyone other than a qualified service technician may
void the warranty. Hazardous electrical voltages are present
inside this product.

The exclamation point in an equilateral triangle is
intended to alert the user to the presence of
important operating and maintenance (servicing)
instructions in the literature accompanying the
product.

IMPORTANT SAFETY INSTRUCTIONS

When installing telephone equipment, always follow basic safety precautions
to reduce the risk of fire, electrical shock, and injury to persons, including:

Read and understand all instructions.

Follow all warnings and instructions marked on or packed with the
product.

Never install telephone wiring during a lightning storm.

Never install a telephone jack in a wet location unless the jack is
specifically designed for wet locations.

Never touch uninsulated telephone wires or terminals unless the
telephone wiring has been disconnected at the network interface

Use caution when installing or modifying telephone lines.

xvii



Use only AT&T-manufactured MERLIN LEGEND™ Communications
System circuit modules, carrier assemblies, and power units in the
MERLIN LEGEND Communications System (511A) control unit.

Use only AT&T-recommended/approved MERLIN LEGEND
Communications System accessories.

If equipment connected to the analog station modules (008, 408,
408 GS/LS) or to the MLX telephone modules (008 MLX, 408 GS/LS-
MLX) is to be used for in-range out-of-building (IROB) applications,
IROB protectors are required.

Do not install this product near water, for example, in a wet basement
location.

Do not overload wall outlets, as this can result in the risk of fire or
electrical shock.

The MERLIN LEGEND Communications System is equipped with a
three-wire grounding-type plug with a third (grounding) pin. This plug
will fit only into a grounding-type power outlet. This is a safety feature.
If you are unable to insert the plug into the outlet, contact an electrician
to replace the obsolete outlet. Do not defeat the safety purpose of the
grounding plug.

The MERLIN LEGEND Communications System requires a
supplementary ground.

Do not attach the power supply cord to building surfaces. Do not allow
anything to rest on the power cord. Do not locate this product where
the cord will be abused by persons walking on it.

Slots and openings in the module housings are provided for ventilation.
To protect this equipment from overheating, do not block these
openings.

Never push objects of any kind into this product through module
openings or expansion slots, as they may touch dangerous voltage
points or short out parts, which could result in a risk of fire or electrical
shock. Never spill liquid of any kind on this product.

Unplug the product from the wall outlet before cleaning. Use a damp
cloth for cleaning. Do not use cleaners or aerosol cleaners.
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Customer Support Information

Support Telephone Number
In the U.S.A. only, AT&T provides a toll-free customer Helpline (1-800-628-2888)
24 hours a day. Call the Helpline, or your authorized dealer, if you need assistance
when installing, programming, or using your system.

Outside the U.S.A., if you need assistance when installing, programming, or using
your system, contact your authorized AT&T dealer.

Federal Communications Commission (FCC)
Electromagnetic Interference Information
This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference,
in which case the user will be required to correct the interference at his own expense.

Canadian Department of Communications (DOC)
Interference Information
This digital apparatus does not exceed the Class A limits for radio noise emissions set
out in the radio interference regulations of the Canadian Department of
Communications.

Le Présent Appareil Numérique n’émet pas de bruits radioelectriques depassant Ies
Iimites applicable aux appareils numériques de la class A prescribes clans Ie
reglernent sur Ie brouiilage radioelectrique edicté par Ie ministère des Communications
du Canada.
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FCC Notification and Repair Information
This equipment is registered with the FCC in accordance with Part 68 of its rules. In
compliance with those rules, you are advised of the following:

■     Means of Connection. Connection of this equipment to the telephone network
shall be through a standard network interface jack: USOC RJ11C, RJ14C,
RJ21X. Connection to E&M tie trunks requires a USOC RJ2GX. Connection to
off-premises stations requires a USOC RJ11C or RJ14C. Connection to 1.544-
Mbps digital facilities must be through a USOC RJ48C or RJ48X. Connection
to DID requires a USOC RJ11C, RJ14C, or RJ21X. These USOCs must be
ordered from your telephone company.

This equipment may not be used with party lines or coin telephone lines.
■     Notification to the Telephone Companies. Before connecting this

equipment, you or your equipment supplier must notify your local telephone
company’s business office of the following:

The telephone number(s) you will be using with this equipment.
—     The appropriate registration number and ringer equivalence number

(REN), which can be found on the back or bottom of the control unit,
as follows:

If this equipment is to be used as Key System, report the number
AS593M-72914-KF-E.
If the system provides both manual and automatic selection of
incoming/outgoing access to the network, report the number
AS593M-72682-MF-E.
If there are no directly terminated trunks, or if the only directly
terminated facilities are personal lines, report the number
AS5USA-65646-PF-E.
The REN for all three systems is 1.5A.

—     For tie line connection, the facility interface code (FIC) is TL31M and
the service order code (SOC) is 9.0F.
For connection to off-premises stations, the FIC is OL13C and the
SOC is 9.0F.
For equipment to be connected to 1.544-Mbps digital service, the FIC
is 04DU9-B for D4 framing format or 04DU9-C for extended framing
format, and the SOC is 6.0P.
For equipment to be connected to DID facilities, the FIC is 02RV2-T
and the SOC is 9.0F.

—      The quantities and USOC numbers of the jacks required.
— For each jack, the sequence in which lines are to be connected: the

line types, the FIC, and the REN by position when applicable.
You must also notify your local telephone company if and when this equipment
is permanently disconnected from the line(s).

The REN is used to determine the number of devices that maybe connected to
the telephone line. Excessive RENs on the

x x Customer Support Information

line may result in the devices not
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ringing in response to an incoming call. In most, but not all, areas the sum of
the RENs should not exceed five (5.0). To be certain of the number of devices
that may be connected to the line, as determined by the total RENs, contact the
telephone company to determine the maximum REN for the calling area.

Installation and Operational Procedures
The manuals for your system contain information about installation and operational
procedures.

Repair Instructions. If you experience trouble because your equipment is
malfunctioning, the FCC requires that the equipment not be used and that it be
disconnected from the network until the problem has been corrected. Repairs
to this equipment can be made only by the manufacturers, their authorized
agents, or others who may be authorized by the FCC. In the event repairs are
needed on this equipment, contact your authorized AT&T dealer or, in the
U.S.A. only, contact the National Service Assistance Center (NSAC) at
1-800-628-2888.
Rights of the Local Telephone Company. If this equipment causes harm to
the telephone network, the local telephone company may discontinue your
service temporarily. If possible, they will notify you in advance. But if advance
notice is not practical, you will be notified as soon as possible. You will also be
informed of your right to file a complaint with the FCC.
Your local telephone company may make changes in its facilities, equipment,
operations, or procedures that affect the proper functioning of this equipment.
If they do, you will be notified in advance to give you an opportunity to maintain
uninterrupted telephone service.
Hearing Aid Compatibility. The custom telephone sets for this system are
compatible with inductively coupled hearing aids as prescribed by the FCC.
Automatic Dialers. WHEN PROGRAMMING EMERGENCY NUMBERS AND/OR
MAKING TEST CALLS TO EMERGENCY NUMBERS:

Remain on the line and briefly explain to the dispatcher the reason for
the call.
Perform such activities in off-peak hours, such as early morning or late
evening.

Direct Inward Dialing (DID).
a.     This equipment returns answer supervision signals to the Public

Switched Telephone Network when:
(1) answered by the called station
(2) answered by the attendant
(3) routed to a recorded announcement that can be administered

by the customer premises equipment user
(4) routed to a dial prompt

Customer Support Information xxi
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DID calls forwarded
Permissible

b.     This equipment returns answer supervision on all
back to the Public Switched Telephone Network.
exceptions are when:
(1) a call is unanswered
(2) a busy tone is received
(3) a reorder tone is received

Allowing this equipment to be operated in such a manner as not to provide
proper answer supervision signaling is in violation of Part 68 rules.

DOC Notification and Repair Information
NOTICE: The Canadian Department of Communications (DOC) label identifies certified
equipment. This certification means that the equipment meets certain
telecommunications network protective, operational, and safety requirements. The
DOC does not guarantee the equipment will operate to the user’s satisfaction.

Before installing this equipment, users should ensure that it is permissible to connect it
to the facilities of the local telecommunications company. The equipment must also be
installed using an acceptable method of connection. In some cases, the company’s
inside wiring for single-line individual service may be extended by means of a certified
connector assembly (telephone extension cord). The customer should be aware that
compliance with the above conditions may not prevent degradation of service in some
situations.
Repairs to certified equipment should be made by an authorized Canadian
maintenance facility designated by the supplier. Any repairs or alterations made by
the user to this equipment, or any equipment malfunctions, may give the
telecommunications company cause to request the user to disconnect the equipment.

Users should ensure for their own protection that the electrical ground connections of
the power utility, telephone lines, and internal metallic water pipe system, if present,
are connected. This precaution may be particularly important in rural areas.
CAUTION: Users should not attempt to make such connections themselves, but should
contact the appropriate electrical inspection authority or electrician, as appropriate.

To prevent overloading, the Load Number (LN) assigned to each terminal device
denotes the percentage of the total load to be connected to a telephone loop used by
the device. The termination on a loop may consist of any combination of devices
subject only to the requirement that the total of the Load Numbers of all the devices
does not exceed 100.

DOC Certification No.: 230 4095A
CSA Certification No.: LR 56260
Load No.: 6
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Renseignements sur la notification du ministère des Communications du Canada et
la réparation
AVIS: L’étiquette du ministère des Communications du Canada identifie le materiel
homologué. Cette étiquette certifie que le matériel est conforme à certaines normes de
protection, d’exploitation et de sécurité des réseaux de télécommunications. Le
Ministère n’assure toutefois pas que le matériel fonctionnera à la satisfaction de
l’utilisateur.

Avant d’installer ce matériel, l’utilisateur doit s’assurer qu’il est permis de le raccorder
aux installations de l’entreprise locale de telecommunication. Le matériel doit
également être installé en suivant une méthode acceptée de raccordement. Dans
certains cas, les fils intérieurs de l’enterprise utilises pour un service individual à ligne
unique peuvent être prolongés au moyen d’un dispositif homologué de raccordement
(cordon prolongateur téléphonique interne).
L’abonné ne doit pas oublier qu’il est possible que la conformity aux conditions
énoncées ci-dessus n’empêchent pas la degradation du service dans certaines
situations. Actuellement, les entreprises de telecommunication ne permettent pas que
l’on raccorde leur matériel à des jacks d’abonné, sauf clans les cas précis prévus pas
les tarifs particuliers de ces entreprises.

Les réparations de matériel homologué doivent être effectuées par un centre
d’entretien canadien autorisé désigné par le fournisseur. La compagnie de
telecommunications peut demander à l’utilisateur de débrancher un appareil à la suite
de reparations ou de modifications effectuées par l’utilisateur ou à cause de mauvais
fonctionnement.

Pour sa propre protection, l’utilisateur doit s’assurer que tous les fils de mise à la terre
de la source d’énergie électrique, des lignes téléphoniques et des canalisations d’eau
métalliques, s’il y en a, sent raccordés ensemble. Cette précaution est
particulièrement importance dans les régions rurales.
AVERTISSEMENT: L’utilisateur ne doit pas tenter de faire ces raccordements lui-
même; il doit avoir recours à un service d’inspection des installations électriques, ou à
un electrician, selon le cas.

L’indite de charge (IC) assigné à chaque dispositif terminal indique, pour éviter toute
surcharge, le pourcentage de la charge totale qui peut être raccordée à un circuit
téléphonique bouclé utilisé par ce dispositif. La terminaison du circuit bouclé peut être
constitute de n’importe quelle combinaison de dispositifs, pourvu que la somme des
indices de charge de l’ensemble des dispositifs ne dépasse pas 100.

No d’homologation: 230 4095A
No de certification: CSA LR 56260
L’indice de charge: 6
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Location Label Placement

Ministère des Communications
du Canada emplacement de
l’étiquette
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Security of Your System-Preventing Toll Fraud

As a customer of a new telephone system, you should be aware that there exists an
increasing problem of telephone toll fraud. Telephone toll fraud can occur in many
forms, despite the numerous efforts of telephone companies and telephone equipment
manufacturers to control it. Some individuals use electronic devices to prevent or
falsify records of these calls. Others charge calls to someone else’s number by
illegally using lost or stolen calling cards, billing innocent parties, clipping on to
someone else’s line, and breaking into someone else’s telephone equipment physically
or electronically. In certain instances, unauthorized individuals make connections to
the telephone network through the use of remote access features.

The Remote Access feature of your system, if you choose to use it, permits off-
premises callers to access the system from a remote telephone by using an 800
number or a 7- or 10-digit telephone number. The system returns an
acknowledgement signaling the user to key in his or her authorization code, which is
selected and administered by the system manager. After the authorization code is
accepted, the system returns dial tone to the user. If you do not program specific
egress restrictions, the user will be able to place any call normally dialed from a
telephone associated with the system. Such an off-premises network call is originated
at, and will be billed from the system location.

The Remote Access feature, as designed, helps the customer, through proper
administration, to minimize the ability of unauthorized persons to gain access to the
network. Most commonly, phone numbers and codes are compromised when
overheard in a public location, through theft of a wallet or purse containing access
information, or through carelessness (writing codes on a piece of paper and improperly
discarding it). Additionally, hackers may use a computer to dial an access code and
then publish the information to other hackers. Enormous charges can be run up
quickly. It is the customer’s responsibility to take the appropriate steps to properly
implement the features, evaluate and administer the various restriction levels, protect
access codes, and distribute access codes only to individuals who have been fully
advised of the sensitive nature of the access information.

Common carriers are required by law to collect their tariffed charges. While these
charges are fraudulent charges made by persons with criminal intent, applicable tariffs
state that the customer of record is responsible for payment of all long-distance or
other network charges. AT&T cannot be responsible for such charges and will not
make any allowance or give any credit for charges that result from unauthorized
access.
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To minimize the risk of unauthorized access to your communications system:

■

■

■

■

■

■

■

■

■

Use a nonpublished Remote Access number.
Assign authorization codes randomly to users on a need-to-have basis,
keeping a log of ALL authorized users and assigning one code to one person.
Use random sequence authorization codes, which are less likely to be easily
broken.
Deactivate all unassigned codes promptly.
Ensure that Remote Access users are aware of their responsibility to keep the
telephone number and any authorization codes secure.
When possible, restrict the off-network capability of off-premises callers, via
use of Call Restrictions and Disallowed List capabilities.
When possible, block out-of-hours calling.
Frequently monitor system call detail reports for quicker detection of any
unauthorized or abnormal calling patterns.
Limit Remote Call Forward to persons on a need-to-have basis.

Limited Warranty and Limitation of Liability

AT&T warrants to you, the customer, that your MERLIN LEGEND Communications
System will be in good working order on the date AT&T or its authorized reseller
delivers or installs the system, whichever is later (“Warranty Date”). If you notify AT&T
or its authorized reseller within one year of the Warranty Date that your system is not in
good working order, AT&T will without charge to you repair or replace, at its option, the
system components that are not in good working order. Repair or replacement parts
may be new or refurbished and will be provided on an exchange basis. If AT&T
determines that your system cannot be repaired or replaced, AT&T will remove the
system and, at your option, refund the purchase price of your system, or apply the
purchase price towards the purchase of another AT&T system.

If you purchased your system directly from AT&T, AT&T will perform warranty repair in
accordance with the terms and conditions of the specific type of AT&T maintenance
coverage you selected. If you purchased your system from an AT&T-authorized
reseller, contact your reseller for the details of the maintenance plan applicable to your
system.

This AT&T limited warranty covers damage to the system caused by power surges,
including power surges due to lightning.

The following will not be deemed to impair the good working order of the system, and
AT&T will not be responsible under the limited warranty for damages resulting from

xxvi Customer Support Information



Customer Support Information

■       failure to follow AT&T’s installation, operation, or maintenance instructions
■ unauthorized system modification, movement, or alteration
■ unauthorized use of common carrier communication services accessed

through the system
■ abuse, misuse, or negligent acts or omissions of the customer and persons

under the customer’s control
■      acts of third parties and acts of God

AT&T’S OBLIGATION TO REPAIR, REPLACE, OR REFUND AS SET FORTH ABOVE IS
YOUR EXCLUSIVE REMEDY.

EXCEPT AS SPECIFICALLY SET FORTH ABOVE, AT&T, ITS AFFILIATES, SUPPLIERS,
AND AUTHORIZED RESELLERS MAKE NO WARRANTIES, EXPRESS OR IMPLIED,
AND SPECIFICALLY DISCLAIM ANY WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE.

Limitation of Liability

EXCEPT FOR PERSONAL INJURY, DIRECT DAMAGES TO TANGIBLE PERSONAL
PROPERTY PROXIMATELY CAUSED BY AT&T, AND LIABILITY OTHERWISE
EXPRESSLY ASSUMED IN A WRITTEN AGREEMENT SIGNED BY AT&T, THE
LIABILllY OF AT&T, ITS AFFILIATES, SUPPLIERS, AND AUTHORIZED RESELLERS
FOR ANY CLAlMS, LOSSES, DAMAGES, OR EXPENSES FROM ANY CAUSE
WHATSOEVER (INCLUDING ACTS OR OMISSIONS OF THIRD PARTIES),
REGARDLESS OF THE FORM OF ACTION, WHETHER IN CONTRACT, TORT OR
OTHERWISE, SHALL NOT EXCEED AN AMOUNT EQUAL TO THE LESSER OF THE
DIRECT DAMAGES PROVEN OR THE PURCHASE PRICE OF THE SYSTEM. IN NO
EVENT SHALL AT&T OR ITS AFFILIATES, SUPPLIERS, OR AUTHORIZED RESELLERS
BE LIABLE FOR INCIDENTAL, RELIANCE, CONSEQUENTLY, OR ANY OTHER
INDIRECT LOSS OR DAMAGE (INCLUDING LOST PROFITS OR REVENUES)
INCURRED IN CONNECTION WITH THE SYSTEM. THIS LIMITATION OF LIABILITY
SHALL SURVIVE FAILURE OF THE EXCLUSIVE REMEDY SET FORTH IN THE LIMITED
WARRANTY ABOVE.

Voice Mail Systems

Your Voice Mail system permits callers to leave verbal messages for system users or
gain access to the back-up position in an emergency as well as create and distribute
voice messages among system users.

The Voice Mail system, through proper administration, can help you reduce the risk of
unauthorized persons gaining access to the network. However, phone numbers and
authorization codes can be compromised when overheard in a public location, are lost
through theft of a wallet or purse containing access information, or through
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carelessness (writing codes on a piece of paper and improperly discarding them).
Additionally, hackers may use a computer to dial an access code and then publish the
information to other hackers. Substantial charges can accumulate quickly. It is your
responsibility to take appropriate steps to implement the features properly, evaluate
and administer the various restriction levels, protect and carefully distribute access
codes.

Under applicable tariffs, you will be responsible for payment of toll charges. AT&T
cannot be responsible for such charges and will not make any allowance or give any
credit resulting from unauthorized access.

To reduce the risk of unauthorized access through your Voice Mail system, please
observe the following procedures:

Employees who have voice mailboxes should be required to use the
passwords to protect their mailboxes.

—     Have them use random sequence passwords.
—     Impress upon them the importance of keeping their passwords a

secret.
—     Encourage them to change their passwords regularly.

The administrator should remove any unneeded voice mailboxes from the
system immediately.
AUDIX Voice Power™ has the ability to limit transfers to subscribers only. You
are strongly urged to limit transfers in this manner.
Use the PBX or Key system administration capability to do the following:

—     Block direct access to outgoing lines and force the use of account
codes/authorization codes.

—     Disallow trunk-to-trunk transfer unless required.
—     Assign toll restriction levels to all AUDIX Voice Power ports.
—     If you do not need to use the Outcalling feature, completely restrict the

outward calling capability of the AUDIX Voice Power ports.
Monitor SMDR reports or Call Accounting System reports for outgoing calls that
might be originated by AUDIX Voice Power ports.

Remote Administration and Maintenance

The Remote Administration and Maintenance feature of your telecommunications
system, if you choose to use it, permits users to change the system features and
capabilities from a remote location.

The Remote Administration and Maintenance feature, through proper administration,
can help you reduce the risk of unauthorized persons gaining access to the network.
However, telephone numbers and authorization codes can be compromised when
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or purse containing
a piece of paper and
computer to dial an

overheard in a public location, are lost through theft of a wallet
access information, or through carelessness (writing codes on
improperly discarding them). Additionally, hackers may use a
access code and then publish the information to other hackers. Substantial charges
can accumulate quickly. It is your responsibility to take appropriate steps to implement
the features properly, evaluate and administer the various restriction levels, and protect
and carefully distribute access codes.

Under applicable tariffs, you will be responsible for payment of toll charges. AT&T
cannot be responsible for such charges and will not make any allowance or give any
credit resulting from unauthorized access.

To reduce the risk of unauthorized access through Remote Administration and
Maintenance, please observe the following procedures:

■      The System Administration and Maintenance capability of a PBX or Key system
is protected by a password.

— Change the default password immediately.
— Continue to change the password regularly.
— Only give the password to people who need it and impress upon them

the need to keep it secret.
— If anyone who knows the password leaves the company, change the

password immediately.
■ If you have a special telephone line connected to your PBX or Key system for

Remote Administration and Maintenance, you should do one of the following:
Unplug the line when it is not being used.
Install a switch in the line to turn it off when it is not being used.
Keep the Remote Administration and Maintenance telephone number
secret. Only give it to people who need to know it, and impress upon
them the need to keep it a secret. Do not write the telephone number
on the PBX or Key system, the connecting equipment, or anywhere
else in the system room.

■      If your Remote Administration and Maintenance feature requires that someone
in your office transfer the caller to the Remote Administration and Maintenance
extension, you should impress upon your employees the importance of only
transferring authorized individuals to that extension.
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About This Book

This book, which provides summaries of each procedure for programming the
MERLIN LEGEND™ Communications System, is intended for qualified service
personnel and technicians. The material is presented in the order in which
you would program a new system. Additional information is available as
follows:

More detailed procedures for system programming, along with
information on how to program on the system programming console
and on the PC, can be found in System Programming.

Complete instructions on using SPM can be found in System
Programming and Maintenance (SPM).

Detailed information about all of the features described here can be
found in the Feature Reference.

Detailed information on how to choose among the many options
provided for each feature can be found in System Planning.
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Conventions

The following typographical conventions are used in this book:

■ Bold type is used for telephone buttons.
Press Drop to delete the current entry.

Italic type is used for substitutable values for which you must supply a■

specific value.
Specify extension: dial/type [nnnn].
Specify slot and port: dial/type [sspp].

■    Constant width type is used for information on telephone display
screens or on a PC screen.

Select Sys Program.

■    Bold constant width type indicates information that you enter
exactly as shown.

Dial #55.

■ Keys on the PC are shown in boxes.

Press [F7] .

■    When two keys are to be pressed at the same time, the keys are
connected by a plus sign.

Press [Alt] + [P] .

■ The Enter (Return) key on a PC is shown as ↵ .
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Product Safety Labels

Throughout this book,
point inside a triangle

hazardous
along with

situations are indicated by an exclamation
the word warning or caution.

WARNING:
Warning indicates the presence of a hazard that could cause death
or severe personal injury if the hazard is not avoided.

CAUTION:
Caution indicates the presence of a hazard
minor personal jnjury or property damage if
avoided.

that will or can cause
the hazard is not
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How to Comment on This Document

We welcome your comments, both positive and negative. Please use the
feedback form on the next page to let us know how we can continue to serve
you. If the feedback form is missing, write directly to

A. Sherwood
AT&T
99 Jefferson Road
Room 2A25
Parsippany, NJ 07054
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Introduction

This chapter covers the information you need to know before you begin
system programming.

It describes the following:

system programming console, buttons, and overlay

types of programming

programming summary contents

programming basics

programming menu options

idle states
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System Programming Console

The system programming console is an MLX-20L telephone connected to the
system programming jack. When you enter system programming on a new
system for the first time, the console must be connected to the first jack on the
first 008 MLX module or 408 GS/LS-MLX module (Release 2.0 and later
versions). This jack is factory set as the system programming jack and as an
operator position. After you enter programming, you can change the system
programming jack to any one of the first five jacks on the first 008 MLX
module or 408 GS/LS-MLX module (Release 2.0 and later versions). This
allows you to program without interfering with the operator’s call handling.

You can also have one or two Direct Station Selectors (DSSs) connected to
the system programming console. Each DSS adds 50 extension buttons to
the console, which facilitates assigning features to telephones.

The MLX-20L telephone with a DSS is shown in Figure 1.

8  System Programming Console
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Display Buttons

Display Screen
D S S

Line Buttons (20)

Button
Labeling

Cards (2)

Handset

LED
Direct

Station Selector

LED
I  Message

Volume Control Dialpad

Dedicated Feature Buttons (8)

User Cards and Tray

Light

Figure 1.  MLX-20L Telephone
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Console Buttons

System programming can be done using the console’s 14 display-area
buttons. These buttons are arranged in two columns of seven buttons. The
top two buttons in each column
regardless of the display. Table

have the same labels and functions
1 describes these functions.

Table 1. Display Button Descriptions

Button Function

Home Return to normal call-handling mode after you finish programming. This button
displays the Home screen.

Menu Display the Main Menu shown in Figure 1-2.
More Display more menu items when a menu is continued on more than one screen

(indicated by a “>”).

Inspct     (Inspect) View a list of lines or telephones on which a feature is programmed.

10  System Programming Console
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Console Overlay

The programmable lines and buttons are on the main part of the console.
There are 20 physical buttons on the console itself but you can use the
overlay to program up to 34 lines. Some of the unlabeled buttons on the lower
part of the console may also be used for programming features. You can also
use the dialpad for entering feature and programming codes.

Figure 2 illustrates the system console overlay.

Line 14
Line 21

Line 1

❑ ❑ ❑
❑ ❑ ❑
❑ ❑ ❑
❑ ❑ ❑

Line 34

Figure 2.  Console Overlay

Appendix D shows the button diagrams for the telephones used in the
communications system. Refer to this appendix when programming buttons
for other telephones.
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Programming Information

This section covers basic system programming information. See System
Programming for more information.

Types of Programming

There are three types of programming for the communications system:

System Programming — enables the System manager to program
features that affect all or most system users. System programming
requires one the following:

—    an MLX-20L™ telephone connected to one of the first five ports
of the first MLX module in the control unit

—    a PC with System Programming and Maintenance (SPM)
software connected to the lower RS-232 port on the processor,
with a built-in modem in the processor. The modem permits
remote programming and maintenance via the public network.
SPM emulates a system programming console on your PC.

NOTE:
If your system has the AT&T Integrated Solution II (IS II)—UNIX®
application, you have a Master Controller equipped with the UNIX
version of SPM. See Chapter 2 in System Programming for more
information.

Extension Programming enables individual telephone users and
system operators (except for QCC operators) to change their
telephone features to meet individual needs. For details on extension
programming, see the appropriate user and operator guides.

Centralized Telephone Programming enables the System manager
to program any feature that can be programmed by individual
telephone users or system operators. Centralized Telephone
Programming can be done on the programming console or on a PC
with the SPM software. For details on Centralized Telephone
Programming, see Chapter 4 in System Programming.
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Programming Summary Contents

Each programming summary contains a general description of the feature
and provides the folIowing programming information:

Programmable by—indicates who has system permission to use the
procedure

Mode—specifies which system mode supports the procedure

Idle condition—specifies the idle state required before the procedure
can be performed

Planning form —indicates which planning forms provide information for
the procedure

Factory setting—shows the default settings, if any, for equipment or
features affected by the procedure

Valid entries—specifies the characters or numbers accepted during
data entry

Inspect—specifies whether or not the feature status can be verified
using the Inspect feature

Copy option—indicates whether or not the feature programmed with
procedure can be copied to another system component

Console Procedure—provides a summary of the procedure steps if
using the system console

PC Procedure—provides a summary of the procedure steps if using
SPM

Programming Information 13
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Programming Basics

To begin programming, do the following:

On the console:

On the PC:

In most cases, to exit

Select Menu → Sys Program → Exit:
The System Programming menu is displayed.

Type SPM → [↵] → Press any key → [F1] → [F5] :
The System Programming menu is displayed.

from a screen without making any changes, press Exit
or [F5] . Exceptions are noted as part of a procedure.

Ordinarily you complete a procedure by pressing Enter ( [F10] ) to save the
information you have programmed. occasionally you press Exit ( [F5] ) and
go back to the previous screen.

If you are programming a group of sequentially numbered extensions or
trunks, you may have the option of pressing Next (  [F8] ) to save your entry
and automatically provide the number of the next extension or trunk in the
sequence, thus saving you a couple of steps.

When you have completed a procedure, pressing Exit ( [F5] ) takes you Up
one screen in the menu hierarchy.

In most cases, you will be at an intermediate step in the procedure you have
just completed. At that point, you can select one of the options shown on the
screen and continue programming, or you can press Exit again. This
usually takes you back to the System Programming menu. If not, you again
have the option of continuing to program from the current screen or pressing
Exit again.

In a few cases, pressing Exit brings you back to the System Programming
menu where you can select another option to program or exit from system
programming.
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Programming Menu Options

Table 2 lists the options that display on the System Programming menu.

Table 2. Programming Menu Options

Option Description
System

SysRenumber

Operator

LinesTrunks

Extensions

Opt ions

Tables

AuxEquip

NightSrvce

Labeling

Set system operating conditions.

Select the system numbering plan and/or reassign extension
numbers with 1- to 4-digit numbers that are more appropriate or
convenient for your company.

Assign or remove operator positions and program operator
features (such as Operator Hold Timer or QCC options).

Program line/trunk options.

Program features for telephones (such as restrictions, line
assignments).

Program system-wide features (such as Transfer Return, Delay
Ring).

Program features
(such as Allowed

Program auxiliary

that require entering information in a table
Lists, Disallowed Lists).

equipment connected to the system (such as
loudspeaker paging, fax).

Program Night Service features.

Program the labels shown on display telephones (such as
System Directory, Posted Messages).

Continued on next page
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Table 2.- Continued

Option Description

Data Specify telephones that need simultaneous voice and data
capability.

Print Print system programming reports (such as system
configuration,  extension assignments).

Cntrl Prog Do centralized telephone programming (assign features to
specific buttons on telephones).

Language Select the language that your console uses to display text on
the screens. Selections are English (default), French, and
Spanish.

Exit Exit system programming.
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Idle States

Some programming procedures can be started only when the entire system,
or some part of the system (such as a trunk or an extension), is idle, that is,
not in use. Some procedures require that a trunk or extension be idle only at
the instant of programming. Lengthy procedures require the system, trunk, or
extension be forced into remaining idle until programming is completed.
These procedures wait for the system or trunk or extension to become idle
and then prevent the initiation of any new calls—a condition called forced idle.

If a procedure requires an
normal business hours.

If a procedure requires an
begin, you see the screen

idle condition, do the programming outside of

idle system and the system is busy when you
shown in Figure 3.

System Busy Pls Wait

Dial Code: nnnn
Slot/Port: ss/pp

Exit

Figure 3.  System Busy Screen

When the system is no longer busy, the screen changes to the appropriate
programming screen.

Idle States 1 7
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System Forced Idle

When the entire system is forced idle, no calls can be made or received. The
following procedures can be done only when the entire system (all lines and
telephones) is idle:

■

■

■

■

■

■

■

■

select system mode
identify system operator positions
renumber system
renumber modules
identify telephones with voice signal pairs for Voice Announce to Busy
feature
identify telephones needing Simultaneous Voice and Data feature
restore system programming information
identify Music-on-Hold jack

When the system is forced idle, all multiline telephone users hear a signal,
indicating that the telephone cannot be used. On a display telephone, the
message

Wait: System Busy

appears. Single-line telephones do not get a dial tone.

Line or Trunk Idle

The following procedures can be done only when the line or trunk being
programmed is idle. Since these procedure require the line or trunk to be idle
only at the instant of programming, the line or trunk is not forced idle as
described above.

■   identify loudspeaker paging line jack
■   assign trunks to pools
■   specify incoming or outgoing DID or tie-trunk type
■   specify tie-trunk direction
■   specify tie-trunk E&M signal
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Extension Forced Idle

When a telephone or data terminal is forced idle, no calls can be made or 
received on that telephone or data terminal, The following procedures can be
started only when the telephone or data terminal being programmed is idle.

■   assign call restrictions
■   assign pool dial-out restrictions
■   copy telephone assignments
■ assign lines, trunks, or pools to extensions
■   assign labels to a Personal Directory
■   use centralized telephone programming

When the telephone is forced idle, a multiline telephone user hears a signal,
indicating that the telephone cannot be used. On a display telephone, the
message

Wait: System Busy

appears. Single-line telephone user does not get a dial tone.

100D Module Idle

The following can be done only when the 100D Module is idle:

■   specify board type
■   specify frame format
■   specify board signaling format
■   specify board suppression format
■   specify board facility compensation

Idle States  1 9
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Forced Idle Reminder Tones

Forced idle reminder tones are provided in the following situations:

■    At the telephone, to remind an extension that the system or the
extension is in the forced idle state.

■    At the programming console or SPM, to remind the system manager
that the system or at least one extension is in the forced idle state
because of administrative activity.

This tone is a high-low “doorphone” tone (400 ms of 667 Hz tone
followed by 400 ms of 571 Hz tone).

In a Release 1.1 or Release 2.0 system, all three tones occur every
20 seconds. You can adjust the volume of these tones with the volume
control.

2 0 Idle States



Basic System Operating
Conditions 1

The procedures in this chapter are all related to the system rather than to the
operation of telephones, operator positions, or trunks. These are conditions
that have to be set only when the system is new or, sometimes, after a frigid
start.

NOTE:
You have to reset the system time when Daylight Savings Time begins
and ends.

This chapter contains the following programming procedures:

System Restart

System Programming Position Assignment

Mode of Operation

Board Renumbering

Automatic Maintenance Busy

System Date

System Time

System Language

Basic System Operating Conditions  1-1
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System Restart

Use

CAUTION:
This procedure is for qualified support personnel only.

this procedure to perform a system restart (cold start).

All calls are dropped when you perform this procedure. System programming
is saved.

Telephones with the Extension Status feature can lose toll restrictions as a
result of a cold start.

Summary: System Restart

Programmable by Qualified support personnel

Mode All

Idle Condition Not required

Planning Form Not applicable

Factory Setting None

Valid Entries None

Inspect No

Copy Option No

Console Procedure System → Restart → Yes

PC Procedure [F1] → [F1] → [F1]

1-2  System Restart
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System Programming Position
Assignment

Use this procedure to reassign the station jack used for system programming.
This jack should not be the same jack used for the operator position.

The system programming position can be reassigned only to one of the first
five jacks on the first MLX module. Only one system programming console is
allowed per system.

If you are programming on the console:

■   The console must be connected to the station jack currently assigned
for system programming.

■    As soon as you change the system programming jack, the system
programming session is terminated. To proceed with system
programming, you must connect the system programming console to
the newly assigned station jack and re-enter system programming.
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Summary: Assign System Programming
Position

Programmable by

Mode

Idle Condition

Planning Form,

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 1, System Planning

First jack on first MLX module (also set as an operator
position)

Extension number of one of the first five jacks on the
first MLX module

No

No

System → SProg Port → Drop → Dial ext. no. →
Enter → Exit

[F1]  → [F2]  → [Alt]  + [P] → Type ext. no. →
[F10] → [F5]

1-4  System Programming Position Assignment
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System Language

Release 1.1 and 2.0 Only
Your communications system offers you a choice of three languages (English,
French, and Spanish) for the following options:

■    System language (set first)

■    Station Message Detail Recording (SMDR) reports (see “System
Features”)

■    Print reports (see “Printing Reports”)

■    Extensions (see “Optional Telephone Features”)

Use this procedure to set the system language.

Summary: System Language

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 1, System Planning

English

English, French, Spanish

No

No

More → Language → SystemLang → Yes → Select
a language → Enter

[PgUp]  → [F6]
language → [F10]

→  [F1] → [F3] → Select a
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Board Renumbering

Use

CAUTION:
This procedure is to be performed by qualified support personnel
only.

this procedure to renumber boards that have already been installed.
Note that this is not the same procedure as the Boards option, available to
qualified service personnel with SPM only. This procedure restarts the system
(system programming is not lost).

Summary: Board Renumbering

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

Qualified support personnel only

All

System idle

Not app

None

Not app

licable

licable

Not applicable

Not applicable

System → Board Renum → Yes

[F1] → [F4] → [F2]

1-6 Board Renumbering
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Mode of Operation

The system mode-Key, Behind Switch, or Hybrid/PBX-determines how the
system operates. More specifically, the system mode determines:

■   how lines or trunks are provided to users

■   types of operator consoles allowed

■   features available

Changing this option causes a system restart and terminates the
programming session. You must re-enter system programming to program
other features.

NOTE:
The Hybrid/PBX option is not available if the control unit processor module
has been modified with the hardware strap in place to operate in Key
mode only. See Equipment and Operations Reference.

These

■

■

■

■

■

■

■

options cannot be programmed for Key or Behind Switch systems:

Automatic Route Selection (ARS)

Pools

Queued Call Consoles (QCCs) and associated features

Direct Inward Dialing (DID) Trunks

System Access buttons

Dial Plan Routing (PRI)

Call by Call Services (PRI)

The Ground-start trunks option cannot be programmed if the processor
module has been modified for Key mode-only operation.
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Summary: Mode of Operation

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

System idle

Form 1, System Planning

Key

Key, Behind Switch, Hybrid/PBX

No

No

System → Mode → Select mode → Enter
[F1] → [F3] → Select mode → [F10]
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Automatic Maintenance Busy

Automatic Maintenance Busy allows the system to take a malfunctioning trunk 
out of service for outgoing calls. (Incoming calls are never blocked.) This
protects against disruptions in outgoing calling patterns that are caused by
faulty outside facilities.

For optimum performance, enable Automatic Maintenance Busy for
Hybrid/PBX systems with pooled trunks.

NOTE:
No more than 50% of the trunks in a trunk pool are allowed to be placed
in the maintenance-busy state at one time unless the central office has
failed to disconnect a trunk (which prevents anyone from using that trunk)
or an entire trunk module is manually taken out of use (a user-imposed
maintenance-busy state).
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Summary: Automatic Maintenance Busy

Programmable by System manager

Mode All

Idle Condition Not required

Planning Form Form 1, System Planning

Factory Setting Disabled

Valid Entries Enabled, Disabled

Inspect No

Copy Option No

Console Procedure To disable Automatic Maintenance Busy:
System → MaintenBusy → Disable → Enter
→ Exit

To enable Automatic Maintenance Busy – no tie
trunks:
System → MaintenBusy → Enable → Enter
→ Exit

To enable/disable with tie trunks:
System → MaintenBusy → Enable → Enter →
Enable/Disable → Enter → Exit 

PC Procedure To disable Automatic Maintenance Busy:
[F1] → [F6] → [F2] → [F10] → [F5]

To enable Automatic Maintenance Busy -no tie
trunks:
[F1] → [F6] → [F1] → [F10] → [F5]

To enable/disable with tie trunks:
[F1] → [F6] → [F1] → [F10] → [F1] / [F2] →
[F10] → [F5]
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System Date

The System Date feature allows you to set the month, day, and year that
appear on MLX display telephones and on Station Message Detail Recording
(SMDR) reports.

NOTE:
If you are planning to use the SMDR feature, make sure the current date is
set.

Summary: Set System Date

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 1, System

01-01-00

Month: 01-12
Day: 01-31
Year: 00-99

No

No

Planning

System → Date → Drop → Dial current date →
Enter → Exit

[F1] → [F7] → [Alt] + [P] → Type current date →
[F10]  → [F5]
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System Time

The System Time feature allows you to set the time that appears on MLX
display telephones and on SMDR reports.

NOTE:
If you are planning to use the SMDR feature, make sure the system time is
set accurately.

If you change the system time while the system is in Night Service mode,
Night Service is deactivated and must be manually reactivated.

If you have installed applications such as Call Management System (CMS) or
AUDIX™ Voice Power, you may need to set the time in the applications
software whenever you reset the system time.

Summary: Set System Time

Programmable by

Mode

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Form 1, System Planning

0000

0000-2359

No

No

System → Time → Drop → Dial current time →
Enter → Exit

[F1] → [F8] → [Alt] + [P] → Type current time →
[F10]  → [F5]
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System Renumbering 2
The procedures in this chapter are used to assign the 2-digit, 3-digit, and Set
Up Space numbering plans.

NOTE:
System Renumbering is called Flexible Numbering in the MERLIN® II
Communications System. This is not the same as Board Renumbering, an
option used when modules in the control unit are changed.

Do not attempt to assign a numbering plan without Planning Forms 2a,
System Numbering-Station Jacks, 2b, System Numbering- Digital Adjuncts,
and 2d, System Numbering, Special Renumbers. Form 6a, Optional Operator
Features, is needed to assign a DSS Page button.

This chapter contains the following programming procedures:

■   Select System Numbering Plan

■   Single Renumbering

■   Block Renumbering

■   Direct Station Selector (DSS) Page Button Assignment
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System Renumbering

You select only one of the numbering plans (2-digit numbering, 3-digit
numbering, or Set Up Space numbering). In addition, you may need to
perform single and/or block renumbering. You do not need to assign DSS
page buttons unless the system programming console or one of the operator
positions is connected to a DSS. No matter which procedures you need to
perform, assign the numbering plan first, then do single and/or block
renumbering, and finally, assign DSS page buttons (if necessary).

Use the single renumbering procedure any time the extension numbers you
are changing from or to are not sequential.

Block renumbering is quicker, but you can use block renumbering only when
the extension numbers you are changing from and to are sequential.

When trunk or station modules are removed from the control unit, the
remaining modules must be rearranged so that no empty slots remain. The
system does not acknowledge any modules installed after an empty slot;
therefore, if the system is renumbered, extensions are not assigned to station
jacks after the empty slots.
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Select System Numbering Plan

CAUTION:
To a void possible loss of system programming information, renumber
the system before you program the rest of the options described in
this book.

Three system numbering plans are available. The choice should appear on
System Planning Form 2a. The three plans are as follows:

■

■

■

The 2-digit plan (for systems with fewer than 50 extensions and no
plans to exceed that number within two or three years): Each of the
first 58 station jacks is assigned a 2-digit extension number, beginning
with 10 and ending with 67. Any remaining extensions are assigned
4-digit numbers, beginning with 6800 and ending with 6885.

The 3-digit plan (for systems with 50 or more extensions or plans to
grow to that number within the next year or so): All extensions are
assigned a 3-digit number, beginning with 100 and ending with 243.

The Set Up Space plan (for systems with a need to customize their
extension numbers or use extension numbers of varying lengths—1 to
4 digits): All extensions are assigned 4-digit numbers in the 7000
range. Extension numbers 1000 through 6999 are also available for
use when you renumber.

In all three numbering plans, the system assigns 3-digit extension numbers to
pools (Hybrid/PBX only), calling groups, paging groups, remote access
codes, the Listed Directory Number, park codes, and Idle Line Access (Key
and Behind Switch modes). In addition, the system assigns 9 for Automatic
Route Selection (Hybrid/PBX only) and Idle Line Access (Key and Behind
Switch only).

Zero (0) represents a special extension number—actually a fixed dial code—
for the primary operator or QCC queue. Any extension number except 0 can
be renumbered.

Extension numbers can be composed of any combination of digits; however,
no number can begin with 0. Trunk numbers (801 – 880) are not considered
to be extensions and cannot be renumbered.

Select System Numbering Plan  2-3



System Renumbering

The system does not provide a message to indicate a successful renumber
when either the 2-digit or 3-digit numbering plan is selected. For the set up
space numbering plan, the system provides a message indicating that all
extensions are in the 7000 range.

CAUTION:
Select Exit on the console, [F5] on the PC, when you have finished
selecting the numbering plan. If you press Home, extensions may
remain in the forced idle condition (indicated when the LED next to
each DSS button is on). To restore extensions to their normal
operating state, restart the system.

Summary Select System Numbering Plan

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

System idle

Form 2a, System Numbering – Station Jacks

2-digit

2-digit, 3-digit, Set Up Space

No

No

SysRenumber → Default Numbering → Select
numbering plan → Exit → Exit

[F2] → [F1] → Select numbering plan → [F5] →
[F5]
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Single Renumbering

Use this procedure to assign a specified extension number to a telephone,
accessory, line, pool (Hybrid/PBX only), calling group, paging group, or Listed
Directory Number. Single renumbering is also used for Remote Access, Park,
Idle Line Access (Key and Behind Switch only), and Automatic Route
Selection (Hybrid/PBX only).

When required, this procedure should be performed immediately following the
selection of a system numbering plan.

CAUTION:
Select Exit on the console, [F5] on the PC, after renumbering
extensions. If you press Home, extensions may remain in the forced
idle condition (indicated when the LED next to each DSS button is
on). To restore extensions to their normal operating state, restart the
system.
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Summary: Single Renumbering

Programmable by System manager

Mode All

Idle Condition System idle

Planning Forms Form 2a, System Numbering – Station Jacks
Form 2b, System Numbering – Digital Adjuncts
Form 2d, System Numbering – Special Renumbers

Factory Setting Not applicable

Valid Entries Old and new extension numbers

Inspect Yes

Copy Option No

Console Procedure SysRenumber → Single → Select item → Dial old
ext. no. → Enter → Dial new ext. no. → Enter →
Exit → Exit
[F2] → [F2] → Select item → Type old ext. no. →
[F10] → Type new ext. no. → [F10] → [F5] → [F5]

PC Procedure
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Block Renumbering

Use this procedure to assign extension numbers to a group of extensions,
accessories, or lines. Both the original numbers and the numbers they are
being changed to must be sequentially numbered.

When required, this procedure should be performed immediately following the
selection of a system numbering plan.

CAUTION:
Select Exit on the console, [F5] on the PC, when you have
renumbering extensions. If you press Home, extensions may remain
in the forced idle condition (indicated when the LED next to each
DSS button is on). To restore extensions to their normal operating
state, restart the system.
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Summary: Block Renumbering

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

System manager

All

System idle

Form 2a, System Numbering - Station Jacks
Form 2b, System Numbering - Digital Adjuncts
Form 2d, System Numbering - Special Renumbers

Not applicable

Old and new extension numbers

Yes

No

SysRenumber → Block → Select type of group →

PC Procedure

Dial no. of first group member → Enter → Dial no. of
last group member → Enter → Dial new beginning
no. → Enter → Exit → Exit → Exit

[F2] → [F3] → Select type of group → Type no. of
first group member → [F10] → Type no. of last group
member → [F10] → Type new beginning no. →
[F10] → [F5] → [F5] → [F5] 
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Direct Station Selector (DSS) Page
Buttons

Use this procedure to set the three Page buttons on the DSS to correspond to
the system numbering plan. This procedure assigns extension numbers to
DSS buttons. You cannot program individual buttons on a DSS; this is the
only method for programming DSS buttons.

If only one DSS is attached, each Page button assignment sets the console
for a range of 50 extension numbers. If two DSSs are attached, each Page
button assignment sets the console for a range of 100 extension numbers.
Page button assignment should be sequential (Page 1: 0-49, Page 2: 50-
99, Page 3: 100-149).

NOTE:
If two DSSs are attached, change the factory setting so that the difference
between extension numbers assigned to the range is at least 100. For
example, assign Page 1 to begin with extension 10, Page 2 to begin with
extension 110, and Page 3 to begin with extension 210.

Operator Park Zone codes must be included in the extension number range
specified for one of the page buttons.

CAUTION:
Select Exit on the console, [F5] on the PC, when you have finished
this procedure. If you press Home, extensions may remain in the
forced idle condition (the LED next to each DSS button is on), and
the system may have to be restarted.
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Summary: Assign Direct Station Selector Page
Buttons

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System Renumbering

System manager

All

Not required

Form 6a, Optional Operator Features

Page 1 = 0, Page 2 = 50, Page 3 = 100

1,2,3

Yes

No

SysRenumber → Single → More → DSS Buttons
→ Dial page no. → Enter → Dial first ext. no. →
Enter → Exit → Exit

[F2] → [F2] → [PgUp]  → [F1] → Type page no. →
[F10]  → Type first ext. no. → [F10]  → [F5]  → [F5]
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System Operator Positions 3
A system operator position—for the Queued Call Console operator or the
Direct-Line Console operator— should be programmed before you program
lines or trunks.

The QCC operator position is available only for Hybrid/PBX systems. The DLC
operator position is available in any mode and must be programmed if you
have Call Management Systems connected to any operator ports. Table 2-1
shows the maximum number of operator positions allowed for any one
system.
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Table 3-1. Maximum Number of Operator Positions

Position Type Type of Telephone Maximum Positions
QCC MLX-20L 4

DLC MLX-20L 8

MLX-28D
Analog multiline telephones

MERLIN II Display Consoles

TOTAL QCC + DLC 8

Any combination of operator positions can be assigned as long as no more
than 4 operator positions are QCCs and the total combined number does not
exceed eight. If you want to designate a new operator position and the
system already has the maximum number, you must change an existing
operator position to a non-operator telephone before you designate a new
operator position.

NOTE:
All settings return to factory settings for the port type that you are
designating on a telephone when you change it to an operator position or
vice versa. Therefore, you need to reassign lines and features to that
telephone or console. You may also need to change any attached
accessory equipment and optional features.
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Primary Operator Positions

The primary operator position is the position to which your call is directed
when you dial 0 on a System Access button.

The first jack on the first MLX module in your system is assigned as the
primary operator position.

If your system has QCC operator positions, this position must be changed
from the factory setting (DLC) to a QCC operator position. (The position of the
primary operator cannot be changed from the first jack on the first MLX
module.)
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QCC System Operator positions

This procedure applies to Hybrid/PBX systems only. Note that both QCC and
DLC operator positions can be assigned with this procedure, although its
primary purpose is to assign QCC operator positions.

QCC operators serve as central answering positions for all incoming calls.
Incoming calls are held in the QCC queue and are directed to each QCC
operator in a prioritized sequence. The calls are received one at a time,
regardless of the number of incoming calls to the system.

QCC Operator Positions

Additional QCC operator positions can be assigned only to the firsl and fifth
jacks of MLX modules. A maximum of four QCC operator positions can be
assigned. Use this procedure to specify QCC operator positions that serve as
central answering positions for all incoming calls.

CAUTION:
If you want to add or remove QCC operator positions, the following
conditions apply:

■    The primary QCC operator position cannot be removed if
other QCC positions remain in your system.

■    When QCC operator positions are added, the primary QCC
operator position should be the first one added.

■    If QCC operator positions are being removed, the primary
QCC operator position must be the last one removed.
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Summary: QCC Operator Positions

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

System idle

Form 2a, System Numbering - Station Jacks

Type - DLC

first or fifth ports on MLX module (maximum—2 per
module, maximum—4 QCCs per system)

Yes

No

Operator → Positions → Queued Call → Dial
ext. no. → Enter → StoreAll

[F3] → [F1] → [F2] → Type ext. no. → [F10] →
[F3]

DLC Operator Positions

DLC operator positions can be assigned to the first and fifth ports on the first
modules with digital or analog multiline station jacks. A maximum of eight
DLC operator positions can be assigned. Any combination of operator
positions can be assigned as long as there are no more than four QCC
operators and no more than 8 operators in total.

Use this procedure to specify telephones that serve as central answering
positions for all incoming calls, for Call Management Systems connected to 
operator ports, or as calling group supervisors. (You do not need to use this
procedure in a Key or Behind Switch system unless you have more than one
DLC position.) Trunks are assigned on individual buttons. The system
programming console can have several incoming calls ringing simultaneously.
For a new system, remove the factory set DLC operator position assignment
for any telephone not used as an operator position.
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Each CMS requires two DLC operator positions to connect the equipment and
one position to serve as CMS supervisor.

Summary: DLC Operator Positions

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

System idle

Form 2a, System Numbering - Station Jacks

Type - DLC

First or fifth ports (maximum—2 per module,
maximum—8 DLCs per system)

Yes

No

Operator → Positions → Direct Line → Dial
ext. no. → Enter → StoreAll

[F3] → [F1] → [F1] → Type ext. no. → [F10] →
[F3]
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Lines and Trunks 4
The procedures in this chapter are used to assign optional features to
individual lines and trunks. The optional features that can be assigned are the
following:

Type of Trunk

Outmode Signaling for Loop or Ground Start Trunks

Rotary Trunk Digit Transfer

Disconnect Signaling Reliability

Toll Type

Hold Disconnect Interval

Principal User for Personal Line

QCC Queue Priority

QCC Operator to Receive Calls

Trunks to Pools Assignment

In addition, there is a Copy Options feature (described at the end of this
chapter) that allows you to copy optional features from an idle trunk instead
of entering the information an item at a time.
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Type of Trunk

Use this procedure to specify the type of trunk—loop-start (LS) or ground-start 
(GS)—for each outside trunk connected to one of these modules:

■   400 GS/LS

■   408 GS/LS

■   800 GS/LS

■   408 GS/LS-MLX

Any combination of trunk types (all loopstart, all groundstart, or some of each)
is permissible.

This procedure is not used for a system registered with a KF registration
number (Key or Behind Switch). Ground-start trunks are allowed only for
systems with an MF (Hybrid) or PF (PBX) registration number.

Summary: Type of Trunk

Programmable by

Mode

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

A l l

Form 2c, System Numbering – Trunk Jacks

All loop-start

All Ground, All Loop, Ground-Start, Loop-Start

Yes

Yes

LinesTrunks → LS/GS/DS1 → Dial slot no. →
Enter → Select trunk type → Dial port no. → Enter
→ Exit → Exit

[F4]  → [F1]  → Type slot no. → [F10] → Select
trunk type → Type port no. → [F10] → [F5] → [F5]
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Outmode Signaling for Loop or
Ground Start Trunks

Use this procedure to identify either touch-tone signaling or rotary dial
signaling for outgoing calls placed by using each loop- or ground-start trunk.

NOTE:
This procedure is not required if your system has only touch-tone
lines/trunks.

Summary: Outmode Signaling for Loop or
Ground Trunks

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

System manager

Loop Start - All; Ground Start – Hybrid/PBX only

Not required

Form 2c, System Numbering – Trunk Jacks

Touch-tone

Touch-tone, rotary

No

Yes

To program a single extension:†

LinesTrunks → TT/LS Disc → Outmode → Select
entry mode → Dial no. of the line → Enter → Exit
→ Exit → Exit →

To program a block of extensions:
LinesTrunks → TT/LS Disc → OutMode → Select
block of lines → Toggle LED On/Off → Enter →
Exit → Exit → Exit

† Entry mode available
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PC Procedure† To program a single extension:
[F4] → [F3] → [F1] → [F6] → Type no. of the line
→ [F10] → [F5] → [F5] → [F5]

To program a block of extensions:
[F4] → [F3] → [F1] → Select block of lines →
Toggle letter G On/Off → [F10] → [F5] → [F5]
→ [F5]

† Entry mode available
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Rotary Trunk Digit Transfer

Use this procedure to designate whether dialed digits on rotary dial trunks are
sent one-by-one as they are dialed (no delay), or are stored and sent when
dialing is completed (delay).

Summary: Rotary Trunk Digit Transfer

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6f, System Features

Delay

Delay and No Delay

No

No

Options → More → → Select Rotary → Select
option → Enter → Exit

[F7] → [PgUp] → [F4] → Select option → [F10] →
[F5]
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Disconnect Signaling Reliability

Use this procedure to classify the disconnect signal sent by the central office
on loop-start trunks as one of the following:

■   Reliable - signal sent within a short time

■   Unreliable - signal may not be provided

The setting selected applies to all trunks in the system; trunks cannot be
programmed individually. The reliable/unreliable setting does not apply to
ground-start trunks emulated on a T1 facility.

NOTE:
Certain features (Remote Call Forwarding and call transfer to outside
numbers) and applications (CMS, AUDIX Voice Power, and MERLIN
MAIL®) are not recommended with loop-start trunks. See “Hold
Disconnect Interval.”

If you specify a reliable disconnect for trunks programmed with a short
hold disconnect interval, active calls as well as trunks on hold may be
disconnected.

For more information about reliable and unreliable disconnect and its
implications, see the Feature Reference.
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Summary: Disconnect Signaling Reliability

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager, Integrated Administration

All

Not required

Form 2c, System Numbering – Trunk Jacks 

Unreliable

Unreliable, Reliable

No

No

LinesTrunks → TT/LS Disc → LS Disconnect
→ Yes/No → Enter → Exit → Exit

[F4] → [F3] →  [F2] → [F1] / [F2] → [F10] →
[F5]  → [F5]
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Toll Type

Use this procedure to specify whether users have to dial a toll prefix (1 or 0)
before dialing an area code and telephone number. (Your local telephone
company should verify toll

This setting is used by the
that toll restrictions can be

NOTE:
This option applies only to
to tie trunks or DID trunks.

Summary: Toll Type

prefix requirements for each trunk.)

system to classify calls as local or long distance so
applied as appropriate.

loop- and ground-start trunks; it does not apply

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

System manager

All

Not required

Form 2c, System Numbering - Trunk Jacks

Toll prefix required

Required, not required

No

Yes
† To program a single telephone:

LinesTrunks → Toll Type → Select entry mode
→ Dial no. of the line → Enter → Exit → Exit →

To program a block of telephones:
LinesTrunks → Toll Type → Select block of lines
→ Toggle LED On/Off → Enter → Exit → Exit

† Entry mode available
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PC Procedure† To program a
[F4] → [F10]
[F10]  → [F5]

To program a

single telephone:
→ [F6] → Type no. of the line →
→ [F5]

block of telephones:
[F4] → [F10]  → Select block of lines → Toggle letter
G On/Off → [F10] → [F5] → [F5]

† Entry mode available
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Hold Disconnect Interval

Use this procedure to specify the number of milliseconds before a loop-start
trunk is released when a caller on hold hangs up and abandons the call. This
can be specified as either a long interval (450 ms) or a short interval (50 ms).
The hold disconnect interval applies to loop-start trunks connected to 400,
408, or 800 modules; it does not apply to emulated loop-start trunks (T1
facility).

NOTE:
If the disconnect interval is longer than the telephone company setting,
the line is not released when a caller on hold hangs up. Do not program a
short interval unless the local telephone company’s central office is the
crossbar type.

Do not program a reliable disconnect for trunks with a short hold
disconnect interval. This can cause active calls as well as trunks on hold
to be disconnected. See “Disconnect Signaling Reliability.”

For more information on Hold Interval Disconnect and Reliable and Unreliable
Disconnect, see Feature Refefence.
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Summary: Hold Disconnect Interval

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 2c, System Numbering – Trunk Jacks

Long interval (450 ms)

Long interval, short interval

No

No

To program a single telephone:
LinesTrunks → More → HoldDiscnct → Select
entry mode → Dial no. of the trunk → Enter → Exit
→ Exit

To program a block of telephones:
LinesTrunks → More → HoldDiscnct → Select
block of lines → Toggle LED On/Off → Enter →
Exit → Exit

To program a single telephone:
[F4]  → [PgUp]  → [F1]  → [F6]  Type no. of the
trunk → [F10] → [F5] → [F5]

To program a block of telephones:
[F4] → [PgUp] → [F1] → Select block of lines →
Toggle letter G On/Off → [F10] → [F5] → [F5]

† Entry mode available
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Principal User for Personal Line

Use this procedure to assign or remove one telephone as principal user for a
personal line. When a telephone with Remote Call Forwarding activated is
assigned as principal user, calls received on the personal line are forwarded
to an outside telephone number. In addition, calls received on that line are
sent to that telephone’s individual and/or Group Coverage receivers unless
the Personal Line button is set to No Ring.

The principal user assignment must be removed before the trunk can be
removed from a button on the telephone.

When no principal user is assigned for a personal line, calls received on the
personal line are not forwarded to outside telephone numbers and calls
received on the personal line follow the Coverage patterns for all users who
share the line.
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Summary: Principal User for Personal Line

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 4b, Analog Multiline Telephone
Form 4d, MLX Telephone
Form 4e, MFM Adjunct-MLX telephone
Form 4f, Tip/Ring Equipment
Form 5a, Direct-Line Console (DLC) – Analog
Form 5b, Direct-Line Console (DLC) – Digital
Form 5c, MFM Adjunct-DLC

No principal user

Not applicable

No

No

LinesTrunks → More → PrncipalUsr → Dial
trunk no. → Enter → Dial ext. no. → Enter → Exit
→ Exit

[F4] → [PgUp] → [F2] → Type trunk no. → [F10]
→ Type ext. no. → [F10] → [F5] → [F5]
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Lines and Trunks

QCC Queue Priority Level

Use this procedure to assign QCC queue priority level values (1-7) to each
loop-start, ground-start, and automatic-in tie trunk in your system. The value
assigned determines the order in which calls are sent to the QCC operator
positions. Call priority 1 is the highest priority, 7 is the lowest priority.

NOTE:
This procedure applies only in Hybrid/PBX mode in a system that includes
QCC operator positions.
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Summary: QCC Queue Priority Level

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure†

PC Procedure

System manager

Hybrid/PBX

Not required

Form 2c, System Numbering - Trunk Jacks

4

1 - 7

Yes

No

To program a single extension:
LinesTrunks → More → QCC Prior → Dial priority
level → Enter → Select entry mode → Dial trunk no.
→ Enter → Exit → Exit

To program a block of extensions:
LinesTrunks → More → QCC Prior → Dial priority
level → Enter → Select block of lines → Toggle LED
On/Off → Enter → Exit → Exit

† To program a single extension:
[F4] → [PgUp] → [F3] → Type priority level →
[F10] → Select entry mode → Type trunk no. →
[F10] → [F5] → [F5]

To program a block of extensions:
[F4] → [PgUp] → [F3] → Type priority level →
[F10] → Select block of lines → Toggle letter G
On/Off → [F5] → [F5] → [F5]

† Entry mode available
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QCC Operator to Receive Calls

Use this procedure to do the following:

■    determine whether or not incoming calls on each trunk ring into the
QCC queue

■    identify the QCC system operator positions to receive incoming calls
on each trunk

NOTE:
This procedure applies only in Hybrid/PBX mode in a system that includes
QCC operator positions.

Each ground-start, loop-start, or automatic-in tie trunk programmed to ring into
the QCC queue can be associated with one or more QCC operator positions.

If a trunk assigned to ring into the QCC queue is also used for shared Remote
Access, use the “Remote Access Trunk Assignment” procedure to assign
remote access before you assign a QCC system operator to receive calls.

NOTE:
Do not change the factory setting of No QCC Operator Assigned to
Receive Calls for trunks dedicated to incoming calls for Calling Groups,
trunks used as personal lines, DID trunks, unequipped DS1 trunks, or
dial-in tie trunks.
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Summary: QCC Operator to Receive Calls

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure
†

PC Procedure

System manager

Hybrid/PBX

Not required

Form 2c, System Numbering – Trunk Jacks

No QCC operator is assigned to receive calls

Extension number of first or fifth

Yes

No

To program a single extension:
LinesTrunks → More → QCC

port

Oper → Dial ext. no.
→ Enter → Entry Mode → Dial trunk no. → Enter
→ Exit → Exit

To program a block of extensions:
LinesTrunks → More → QCC Oper → Dial ext. no.
→ Enter → Select block of lines → Toggle LED
On/Off → Enter → Exit → Exit

† To program a single extension:
[F4] → [PgUp] → [F4] → Type ext. no. → [F10] →
[F6] → Type trunk no. → [F10]  → [F5] → [F5]

To program a block of extensions:
[F4] → [PgUp] → [F4] → Type ext. no. → [F10] →
Select block of lines → Toggle letter G On/Off →
[F10]  → [F5]  → [F5]

† Entry mode available
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Trunks to Pools Assignment

NOTE:
This procedure applies in the Hybrid/PBX mode only.

Use this procedure to create pools (groups of outside trunks connected to the
system). Pools are used to specify preferred routes for Automatic Route
Selection. In addition, pools enable users to select a trunk by dialing a pool
dial-out code or by pressing a single button on the telephone. (A separate
button for each trunk is not needed.) Each pool should contain trunks of the
same type (for example, loop- or ground-start or WATS); however, ground-
and loop-start trunks of the same type can be included in the same pool.
Ground-start trunks must be manually assigned. A maximum of 11 pools is
allowed; a trunk can be assigned to only one pool.

Do not mix different bands of WATS trunks or FX lines to different cities. Do
not include both incoming only and outgoing only trunks in a pool.

If you want to reassign a trunk to a different pool, you must remove it from the
current pool before you assign it to the new pool. Once you assign a trunk to
a pool, it can be assigned to a button only on a direct-line console operator
position; individual lines intended for personal use on telephones other than
the DLC console should not be assigned to pools.

DID trunks and/or trunks used for paging loudspeakers, Music-on-Hold, or
maintenance alarms cannot be grouped in pools. Any such trunks that are
loop start are automatically placed in pools and must be manually removed.

Dial-in tie trunks should not be grouped in pools if you intend to assign pool
buttons on telephones.

If you are using Automatic Route Selection, the main pool (factory set dial-out
code 70) must contain loop- or ground-start lines.

The system provides an error tone when a trunk is in use or if a loudspeaker
paging system, Music-on-Hold, or Maintenance Alarm is already assigned;
however, the system does not indicate the reason for the error tone.
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Summary: Trunks to Pools Assignment

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure†

PC Procedure

System manager

Hybrid/PBX

Trunk idle

Form 2c, System Numbering — Trunk Jacks

All loop-start trunks are assigned to the Main Pool
(factory-set extension number 70); all tie trunks are
assigned to the pool with the factory-set extension
number 891; no factory-set extension assigned to
ground-start trunks.

Line numbers

Yes

Yes

LinesTrunks → Pools → Dial pool dial-out code →
Enter → Select block of lines → Toggle LED On/Off
→ Enter → Exit → Exit

† [F4] → [F9] → Type pool dial-out code → [F10] →
Select block of lines → Toggle letter R On/Off →
[F10]  → [F5]  → [F5]

† Entry mode available
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Copy Options for Lines/Trunks

Use this procedure to copy options assigned to loop-start or ground-start
trunks, tie trunks, or DID trunks. Note that many of these options apply to
Hybrid/PBX systems only. The following information is copied for each type:

■    For loop-start or ground-start trunks (including those emulated on T1
facilities): toll type, signaling type, and pool assignment (Hybrid/PBX
only)

■    For tie trunks: direction, tie trunk type, E&M signal, dial mode, dial
tone, answer supervision time, disconnect time, and pool assignment
(Hybrid/PBX only)

■    DID trunks (Hybrid/PBX only): block assignment and disconnect time

To find out whether there is an optional feature assigned that you would like to
copy, use Inspct from the system programming console or [PgDn] on a PC.

NOTE:
You can copy options to a block of trunks only if they are all the same
type (loop-start, ground-start, tie trunks, or DID trunks). If you attempt to
copy assignments and a mismatch in type is found, information is copied
to that point only. You receive no error message.

If you are copying options to a block of lines/trunks, they must be
sequentially numbered.

If the block you are copying to includes an invalid trunk type, the copying
process stops at the invalid type. Only the trunks that were copied to before
the invalid type was found are copied successfully.

If you are copying assignments to a block of trunks and one of the trunks is in
use, you see the message Trunk Busy - Pls Wait on your display. The
copy for the rest of the trunks in the block is delayed until the busy trunk
becomes idle. If you exit without waiting for the copying to be completed, the
copying done up to that point is not canceled.
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Summary Copy Options for Lines/Trunks

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All (but note differences)

Not required

Form 2c, System Numbering – Trunk Jacks
Form 3c, Incoming Trunks – Tie
Form 3d, Incoming Trunks – DID

Not applicable

Not applicable

No

Not applicable

To copy individual lines/trunks:
LinesTrunks → Copy → Single → Dial copy from
trunk no. → Enter → Dial copy to trunk no. → Enter
→ Exit → Exit → Exit

To copy blocks of lines/trunks:
LinesTrunks → Copy → Block → Dial copy from
trunk no. → Enter → Dial first copy to trunk no. in
block → Enter  Dial last copy to trunk no. in block
→ Enter → Exit → Exit → Exit

To copy individual trunks:
[F4]  → [F7]  → [F1]  → Type copy to trunk no. →
[F10] → Type copy from trunk no. → [F10] → [F5]
→ [F5] → [F5]

To copy blocks of trunks:
[F4]  → [F7]  → [F2]  → Dial copy from trunk no. →
[F10] → Dial first copy to trunk no. in block → [F10]
→ Dial last copy to trunk no. in block → [F10] →
[F5 ] → [F5 ] → [F5 ]
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DS1 Facilities 5
Use the procedures in this chapter to program the following options for DS1
facilities (T1 or PRI) connected to a 100D (DS1) module:

Type of DS1 facility

— T1

— PRI

Frame Format

Zero Code Suppression

Signaling Mode

Line Compensation

Clock Synchronization

Channel Service Unit

DS1 Facilities 5-1



DS1 Facilities

Type of DS1 Facility

Use this procedure to specify the type of facility (T1 or PRI) connected to a
100D (DS1) module.

If T1 type is programmed and the channels are used for emulation anti/or
AT&T Switched Network (ASN), you must specify the type of channel
emulation. If the type is T1 and the type of channel emulation is tie trunk, you
must specify the transmit/receive loss parameter setting. The two valid
settings are:

■    TIE-PBX Select when emulated tie trunks are used to connect to
another communications system (such as PBX or Centrex). The
transmit/receive parameter is set to 0/4.

■    Toll Select when emulated tie trunks are used for ASN services (such
as Megacom, Megacom 800, or Software Defined Network). The
transmit/receive parameter is set to 0/6.

If you select T1, channels can emulate ground-or loop-start trunks, tie trunks,
or DID trunks in any combination. Note that unused channels must be
specified as unequipped.

If either T1 or PRI is selected, channels can be used for ASN services. When
T1 channels are used for ASN services, each channel must be programmed
for tie trunk emulation.

If you select PRI, you must also perform additional procedures—at a
minimum, the Framing Mode and Zero Code Suppression procedures must
be performed.
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Summary: Type of DS1 Facility

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

System manager

All

100D module idle

Form 2c,
Form 3b,
Module)

T1

T1, PRI

Yes

No

System Numbering - Trunk Jacks
Incoming Trunks – DS1 Connectivity (100D

To select PRI:
LinesTrunks → LS/GS/DS1 → Dial slot no. →
Enter → Type → PRI → Enter → Exit → Exit →
Exit → Exit

To select T1 - All Ground, All Loop, All DID, All
Unequip:
LinesTrunks → LS/GS/DS1 → Dial slot no.  →
Enter → Type → T1 → Enter → More → Select
type of emulation → Enter → Exit → Exit → Exit
→ Exit

To select T1 - TIE:
LinesTrunks → LS/GS/DS1 → Dial slot no.  →
Enter → Type → T1 → Enter → TIE-PBX or Toll
→ Enter → Dial channel no. → Enter → Exit →
Exit → Exit → Exit

To select T1 - Ground Start, Loop Start, All Tie, DID,
or Unequip:
LinesTrunks → LS/GS/DS1 → Dial slot no.  →
Enter → Type → T1 → Enter → More → Select
type of emulation → Enter → Dial channel no. →
Enter → Exit → Exit → Exit → Exit
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PC Procedure To select PRI:
[F4] → [F1] → Type slot. no. → [F10] → [F1] → 
[F2] → [F10]  → [F5] → [F5] → [F5] → [F5]

To select T1 - All Ground, All Loop, All DID, All
Unequip:
[F4] →
[F1] →
→ [F10]

[F1] → Type slot no. → [F10]  → [F1] →
 [F10] → [PgUp] → Select type of emulation
→ [F5] → [F5] → [F5] → [F5]

To select T1 - Tie:
[F4]  →
[F1] →
channel

[F1]  → Type slot no. → [F10]  → [F1]  →
[F10] → Select facility → [F10] → Type
no. → [F10]  → [F5]  → [F5]  → [F5]  →

[F5]

To select T1 - G
or Unequip:
[F4 ] → 
[F1 ] → 
→ [F10]
[F5]  →

5-4  Type of DS1 Facility

round Start, Loop Start, All Tie, DID,

DS1 Facilities

[F1] → Type slot no. → [F10]  → [F1] →
[F10] →  [PgUp] → Select type of emulation
→ Type channel no. → [F10]  → [F5] →
[F5] → [F5]



DS1 Facilities

Frame Format

Use this procedure to specify the framing format for the 100D module as D4
Compatible or Extended Super Frame. Your selection must match the framing
mode at the far end of the DS1 facility.

Summary: Frame Format

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

100D module idle

Form 3b, Incoming Trunks - DS1 Connectivity (100D
Module)

D4 compatible

D4, ESF

No

No

LinesTrunks → LS/GS/DS1 → Dial slot no. →
Enter → FrameFormat → Select format type →
Enter → Exit → Exit

[F4]  → [F1]  → Type slot no. → [F10]  → [F2]  →
Select format type → [F10] → [F5] → [F5]
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Zero Code Suppression

Use this procedure to specify zero code suppression for the 100D module as
AMI Zero Code Suppression (AMI-ZCS) or Bipolar 8 Zero Suppression
(B82S). Your selection must match the suppression at the far end of the DS1
facility.

Summary: Zero Code Suppression

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

100D module idle

Form 3b, Incoming Trunks - DS1 Connectivity (100D
Module)

AMI-ZCS

AMI-ZCS, B8ZS

No

No

LinesTrunks → LS/GS/DS1 → Dial slot no. →
Enter → Suppression → select zero code
suppression → Enter → Exit → Exit →

[F4] → [F1] → Type slot no. → [F10] → [F3] →
Select zero code suppression → [F10] → [F5] →
[F5]

5-6  Zero Code Suppression



DS1 Facilities

Signaling Mode
●

Use this procedure to specify the signaling for the 100D module as robbed-bit
or common-channel signaling.

NOTE:
This procedure is needed only for T1 facilities; signaling is set
automatically for PRI facilities.

Summary: Signaling Mode

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

100D module idle

Form 3b, Incoming Trunks - DS1 Connectivity (100D
Module)

Robbed bit

Robbed Bit, Common Channel

No

No

LinesTrunks → LS/GS/DS1 → Dial slot no.  →
Enter → Signaling → Select type of signaling →
Enter → Exit → Exit →

[F4] → [F1] → Type slot no. → [F10] → [F4] →
Select type of signaling → [F10] → [F5] → [F5]
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Line Compensation

Use this procedure to specify the amount of cable loss in decibels based on
the length of cable between the 100D module and the channel service unit or
far end. The choices are as follows:

■   1 = 0.6 dB loss

■   2 = 1.2 dB loss

■   3 = 1.8 dB loss

■   4 = 2.4 dB loss

■   5 = 3.0 dB loss

Summary: Line Compensation

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

100D module idle

Form 3b, Incoming Trunks - DS1 Connectivity (100D
Module)

1 (0.6 dB loss)

1 - 5

No

No

LinesTrunks → LS/GS/DS1 → Dial Slot no. →
Enter → Line Comp → Drop → Dial line
compensation value → Enter → Exit → Exit

[F4] → [F1] → Type slot no. → [F10] → [F6] →
[Alt] + [P] → Type line compensation value →
[F10] → [F5] → [F5]
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Clock Synchronization

Use this procedure to specify the modules that provide primary, secondary,
and tertiary clock synchronization. In addition, you can specify whether the
clock is synchronized to the external end point (loop) or to the clock reference
source (local). This procedure is also used to activate or deactivate the clock.
NOTE:
This procedure is necessary only if your system includes more than one
100D module.

Summary: Clock Synchronization

Programmable by System manager

Mode All

Idle Condition Not required

Planning Form Form 3b, Incoming Trunks - DS1 Connectivity (100D
Module)

Factory Setting Primary clock - the first 100D module in the control
unit carrier; source – loop;

Valid Entries Primary/secondary/tertiary

Inspect No

Copy Option No

activation – active

and loop/local

Console Procedure LinesTrunks → LS/GS/DS1 → Dial slot no. →
Enter → Clock Sync → Priority → Select clock
synchronization → Enter → Source → Select
source of synchronization → Enter → Activation
→ Select clock activation → Enter → Exit → Exit
→ Exit

PC Procedure [F4] → [F1] → Type slot no. → [F10] → [F7] →
[F1] → Select clock synchronization → [F10] →
[F2]  → Select
[F3]  → Select

[F5]  → [F5]

source of synchronization → [F10] →
clock activation → [F10] → [F5] →
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Channel Service Unit

Use this procedure to specify the type of equipment provided by the local
telephone company as foreign exchange or special access.

NOTE:
You do not need to use this procedure unless your system emulates loop
start or ground start with the T1 type of DS1 facility.

Summary: Channel Service Unit

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

100D module idle

Form 3b, Incoming Trunks - DS1 Connectivity (100D
Module)

Foreign Exchange

Foreign Exchange, Special Access

No

No

LinesTrunks → LS/GS/DS1 → Dial Slot no. →
Enter → ChannelUnit → Select type of channel
Unit → Enter → Exit → Exit

[F4]  → [F1]  → Type slot no. → [F10] → [F8] →
Select type of channel unit → [F10] → [F5] → [F5]

5-10  Channel Service Unit



Tie Trunks 6

The procedures in this chapter tell you how to program the following options
for tie trunks:

■   Direction

■   Tie Trunk Type

■   E&M Signal

■   Dial Mode

■   Tie Trunk Dial Tone

■   Tie Trunk Answer Supervision Time

■   Disconnect Time

Tie Trunks 6-1



Tie Trunks

Direction

Use this procedure to specify whether tie trunks
direction. For one-way tie trunks, you must also
is out or in.

Summary: Direction

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

operate in a one- or two-way
specify whether the direction

System manager

All

Tie trunk idle

Form 3c, Incoming Trunks - Tie

Two-way

Two-way, Outgoing, Incoming

No

Yes

LinesTrunks → TIE Lines → Direction → Dial
trunk no. → Enter → Specify direction → Enter →
Exit → Exit

[F4] → [F2] → [F1] → Type trunk no. → [F10]  →
Specify direction → [F10]  → [F5] → [F5]
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Tie Trunk Type

Use this procedure to specify whether the signaling type of incoming or
outgoing tie trunk is wink, delay, immediate, or automatic.

The following settings are recommended when T1 facilities are programmed
for tie-trunk emulation to provide special network services (such as Megacom,
Megacom 800, or Software Defined Network (SDN):

If Automatic Route Selection (ARS) is used for all outgoing calls and no
Personal Line or Pool buttons are used, assign the wink signaling type.
Set the network to wink.

If Personal Line or Pool buttons (pool or dial-out codes) are used for
outgoing calls, assign the immediate signaling type. Set the network to
dial.

If Dialed Number Identification Service (DNIS) is used for incoming
calls, assign the wink signaling type. The network is also set to wink.
(Setting both ends to immediate also works. Check with the network
service provider for proper settings.)

When DNIS is not used for incoming calls, assign the automatic
signaling type. The network is also set to automatic.
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Tie Trunks

Summary: Tie Trunk Type

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Tie trunk idle

Form 3c, Incoming Trunks - Tie

Wink

Wink, Delay, Immediate, Automatic

No

Yes

LinesTrunks → TIE Lines → Intype/Outtype
→ Dial trunk no. → Enter → Specify trunk type →
Enter → Exit → Exit

[F4]
[F10]

→
→

[F2] →
Specify

[F2]
trunk

/ [F3] → Type trunk no. →
type → [F10]  → [F5] → [F5]
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Tie Trunks

E&M Signal

Use this procedure to specify the type of tie trunk signal, as follows:

■   1S - tie trunks are connected through the local telephone company

■   1C - tie trunks are connected directly to a system using 1S signaling

■     5 - tie trunks are connected to a system using type 5 signaling

Summary: E&M Signal

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Tie trunk idle

Form 3c, Incoming Trunks - Tie

1S

1S, 1C, 5

No

Yes

LinesTrunks → TIE Lines → E&M Signal →
Dial trunk no. → Enter → Specify signaling type →
Enter → Exit → Exit

[F4] → [F2] → [F4] →
Specify signaling type →

Type trunk no. →
[F10] → [F5] →

[F10] →
[F5]
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Dial Mode

Use this procedure to specify whether an incoming or outgoing tie trunk is
touch-tone or rotary.

NOTE:
Touch-tone cannot be programmed for incoming immediate tie trunks.

Users of touch-tone single-line telephones cannot make calls by using
individual trunks programmed for rotary operation.

Summary: Dial Mode

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure†

PC Procedure†

System manager

All

Not required

Form 3c, Incoming Trunks - Tie

Rotary

Rotary, touch-tone

Yes

Yes

LinesTrunks → TIE Lines → Inmode/Outmode
→ Select block of lines → Toggle LED On/Off → Exit
→ Exit → Exit

[F4] → [F2] → [F6] / [F7] → Select block of lines
→ Toggle letter G On/Off → [F5] → [F5] → [F5]

† Entry mode available
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Tie Trunks

Tie Trunk Dial Tone

Use this procedure to specify whether the system provides dial tone for
people calling in on a tie trunk. Settings are remote (system provides dial
tone) and local (system does not provide dial tone).

Summary: Tie Trunk Dial Tone

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 3c, Incoming Trunks - Tie

Remote

Remote, Local

Yes

Yes

LinesTrunks → TIE Lines → Dialtone → Select
block of lines → Toggle LED On/Off → Exit → Exit
→ Exit

[F4] → [F2] → [F8]  → Select block of lines →
Toggle letter G On/Off → [F5] → [F5] → [F5]

† Entry mode available

Tie Trunk Dial Tone  6-7



Tie Trunks

Tie Trunk Answer Supervision Time

Use this procedure to specify the tie-trunk answer supervision time in
milliseconds.

Summary: Tie Trunk Answer Supervision Time

Programmable by System manager

Mode All

Idle Condition Not required

Planning Form Form 3c, Incoming Trunks – Tie

Factory Setting 300 ms

Valid Entries 20 - 4800 ms, in increments of 20 ms

Inspect No

Copy Option Yes

Console Procedure LinesTrunks → TIE Lines → AnsSupvr → Dial
trunk no. → Enter → Drop → Dial no. of ms →
Enter → Exit → Exit

PC Procedure [F4] → [F2] → [F9] → Type trunk no. → [F10]  →
[Alt] + [P] → Type no. of ms → [F10]  → [F5] →
[ F 5 ]
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Disconnect Time

Use this procedure to specify the tie trunk disconnect time in milliseconds.

Summary: Disconnect Time

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 3c, Incoming Trunks - Tie

300 ms

140 - 2400 ms

No

Yes

LinesTrunks → TIE Lines → Disconnect →
Dial trunk no. → Enter → Drop → Dial no. of ms →
Enter → Exit → Exit

[F4] → [F2] → [F10] → Type Trunk no. →
[F10]  → [Alt]  + [P] → Type n. of ms → [F10]  →
[F5] → [F5]
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These procedures detail the steps for programming DID trunks. The following
procedures are included:

■   Block Assignment

■   DID Trunk Type

■   Disconnect Time

■   Expected Digits

■   Delete Digits

■   Add Digits

■   Signaling

■   Invalid Destination

NOTE:
These procedures apply only in the Hybrid/PBX mode.

DID Trunks 7-1
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Block Assignment

Use this procedure to assign each DID trunk connected to the system either
to Block 1 or Block 2.

NOTE:
DID trunks apply only in Hybrid/PBX mode.

Summary: Block Assignment

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 3d, Incoming Trunks - DID

Block 1

Block 1, Block 2

Yes

Yes

LinesTrunks → DID → Block → Dial trunk block
no. → Enter → Select trunk lines → Type trunk block
no. → Enter → Toggle LED On/Off → Enter →
Exit → Exit → Exit

[F4] → [F4] → [F1] → Type trunk block no. →
[F10] → Select trunk lines → Toggle letter G On/Off →
[F10] → [F5] → [F5] → [F5]
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DID Trunk Type

Use this procedure to specify the type of DID trunk as either immediate-start
or wink-start.

NOTE:
DID trunks apply only in Hybrid/PBX mode.

Summary: DID Trunk Type

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

DID trunk idle

Form 3d, Incoming Trunks – DID

Wink-start

Immediate-Start, Wink-Start

No

No

LinesTrunks → DID → Type → Dial trunk block no.
→ Enter → Immed/Wink → Enter →
Exit → Exit

[F4] → [F4] → [F2] → Type trunk block no. →
[F10] → [F1] / [F2] → [F10] → [F5] → [F5]

DID Trunk Type 7-3
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Disconnect Time

Use this procedure to specify the DID trunk disconnect time in milliseconds

NOTE:
DID trunks apply only in Hybrid/PBX mode.

Summary: Disconnect Time

Programmable by System manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form Form 3d, Incoming Trunks - DID

Factory Setting 500 ms

Valid Entries 10 - 2400 ms, in increments of 10 ms

Inspect No

Copy Option Yes

Console Procedure Lines Trunks → DID → Disconnect → Dial trunk
no. → Drop → Dial no. of ms → Enter → Exit →
Exit

PC Procedure [F4] → [F4] → [F3] → Type trunk no. → [F10] →
[Alt] + [P] → Type no. of ms → [F10] → [F5] →
[F5]

7-4 Disconnect Time
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Expected Digits

Use this procedure to specify the number of digits sent by the local telephone
company.

NOTE:
DID trunks apply only in Hybrid/PBX mode.

Summary: Expected Digits

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 3d, Incoming Trunks - DID

3 digits

1 - 4 digits

No

No

LinesTrunks → DID → ExpectDigit → Dial trunk
block no. → Enter → Drop → Dial no. of digits →
Enter → Exit → Exit

[F4]  → [F4]  → [F4]  → Type trunk block no. →
[F10]  → [Alt]  + [P]  → Type no. of digits → [F10]
→ [F5] → [F5]

Expected Digits 7-5
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Delete Digits

Use this procedure to specify the number of digits to be deleted from the
digits sent by the

NOTE:
DID trunks apply

Summary Delete

local telephone company.

only in Hybrid/PBX mode.

Digits

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 3d, Incoming Trunks - DID

0 digits

0 - 4 digits

No

No

LinesTrunks → DID → DeleteDigit → Dial trunk
block no. → Enter → Drop → Dial no. of digits →
Enter → Exit → Exit

[F4] → [F4] → [F6] → Type trunk block no. →
[F10] → [Alt] + [P] → Type no. of digits → [F10]
→ [F5] → [F5]  

7-6 Delete Digits
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Add Digits

Use this procedure to specify the specific digits that must be added to the
digits sent by the local telephone company.

NOTE:
DID trunks apply only in Hybrid/PBX mode.

Summary: Add Digits

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 3d, Incoming Trunks - DID

0

1 - 9999

No

No

LinesTrunks → DID → Add Digits → Dial trunk
block no. → Enter → Drop → Dial added digits →
Enter → Exit → Exit

[F4]  → [F4]  → [F7]  → Type trunk block no. →
[F10] → [Alt] + [P] → Type added digits → [F10]
→ [F5] → [F5]
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Signaling

Use this procedure to specify whether the type of dialing signal from the local
telephone company is touch-tone or rotary.

NOTE:
DID trunks apply only in Hybrid/PBX mode.

Touch-tone dial mode cannot be programmed for immediate start DID trunks.

Touch-tone single-line telephone users cannot make calls by using individual
trunks programmed for rotary operation. The touch-tone signals generated
from the telephone while dialing are transmitted to the central office at the
same time the rotary signals are sent to the system. The central office
receives both signals and cannot process the call.

Summary: Signaling

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 3d, Incoming Trunks - DID

Rotary

Rotary, Touch-tone

No

No

LinesTrunks → DID → Signaling → Dial trunk
block no. → Enter → Rotary/TouchTone → Enter
→ Exit → Exit

[F4] → [F4] → [F8] → Type trunk block no. →
[F10]  → [F1] / [F2]  → [F10]  → [F5]  → [F5]
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Invalid Destination

Use this procedure to specify whereto direct outside calls (received on DID
trunks) to unassigned extension numbers. Calls can be directed to a backup
position (normally the primary system operator) or given a fast busy signal,

NOTE:
DID trunks apply only in Hybrid/PBX mode. 

Summary: Invalid Destination

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 3d, Incoming Trunks - DID

Backup (calls are sent to the primary system
operator)

Backup, Fast Busy

No

No

LinesTrunks → DID → InvalDstn → Send to
Backup Extension/Return Fast Busy →
Enter → Exit → Exit

[ F 4 ] → [ F 4 ] → [ F 9 ] → [ F 1 ] / [ F 2 ] →
[ F 1 0 ] →
[ F 5 ] → [ F 5 ]

Invalid Destination 7-9



PRI Facilities 8
The procedures in this chapter provide the steps for programming the
following options for Primary Rate Interface (PRI) Facilities connected to a
100D (DS1) module:

■

■

■

■

■

■

■

■

■

■

■

■

■

■

Telephone Number
B-Channel Groups
Network Service
Copy Telephone Number to Send
Incoming Routing
Telephone Number to Send
Test Telephone Number
Timers and Counters
Terminal Equipment Identifier
Dial Plan Routing
Outgoing Tables
Network Selection Tables
Special Services Tables
Call-by-Call Service Table

PRI Facilities 8-1
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NOTE:
If you are adding PRI Facilities to an existing system, do not start these
procedures until you have checked the following:

■   Type of DS1 Facility must be set to PRI.

■   Frame Format must be specified correctly.

■   Zero Code Suppression must be specified correctly.

Your system will not operate properly if these values are not correctly set.
To inspector change these values, see Chapter 5.

If you are using ARS in connection with PRI, make sure you select voice, data,
or voice and data as appropriate when you perform the ARS “Voice and/or
Data Routing” procedure under Automatic Route Selection section.

8-2 PRI Facilities
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Telephone Number

Use this procedure to assign a string of up to 12 digits to each PRI channel.
This string must match the number sent by the network (that is, the number
provided by the PRI service provider) to indicate the number dialed by an
outside caller. The system uses this number to route the call to the correct
destination, thus the number assigned to each channel in
group must be unique. Note also that the number cannot
associated test telephone number.

Summary: Telephone Number

the same B-channel
be the same as the

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 3b, Incoming Trunks – DS1 Connectivity (100D
Module)

No digits

Up to 12 digits in any combination of the digits 0 - 9

No

No

LinesTrunks → PRI → PhoneNumber → Dial trunk
no. → Enter → Drop → Dial telephone no. → Enter
→ Exit → Exit

[F4] → [F6] → [F1] → Type trunk no. → [F10] →
[Alt] + [P] → Type telephone no. → [F10] → [F5]
→ [F5]

Telephone Number 8-3
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B-Channel Groups

Use this procedure to assign B-channels to a group and to associate
individual ISDN channels that can place and receive calls on the B-channels
in each group.

Each B-channel can be assigned to only one group, and each ISDN channel
can be associated with only one group.

Each group can contain up to 23 channels; however, all channels assigned
must signal through the same D-channel (that is, must be connected to the
same 100D module).

B-channels must be assigned in the order of system search (through the
group) for an available channel. To minimize call attempts on the same line or
trunk, arrange B-channels in the opposite order of the hunting arrangement
provided by the network service provider.

B-channels must be identified by control unit slot and port number since they
are not associated with a line/trunk number or a logical ID. Up to 69 B-
channel groups can be established.

8-4 B-Channel Groups
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Summary: B-Channel Groups

Programmable by System manager

Mode All

Idle Condition Not required

Planning Form Form 3b, Incoming Trunks - DS1 Connectivity
(100D Module)

Factory Setting Not applicable

Valid Entries Group numbers

Inspect Yes

Copy Option No

Console Procedure LinesTrunks → PRI → B–ChannlGrp →
B Channels → Dial group no. → Enter → Dial B
channel slot and port no. → Enter → Lines → Dial
group no. → Enter → Select specific lines/trunks →
Turn green LEDs on/off → Exit → Exit → Exit

PC Procedure [F4] → [F6] → [F2] → [F1] → Type group no. →
[F10] → Type B channel slot and port nos. → [F10]
→ [F2] → Type group no. → [F10] → Select specific
lines/trunks → Toggle G on/off → [F5] → [F5] →
[F5]

† Entry mode available

B-Channel Groups 8-5
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Network Service

Use this procedure to specify the type of outgoing service provided by each
B-channel group (Megacom WATS and 800, MultiQuest Service, ACCUNET
Switched Digital Service (SDS), or Software Defined Network (SDN).

MultiQuest or any other service not shown on the Network Service screen can
be indicated by entering the 5-digit binary code that represents the service in
the Network Facilities Information Element of ISDN PRI layer 3 signaling
protocol. The code for MultiQuest is 10000.

Summary: Network Service

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 3b, Incoming Trunks - DS1 Connectivity (100D
Module)

Not applicable

AT&T Toll, Local, Mist

No

No

LinesTrunks → PRI → B-ChannlGrp →
NetworkServ → Dial group no.  → Enter → Specify
network Service → Enter → Exit → Exit → Exit
→ Exit

[F4]  → [F6]  → [F2]  → [F3]  → Type group no. → 
[F10] → Specify network service → [F10] →
[F5] → [F5] → [F5] → [F5]

8-6 Network Service
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Copy Telephone Number to Send

Use this procedure to indicate whether or not the telephone number to send
to the network for calls going out over ISDN lines assigned to a B-channel
group, is copied from the number assigned to that channel.

Select “Do Not Copy Phone Number” when a telephone number to send is
assigned to each channel in the B-channel group or when no telephone
number is to be sent to the network. In the latter case, make sure that no
telephone number is assigned to each channel in the B-channel group by
using the “Telephone Number to Send” procedure.

Summary: Copy Telephone Number to Send

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 3b, Incoming Trunks – DS1 Connectivity

Do not copy

Do not copy, copy

No

No

LinesTrunks → PRI → B ChannlGrp → Copy
Number → Dial group no. → Enter → Specify Copy
or no copy → Enter → Exit → Exit → Exit

[F4] → [F6] → [F2] → [F4] → Type group no. →
[F10] → Specify copy or no copy → [F10] →
[F5] → [F5] → [F5]

Copy Telephone Number to Send  8-7
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Incoming Routing

Use this procedure to specify whether incoming routing is by line appearance
or according to dial plan. Dial Plan Routing is available in Hybrid/PBX mode
only.

Summary: Incoming Routing

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

Line appearance – All; Dial Plan Routing - Hybrid/PBX
only

Not required

Form 3b, Incoming Trunks – DS1 Connectivity (100D
Module)

Line appearance

Dial Plan Routing, Routing by Line Appearance

No

No

LinesTrunks → PRI → B-ChannlGrp →
Incoming Rtg → Dial B-channel group no. →
Enter → Specify method of routing → Enter →
Exit → Exit → Exit

[F4]  → [F6]  → [F2]  → [F6]  → Type B-channel
group no. → [F10] → Specify method of routing →
[F10]  → [F5] → [F5] → [F5]
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Telephone Number to Send

Use this procedure to assign the telephone number to send to the network
when outgoing calls are made on an ISDN line. If the person being called
subscribes to an automatic number identification service, the number
indicates who is calling.

The number assigned to each channel does not have to be unique because it
is not used for routing.

Summary: Telephone Number to Send

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 3b, Incoming Trunks - DS1 Connectivity (100D
Module)

No digits are assigned

Up to 12 digits in any combination of the digits 0-9

No

No

LinesTrunks → PRI → NumbrToSend  → Specify
type of no. → Enter → Drop → Dial base no. →
Enter → Dial line no. → Enter → Drop → Dial
telephone no. → Enter → Exit → Exit

[F4] → [F6] → [F3] → Specify type of no. →
[F10] → [Alt] + [P] → Type base no. → [F10] →
[Alt] + [P] → Type telephone no. → [F10]  → [F5]
→ [F5]

Telephone Number to Send  8-9
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Test Telephone Number

Use this procedure to assign a test line or trunk telephone number for each
100odule installed in the control unit.

The number assigned to the test line/trunk must be different from the numbers
assigned to other channels in the same B-channel group. It must be the
same as the number provided by the PRI service provider.

Summary: Test Telephone Number

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 3b, Incoming Trunks – DS1 Connectivity (100D
Module)

Not applicable

Telephone number

No

No

LinesTrunks → PRI → Test TelNum → Dial slot 
no. → Enter → Drop → Dial telephone no. → Enter
→ Exit → Exit

[F4] → [F6] → [F4] → Type slot no. → [F10] →
[Alt] + [P] → Type telephone no. → [F10] → [F5]
→ [F5]

8-10  Test Telephone Number
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Timers and Counters

Use this procedure to set timer and counter thresholds.

CAUTION:
The factory settings for these thresholds are standard and rarely
need to be changed.

If you are not sure of the correct timer and threshold settings for your
PRI lines and trunks, check with your authorized support
representative before you make a change.

Incorrect settings can cause your PRI lines and trunks to malfunction.

When no response is received from the network before the programmed
setting, the system takes the appropriate corrective action.

The timers and counters are the following:

T200 Timer – times the delay in the link layer acknowledgement of a
message sent from the system to the network over a D-channel.

T203 Timer – times the interval between each exchange of messages
between the system and the network on the D-channel

N200 Counter – counts the number of times the system has transmitted
a message on a D-channel because no link layer acknowledgement is
received from the network

N201 Counter – counts the maximum number of layer 3 octets the
system can send or receive in a single D-channel message

K Counter – counts the number of layer 3 unacknowledged messages
sent from the system to the network on a D-channel

T303 Timer – times the delay in network response when the system
sends a setup message to initiate an outgoing call

T305 Timer - times the delay in network response when the system
sends a disconnect message to clear a call
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■    T308 Timer – times the delay in network response when the system
sends a release message to clear a call

■    T309 Timer – times the duration of a D-channel data link failure (a loss
of signaling for the entire PRI connection)

■    T310 Timer – times the network delay following the receipt of a call
proceeding message on an outgoing call

■    T313 Timer – times the delay in network response when the system
sends a connect message that indicates the completion of an
incoming call

■    T316 Timer – times the delay in network response when the system
sends a restart message to clear a B-channel

NOTE:
If you enter an invalid timer value, the number you enter is truncated to
the closest valid value. For example, if you enter 45 for a counter that
ranges from 0 – 30, 4 is recorded.

The following table shows the factory setting for each timer and counter
the valid range for each threshold.

Summary: Timers and Counters

and

Programmable by System manager

Mode All

Idle Condition Not required

Planning Form Form 3b, Incoming Trunks - DS1 Connectivity (100D
Module)

Factory Setting See Table 8-1
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Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

Table 8-1. Timers and Counters

Timer/Counter Setting Factory Setting Valid Range

T200 Timer

T203 Timer

N200 Counter

N201 Counter

K Counter

T303 Timer

T305 Timer

T308 Timer

T309 Timer

T310 Timer

T313 Timer

T316 Timer

Maximum response time

Maximum time

Maximum transmissions

Maximum octets

Maximum outstanding
l-frames

Setup timeout

Disconnect timeout

Release timeout

Signal loss

Call Proc. timeout

Connect timeout

Restart timeout

1 second

30 seconds

3 transmissions

260 octets

7 frames

4 seconds

4 seconds

4 seconds

90 seconds

10 seconds

4 seconds

120 seconds

1000 - 3000 ms

1 - 60 seconds

1 - 5 transmissions

16 - 260 octets

1 - 15 frames

4 - 12 seconds

4 - 30 seconds

4 - 12 seconds

30 - 120 seconds

2 - 10 seconds

4 - 12 seconds

30 - 120 seconds

See Table 8-1

No

No

Lines Trunks → PRI → Protocol → Timers →
Dial slot no. → Enter → Select timer/counter  → Drop
→ Dial no. of ms/octets/etc. → Enter → Exit →
Exit → Exit → Exit

[F4] → [F6] → [F6] → [F1] → Type slot no. →
[F10] → Select timer/counter → [Alt] + [P] → Type
no. of ms/octets/etc. → [F10] → [F5] → [F5] →
[F5] → [F5]
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Terminal Equipment Identifier

Use this procedure to assign the link layer address of a piece of equipment
connected to each D-channel. Normally, only one piece is connected and the
system assumes that the Terminal Equipment Identifier (TEI) is 0.

CAUTION:
The value of the TEI rarely has to be changed.

Check with your authorized support representative before changing
this value.

Summary: Terminal Equipment Identifier

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 3b, Incoming Trunks – DS1 Connectivity (100D
Module)

0

0 - 6 3

No

No

LinesTrunks → PRI → Protocol → TEI → Dial
slot no. → Enter → Drop → Dial new ID no. →
Enter → Exit → Exit → Exit

[F4]  → [F6]  → [F6]  → [F2]   Type slot no. →
[F10] → [Alt] → [P] → Type new ID no. → [F10] →
[F5] → [F5] → [F5]
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Dial Plan Routing

Dial Plan Routing is available only in Hybrid/PBX mode. Key and Behind
Switch systems route incoming calls by line.

Dial Plan Routing provides a way of routing incoming calls on a “per B-
channel group” basis. An incoming call is routed by matching the incoming
number (by service, number of digits, and pattern) and then optionally
deleting and/or adding digits to direct the call to a specific endpoint. A
service must be specified; the number of digits and pattern are optional. For
example, you can specify that calls received from a particular area code
should be routed to the specific individual or group responsible for accounts
in that area.
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Summary: Dial Plan Routing

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

System manager

Hybrid/PBX

Not required

System Form 3b, Incoming Trunks - DS1 Connectivity
(100D Module)

Not applicable

Not applicable

No

No

To specify Service:
LinesTrunks → PRI → DialPlanRtg → Service
→ Dial entry no. → Enter → Select service → Exit
→ Exit → Exit

To specify Patterns:
LinesTrunks → PRI → DialPlanRtg →
Patterns → Dial entry no. → Enter → Drop → Dial
pattern → Enter → Exit → Exit → Exit

To specify Total Digits:
LinesTrunks → PRI → DialPlanRtg → Total
Digits → Dial entry no. → Enter → Drop → Dial
digits → Enter → Exit → Exit → Exit

To specify Delete Digits:
LinesTrunks → PRI → DialPlanRtg → Delete
Digits → Dial entry no. → Enter → Drop → Dial
delete digits → Enter → Exit → Exit → Exit

To specify Add Digits:
LinesTrunks → PRI → DialPlanRtg → Add
Digits → Dial entry no. → Enter → Drop → Dial
add digits → Enter → Exit → Exit → Exit

8-16 Dial Plan Routing



PRI Facilities

PC Procedure To specify Service:
[F4] → [F6] → [F7] → [F1] → Type entry no. →
[F10] → Select service →  [F10] → [F5] → [F5] →
[ F 5 ]

To specify Patterns:
[F4] → [F6] → [F7] → [F2] → Type entry no. →
[F10]  → [Alt] + [P] → Type pattern → [F10]  →
[F5] → [F5] → [F5]

To specify Total Digits:
[F4] → [F6] → [F7] → [F3] → Type entry no. →
[F10] → [Alt] + [P] → Type digits → [F10] →
[F5] → [F5] → [F5]

To specify Delete Digits:
[F4] → [F6] → [F7] → [F4] → Type enrty no.
[F10]  → [Alt]  + [P] → Type specify Delete D
[F10] → [F5] → [F5] → [F5]

→
igits →

To specify Add Digits:
[F4] → [F6] → [F7] → [F5] → Type entry no. →
[F10] → [Alt] + [P] → Type add digits → [F10] →
[F5]  → [F5]  → [F5]
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Outgoing Tables

PRI provides tables that work in conjunction with pools and ARS tables to
route calls. The following tables specify services for outgoing calls:

Network Selection selects a long distance carrier. Calls that match
Network Selection tables can be routed to a specific
service by the Call by Call tables.

Special Services selects services such as international dialing and
operator assistance. Calls that match these tables
are not routed by Call by Call tables.

Call-by-Call selects an outgoing service, based on routing digits
and the bearer capability (voice, data, or both) of the
calling extension. It allows a single group of B
channels to carry a variety of services, such as
ACCUNET, SDN, and Megacom WATS.

8-18  Dial Plan Routing



PRI Facilities

Network Selection Tables

Dialed prefixes for selecting long distance carriers are matched to entries in
the four Network Selection tables. Eight default tables are provided,
specifying 10 ✱✱✱ and 101 ✱✱✱✱ . The asterisks are wildcards and stand for the
various long distance carrier codes. (10 ✱✱✱ is the current U.S. standard for
specifying long distance carriers; 101 ✱✱✱✱ is provided for future use. )

NOTE:
U.S. customers rarely need to program additional Network Selection
tables because long distance carrier codes will match 10 ✱✱✱ or 101 ✱✱✱✱ .

Summary: Network Selection Tables

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 3b, Incoming Trunks – DS1 Connectivity (100D
Module)

Not applicable

Prefix for long distance carrier

No

No

LinesTrunks → PRI → OutgoingTbl →
NetwkSelect → Dial entry no. → Enter → Drop →
Dial prefix → Enter → Exit → Exit → Exit

[F4] → [F6] → [F8] → [F1] → Type entry no. →
[F10] → [Alt] + [P] → Type prefix → [F10] →
[F5] → [F5] → [F5]
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Special Services Tables

Eight tables provide for international calling and for operator-assisted calls.
Default tables include the special prefixes 0 and 00 for operator-assisted
calls. Dialed numbers are matched against entries in these tables for patterns
(011, 010, 01, 00, 0, and 1); for operator assistance (operator-assisted,
presubscribed common carrier operator, and none); and for type of number
(national or international). Up to four digits can be deleted.

Summary: Special Services Tables

Programmable by System manager

Mode All

Idle Condition Not required

Planning Form Form 3b, Incoming Trunks - DS1 Connectivity (100D
Module)

Factory Setting See Table 8-2

Table 8-2.  Special Services Table

Operator
Local Op=Op Delete

Pattern Presubscribed Digits
Table (up to 4 digits) carrier=p (0-4)

0 011 none 3

1 010 OP 3

2 01 OP 2

3 00 OP/P 2

4 0 OP 1

5 1 none 1
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Valid Entries Prefix for international or operator-assisted calls

Inspect No

Copy Option No

Console Procedure To specify Pattern:
LinesTrunks → PRI → OutgoingTbl →
SpecialServ → Pattern → Dial entry no. →
Enter → Drop → Dial pattern → Enter → Exit →
Exit → Exit → Exit

To specify Operator:
LinesTrunks → PRI → OutgoingTbl →
SpecialServ → Operator → Dial entry no. →
Enter → Select type of operator → Enter → Exit
→ Exit → Exit → Exit

To specify Type of Number:
LinesTrunks → PRI → OutgoingTbl →
SpecialServ  → TypeOfNumbr → Dial entry no. →
Enter → Select type → Enter → Exit → Exit →
Exit → Exit

To specify Delete Digits:
LinesTrunks → PRI → OutgoingTbl →
SpecialServ → DeleteDigit → Dial entry no. →
Enter → Drop → Dial pattern → Enter → Exit →
Exit → Exit → Exit
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PC Procedure To specify Pattern:

To specify Operator:
[F4] → [F6] → [F8] → [F2] → [F2] → Type entry
no. → [F10] → Select type of operator → [F10] →
[F5] → [F5] → [F5] → [F5]

To specify Type of Number:

To specify Delete Digits:

PRI Facilities
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[F4] → [F6] → [F8] →  [F2] → [F1] → Type entry
no. → [F10] → [Alt] + [P] → Type pattern → [F10]
→ [F5] → [F5] → [F5] → [F5]

[F4] → [F6] → [F8] → [F2] → [F3] → Type entry
no. → [F10] → Type number type → [F10] →
[F5] → [F5] → [F5] → [F5]

[F4]  → [F6]  → [F8]  → [F2]  →  [F4]  → Type entry
no. → [F10]  → [Alt] + [P] → Type digits to be
deleted → [F10] → [F5] → [F5] → [F5] → [F5]
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Call by Call Service Table

When a call is placed on a Call by Call B-channel group, a specific service is
selected, depending on the match between the dialed digits and the table
entries. A service must be specified, otherwise the entry is ignored. The Call
by Call table can contain up to 10 entries; each entry can contain up to 10
patterns, each with a maximum of eight digits. If a dialed number matches
two patterns, the longer pattern takes precedence. That is, 212555 matches
both 212555 and 212; however, the longer pattern is deemed the matching
pattern. In addition to patterns, the Call by Call table can specify from 0
through 8 digits to be deleted (the default is 0).

If the last entry in the table is empty (no pattern is specified), this entry is used
as a default and matches any pattern and type of call.

Summary: Call by Call Service Table

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

System manager

All

Not required

Form 3b, Incoming Trunks – DS1 Connectivity (100D
Module)

Not applicable

Pattern — up to eight digits
Call — voice, data, both
Service — AT&tT Toll, Local, Misc.
Delete — 0-8

No

No

To specify Patterns:
LinesTrunks → PRI → OutgoingTbl → CBC
Service → Patterns → Dial list no. → Enter →
Drop → Dial pattern → Enter → Exit → Exit →
Exit → Exit
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To specify Voice/Data:
LinesTrunks → PRI → OutgoingTbl → CBC
Service → Voice/Data → Dial list no. → Enter →
Select voice, data, or both → Enter → Exit → Exit
→ Exit → Exit

To specify Network Service:
LinesTrunks → PRI → OutgoingTbl → CBC
Service → NetwkServ → Dial list no. → Enter →
select Service → Enter → Exit → Exit → Exit →
Exit

To specify Delete Digits:
LinesTrunks → PRI → OutgoingTbl → CBC
Service → DeleteDigit → Dial list no. → Enter
→ Drop → Dial no. of digits → Enter → Exit →
Exit → Exit → Exit

PC Procedure To specify Patterns:
[F4] → [F6] → [F8] → [F3] → [F1] → Type
no. → [F10]  → [Alt]  + [P]  → Type pattern →
[F10] → [F5] → [F5] → [F5] → [F5]

list

To specify Voice/Data:
[F4] → [F6] → [F8] → [F3] → [F2] → Type
no. → [F10] → Select voice, data, or both →
[F10]  → [F5] → [F5] → [F5] → [F5]

l i s t

To specify Network Service:
[F4]  → [F6] → [F8]  → [F3]  → [F3]  → Type
no. → [F10] → Select service → [F10] →
[F5] → [F5] → [F5]

l i s t

To specify Delete Digits:
[F4]   →  [F6]   → [F8]  → [F3]  → [F4]  → Dial list no.
→ [F10]  → [Alt]  + [P]  → Dial no. of digits →
[F10] → [F5] → [F5] → [F5] → [F5]
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The procedures in this chapter detail the steps for the following:

■    assigning outside lines or trunks to the buttons on a telephone
(including line and trunks used for loudspeaker paging)

■    copying line button assignments from one telephone to an individual
telephone or block of telephones

■    For Hybrid/PBX systems only:
assigning the following buttons on telephones

—    System Access or Intercom Voice

—    System Access or Intercom Ring

System Access or Intercom Originate Only

—    Shared System or Intercom Access

■    identifying analog multiline telephones that do not have built-in
speakerphones or Hands Free Answer on Intercom capability

■    identifying analog multiline telephones that require pairing of station
jacks to provide the Voice Announce to Busy or to provide
Simultaneous Voice and Data features
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Assign Trunks or Pools to Telephones

Use this procedure to assign outside trunks connected to the control unit to
specific buttons on each telephone. In the Hybrid/PBX mode, the trunks
assigned to a button on a telephone are called personal lines.

This procedure is used only to change or add trunks, Loudspeaker Page, or
pool buttons (Hybrid/PBX only) to telephones. Use the “Assign intercom or
System Access Button” procedures to add or change Intercom or System
Access buttons.

Individual trunks can be assigned to a maximum of 64 telephones. Individual
pools can be assigned as a Pool button on a maximum of 64 telephones.

The following lines/trunks cannot be assigned to a button on a telephone:

■   lines/trunks used for Music-on-Hold

■   lines/trunks used for maintenance alarms

NOTE:
If you use equipment that rebroadcasts music or other copyrighted
materials, you may be required to obtain a copyright license from and pay
license fees to a third party (such as the American Society of Composers,
Artists, and Producers or Broadcast Music Incorporated).

Magic on Hold® requires no such license and can be purchased from
your authorized dealer.

Pool buttons cannot be assigned or removed from extensions unless the pool
has trunks assigned. If all trunks are to be removed from a pool, all Pool
button assignments must first be removed from telephones. Another way of
handling this situation is to program another trunk into the pool and then
remove the Pool button assignments from the extensions.

Hybrid/PBX only - Individual trunks assigned to a pool can be assigned to a
button only on a DLC operator position. If one of the trunks in a pool is
assigned to a button on a non-DLC telephone, the result is a Pool button
assignment.
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Key only - The system assigns the first eight line numbers to buttons on
multiline telephones whether or not an outside line is physically connected. If
a line is not connected, the button assignment must be removed so the user
can assign a feature to the button.

Key only - For MLC-5 cordless multiline telephones, the system assigns the
first eight lines connected to the control unit even though the telephone has
fewer than eight buttons available. Remove the extra lines in system
programming so that no more than three lines are assigned to buttons on an
MLC-5 telephone.

Trunks are assigned to buttons in the order that you press each trunk button
on the system programming console or keyboard. Existing trunk assignments
can be rearranged by removing all current assignments and then pressing the
trunk buttons on the console or keyboard in the order that they should appear
on the buttons. For information on the order of the programmed buttons, refer
to the button numbers on the applicable planning form for each telephone.

If you want to reserve some blank buttons for features between trunk buttons,
a line must be assigned as a placeholder for each blank button. After ail
trunks are assigned, remove the trunks used as placeholders on the buttons
reserved for features.
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Summary Assign Trunks or Pools to
Telephones

Programmable by System manager

Mode All, but note differences in factory settings

Idle Condition Telephone idle

Planning Form Form 4b, Analog Multiline Telephone
Form 4d, MLX Telephone
Form 4e, MFM Adjunct — MLX Telephone
Form 4f, Tip/Ring Equipment
Form 5a, Direct-Line Console (DLC) - Analog
Form 5b, Direct-Line Console (DLC) - Digital
Form 5c, MFM Adjunct — DLC
Data Form 2a, Analog Data Station
Data Form 2b, Digital Data Station

Factory Setting Key Mode: Intercom Ring button, Intercom Voice
button, and the first eight lines connected to the
control unit are assigned to all analog multiline
telephones, MLX telephones (excluding operator
positions), and MFMs connected to MLX telephones.
Two Intercom Ring buttons are assigned to single-line
telephones; no outside lines are assigned.

Behind Switch Mode: Intercom Ring, Intercom Voice,
and Prime Line buttons are assigned to all analog
multiline telephones, MLX telephones (excluding
operator positions), and MFMs connected to MLX
telephones. Two Intercom Ring buttons are assigned
to single-line telephones; no outside lines are
assigned. When prime lines are assigned to MLX
extensions, lines are not assigned to MFMs used to
connect adjuncts. Lines for MFMs must be assigned
separately.
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Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

Hybrid/PBX Mode: System Access Ring, System
Access Voice, and System Access Originate Only
buttons are assigned to all analog multiline

.

telephones, and MLX telephones (excluding operator
positions). Five Call buttons are assigned to QCC
operator positions. Two System Access Ring buttons
and one System Access Originate Only button are
assigned to single-line telephones. No Personal Line
or Pool buttons are assigned.

Extension numbers

Yes

Yes

Extensions → Lines/Trunks → Dial ext. no. →
Enter → Select trunk range → Toggle LED On/Off →
Enter → Exit → Exit

[F6] → [F1] → Type ext. no. → [F10] → Select trunk
range → Toggle letter G On/Off → [F10] → [F5] →
[F5]

† Entry mode available
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Copy Line/Trunk Assignments

Use this procedure to copy outside line/trunk button assignments, pool dial-
out code restrictions (Hybrid/PBX only), and—for operator positions only—
Night Service information from a telephone to another telephone or block of
telephones with identical requirements.

If you are copying assignments to a block of telephones and one of the
extensions in the block is in use, the Station Busy– Pls Wait message
is shown on the display and the copy for the rest of the extensions in the
block is delayed until the busy extension becomes idle. The busy number is
not shown, but if you have a DSS attached, the LED associated with the busy
extension is on. If you exit instead of waiting for the busy extension to
become idle, the copy for the rest of the extensions is canceled; however, the
assignments that have already been copied are not canceled.

If you are copying assignments from an operator position to a block of
telephones that includes both operator and non-operator telephones, the
information is copied only to the operator positions; the non-operator positions
are not affected. Similarly, if you are copying assignments from a non-
operator position to a block of telephones that includes both operator and
non-operator telephones, the information is copied only to the non-operator
positions; the operator positions are not affected. The system provides no
error tone to signal that the copy did not work for all extensions in the block.
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Summary: Copy Line/Trunk Assignments

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Telephone idle

4a, Extension Copy — Analog Multiline Telephone
Template
4c, Extension Copy — MLX Telephone Template

Not applicable

Not applicable

Yes: lines/pools assigned to an extension

Not applicable

To copy to a single extension:
Extensions → Line Copy → Single → Dial copy
from ext. no. → Enter → Dial copy to ext. no. →
Enter → Exit → Exit

To copy to a block of extensions:
Extensions → Line Copy → Block → Dial copy
from ext. no. → Enter → Dial ext. no of first
telephone in block → Enter → Dial ext. no of last
telephone in block → Enter → Exit → Exit

To copy to a single extension:
[F6]  → [F2]  → [F1]  → Type copy from ext. no. →
[F10] → Type copy to ext. no. → [F10] → [F5] →
[F5]

To copy to a block of extensions:
[F6]  → [F2]  → [F2]  → Type copy from ext. no. →
[F10] → Type ext. no. of first telephone in block →
[F10] → Type ext. no. of last telephone in block →
[F10]  → [F5] → [F5]
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Assign Intercom or System Access
Buttons

Use this procedure to assign or change the assignments for Intercom buttons
used to make and receive inside calls. This includes the following types of
Intercom buttons:

■   Ring
■   Voice
■   Originate Only (Ring or Voice)

In the Hybrid/PBX mode only, use this procedure to assign or change
assignments for System Access (SA) buttons used to make or receive inside
and outside calls. This includes the following types of System Access
buttons:

■   Ring
■   Voice
■   Originate Only (Ring or Voice)
■   Shared (Ring or Voice)

You cannot change the factory setting for Call buttons assigned to QCC
operator positions, and you cannot assign Ring, Voice, Originate Only, or
Shared buttons to QCC operator positions.

NOTE:
System Access or Intercom buttons can be assigned only to the first 10
buttons on a telephone.

You can assign a combination of up to 10 System Access or Intercom buttons
to each telephone (excluding QCC operator positions).

You can remove System Access or Intercom buttons, but at least one must
remain on the telephone.

Each System Access Ring or Voice on an individual telephone can be
assigned as a System Access Shared button on up to 16 other telephones.

System Access and Intercom buttons are centrally programmed and cannot
be programmed by individual telephone users.

9-8  Assign Intercom or System Access Buttons



Telephones

Summary: Assign Intercom or System Access
Buttons

Programmable by System manager

M o d e All, but note differences in factory settings

Idle Condition Telephone idle

Planning Form Form 4b, Analog Multiline Telephone
Form 4d, MLX Telephone
Form 4e, MFM Adjuncts — MLX Telephone
Form 4f, Tip/Ring Equipment
Form 5a, Direct-Line Console (DLC) - Analog
Form 5b, Direct-Line Console (DLC) - Digital
Form 5c, MFM Adjunct (DLC)
Data Form 2a, Analog Data Station
Data Form 2b, Digital Data Station

Factory Setting Key Mode: An Intercom Ring, an Intercom Voice, and
the first eight lines connected to the system are
assigned to all analog multiline and MLX telephones,
excluding operator positions. Two Intercom Ring
buttons are assigned to tip/ring equipment connected
on an 012 module. An Intercom Ring and an
Intercom Originate Only (Ring) button are assigned to
tip/ring equipment connected by an MFM. No outside
lines are assigned.

Behind Switch Mode: An Intercom Ring, an Intercom
Voice, and a Prime Line button are assigned to all
analog multiline and MLX telephones, excluding
operator positions. Two intercom Ring buttons and a
Prime Line button are assigned to tip/ring equipment
connected on an 012 module. An Intercom Ring and
an Intercom Originate Only (Ring) button are
assigned to tip/ring equipment connected by an
MFM. No outside lines are assigned.
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Hybrid/PBX Mode: System Access Ring, System
Access Voice, and System Access Originate Only
(Ring) buttons are assigned to all analog multiline and
MLX telephones, excluding operator positions. Two
System Access Ring buttons and a System Access
Originate Only button are assigned to tip/ring
equipment (for example, single-line telephones or fax
machines connected to an 012 module). No Personal
line or Pool buttons are assigned.

All modes: System Access Ring (Hybrid/PBX mode)
or Intercom Ring (Key and Behind Switch modes),
System Access Voice (Hybrid/PBX mode) or Intercom
Voice (Key and Behind Switch modes), and the first
18 through 29 lines connected to the control unit are
assigned to all DLC operator positions. The number
of lines assigned depends on the type of telephone
used as a DLC operator position. Refer to the
appropriate telephone planning form for details.

Valid Entries Not applicable

Inspect Yes: specific button options

Copy Option Yes (You can copy additional SA buttons to another
station, but you cannot overwrite SA buttons that are
already assigned.)

Console Procedure To Program Extension:
More → Cntr–prg → program Ext. → Dial ext.
no. → Enter → Start → Program extension →
Enter → Exit → Exit

To Copy Extension Programming:
More → Cntr-Prg → Copy ext. → Dial copy from
ext. no. → Enter → Dial copy to ext. no. → Enter →
Exit → Exit
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PC Procedure To Program Extension:
[PgUp] → [F4] → [F1] → Type ext. no. → [F10] →
[F10] → Program extension → [F10] → [F5] → [F5] 

To Copy Extension Programming:
[PgUp]  → [F4]  → [F2]  → Type copy from ext. no.
→ [F10] → Type copy to ext. no. → [F10] →
[F5] → [F5]
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Analog Multiline Telephones without
Built-in Speakerphones

Use this procedure to identify those telephones that do not have the built-in
speakerphone or Hands Free Answer on Intercom (HFAI) capability for analog
multiline telephones with flat membrane buttons. The models that must be
identified are 5-Button, 10-Button, 34-Button, and 34-Button Deluxe analog
multiline models with flat membrane buttons.

Keep the factory setting for analog multiline models with raised plastic
buttons, including the following models: 10-Button HFAI, 34-Button with
speakerphone (SP-34), 34-Button with speakerphone and display (SP-34D),
BIS-10, BIS-22, BIS-34, BIS-22D, and BIS-34D.

This procedure is not needed for MLX or single-line telephones.
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Summary: Analog Multiline Telephones
without Built-in Speakerphones

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 4b, Analog Multiline Telephone
Form 5a, Direct-Line Console (DLC) - Analog
Data Form 2a, Analog Data Stations

All models of analog multiline telephones (except the
analog multiline display console) have the BIS/HFAl
capability

Extension numbers

Yes

No

Extensions → BIS/HFAI → Dial ext. no. → Enter
→ Exit → Exit

[F6] → [F8] → Type ext. no. → [F10]  → [F5] →
[ F 5 ]
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Analog Multiline Telephones with
Voice Announce to Busy

Use this procedure to dedicate a voice/voice pair to be used to provide the
Voice Announce to Busy feature to an analog multiline telephone.

The extension number associated with the first (odd-numbered) station jack in
the pair is the telephone’s extension number. The extension number for the
second (even-numbered) station jack is dedicated to the Voice Announce to
Busy feature. Calls cannot be placed to the station jack reserved for the
Voice Announce to Busy feature.

An extension number cannot be dedicated for both the Voice Announce to
Busy feature and the Simultaneous Voice and Data feature.

NOTE:
This procedure does not apply for MLX telephones (Voice Announce to
Busy is automatically provided) and cannot be programmed for single-line
telephones.
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Summary: Analog Multiline Telephones with
Voice Announce to Busy

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

System idle

Form 4b, Analog Multiline Telephone
Form 5a, Direct-Line Console (DLC) — Analog
Data Form 2a, Analog Data Station

Not applicable

Extension numbers

Yes

Yes

Extensions → VoiceSignl → Dial ext. no. →
Enter → Exit → Exit

[F6] → [F10] → Type ext. no. → [F10] → [F5] →
[ F 5 ]
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Analog Multiline Telephones with
Simultaneous Voice/Data

See “Data Features.”
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Auxiliary Equipment 10
The procedures in this chapter describe the steps needed to do the following:

■    identify the trunk jacks used for Music-on-Hold, loudspeaker paging,
and maintenance alarms

■    identify the station jacks used for fax, MERLIN MAIL, Voice Messaging
System, Automated Attendant, and AUDIX Voice Power

Music-on-Hold

Use this procedure to identify the trunk jack reserved for connection of a
music source, such as a radio, tape player, or stereo system.

NOTE:
If you use equipment that rebroadcasts music or other copyrighted
materials, you may be required to obtain a copyright license from and pay
license fees to a third party (such as the American Society of Composers
[ASCAP], Artists, and Producers or Broadcast Music Incorporated [BMI]).

Magic on Hold® requires no such license and can be purchased from
your authorized dealer.
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Only one Music-on-Hold jack is allowed per system.

You cannot assign the trunk identified for Music-on-Hold to a trunk pool. If the
trunk is currently assigned to a pool, you must remove it before you program
this option.

You cannot assign the trunk identified for use with Music-on-Hold to a button
on any telephone or as a Remote Access trunk, and you cannot use the jack
identified for Music-on-Hold for a loudspeaker paging system or maintenance
alarm.

Summary: Music-on-Hold

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All – but in Hybrid/PBX mode, the trunk designated for
Music-on-Hold cannot be assigned to a trunk pool.

System idle

Form 2c, System Numbering - Trunk Jacks

Not Applicable

Line/trunk number

No

No

AuxEquip → MusicOnHold → Dial trunk no. →
Enter → Exit

[F9] → [F1] → Type trunk no. → [F10] → [F5]
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Loudspeaker Paging

Use this procedure to identify the trunk jack reserved for connection of
loudspeaker paging equipment.

NOTE:
If you use equipment that rebroadcasts music or other copyrighted
materials, you may be required to obtain a copyright license from and pay
license fees to a third party (such as the American Society of Composers,
Artists, and Producers or Broadcast Music Incorporated).

Magic on Hold requires no such license and can be purchased from your
authorized dealer.

A maximum of three single-zone or multizone loudspeaker paging systems
can be connected to the system.

You cannot assign the trunk identified for use for loudspeaker paging
equipment to a trunk pool. If the trunk is currently assigned to a pool, you
must remove it before you program this option.

You cannot assign the trunk identified for use for loudspeaker paging
equipment as a Remote Access trunk, and you cannot use its jack for Music-
on-Hold or maintenance alarm.
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Summary: Loudspeaker Paging

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All – but in Hybrid/PBX mode, the trunk designated for
loudspeaker paging cannot be assigned to a trunk
pool.

Line/trunk idle

Form 2c, System

Not Applicable

Numbering - Trunk Jacks

Line/trunk numbers

Yes

No

AuxEquip → Ldspkr Pg → Dial trunk no. → Enter
→ Exit
[F9] → [F2] → Type trunk no. → [F10] → [F5]
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Fax

Use this procedure to identify the station jacks used to connect fax machines.
In addition, specify the telephones to receive a message-waiting indication
(MWI) when a fax transmission is received, and specify the length of time
before the system registers that a fax has arrived and sends the message-
waiting indication.

NOTE:
Do not use this procedure for fax machines connected to analog multiline
telephones via a General Purpose Adapter (GPA) because features
cannot be assigned to the fax independently of the telephone in a GPA
configuration.

A maximum of 16 fax machines can have the Fax Message Waiting feature.
[Additional fax machines (more than 16) can be installed, but these machines
cannot have this feature.]

You can specify up to four telephones to receive the message-waiting
indication when a fax transmission is received. Note that fax machines can
only send and not receive message-waiting indications.
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Summary: Fax

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 4b, Analog Multiline Telephone
Form 4d, MLX Telephone
Form 4e, MFM Adjunct - MLX Telephone
Form 4f, Tip/Ring Equipment
Form 5a, Direct-Line Console (DLC) — Analog
Form 5b, Direct-Line Console (DLC) - Digital
Form 5c, MFM Adjunct - DLC

10 seconds

0 - 30 seconds

Yes

No

AuxEquip → Fax → Extension → Dial ext. no. →
Enter → Exit → Msg waiting → Dial fax machine
ext. no. → Enter → Dial MWI ext. no. → Enter →
Threshold → Drop → Dial no. of seconds → Enter
→ Exit → Exit

[F9] → [F3] → [F1] → Type ext. no. → [F10] [F8]
→ [F5] → [F2] → Type fax machine ext. no. →
[F10] → Type MWI ext. no. → [F10] → [F3]  →
[Alt] + [P]  → Type no. of seconds → [F10] →
[F5] → [F5]
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Maintenance Alarms

Use this procedure to identify the trunk jack that connects an external alerting
device that sounds or flashes when major maintenance problems occur.

You cannot assign the trunk identified for the maintenance alarm to a button
on any telephone or as a Remote Access trunk, and you cannot use its jack to
connect a loudspeaker paging system or Music-on-Hold.

Summary: Maintenance Alarms

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All - but in Hybrid/PBX mode, the trunk designated for
the maintenance alarm cannot be assigned to a trunk
pool.

System idle

Form 2c, System Numbering – Trunk Jacks

Not Applicable

Trunk number

No

No

AuxEquip → MaintAlarms → Dial trunk no. →
Enter → Exit → Exit

[F9] → [F4] → Type trunk no. → [F10] → [F5] →
[ F 5 ]
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Voice Messaging System and
Automated Attendant

Use this procedure to specify the touch-tone duration and the interval
between digits in codes sent between a voice messaging system and the
communications system. The touch-tone duration and interval between digit
assignment must be the same as those programmed on the voice messaging
system.

This procedure specifies the integrated voice messaging ports used to
connect voice messaging systems such as MERLIN MAIL Voice Messaging
System or the AUDIX Voice Power-Integrated Solution II/III application. It also
specifies the generic VMI ports used for automated attendants, such as
MERLIN Attendant or Integrated Voice Power Automated Attendant-lS Il.

in addition, this procedure can be used to specify the number of rings before
a call transferred by the voice messaging system is sent to the backup
position for both integrated and generic VMI ports. The number of rings
cannot be programmed for individual voice messaging systems; the single
setting applies for all. Use the Group Type procedure in the “Optional
Group-Assigned Features” chapter to assign VMI ports as either integrated
or generic.
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Summary: Voice Messaging System and
Automated Attendant

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

(See forms packaged with application.)

Touch-tone duration – 100 ms; intercal between
digits – 50 ms; number of rings before transfer – 4

Touch-tone duration: 50 – 200 ms in increments of 25
ms; interval between digits: 50 – 200 ms in
increments of 25 ms; number of rings before transfer:
0 – 9

No

No

AuxEquip → VMS/AA → TransferRtn → Drop →
Dial no. of rings → Enter → TT Duration → Drop
→ Dial no. of ms → Enter → TT Interval → Drop
→ Dial no. of ms → Enter → Exit → Exit

[F9] → [F6] → [F1] → [Alt] + [P] → Type no. of
rings → [F10]  → [F2]  → [Alt]  + [P]  → Type no. of
ms → [F10]  → [F3] → [Alt] + [P] → Type no. of
ms → [F10]  → [F5] → [F5]
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The procedures in this chapter detail the steps in programming the following
optional features:

■

■

■

■

■

■

■

■

Extension Language

Pool Dial-Out Code

Call Restrictions

Copy Call Restrictions

ARS Restriction Level for an Extension

Forced Account Code Entry

Microphone Operation

Remote Call Forwarding

Optional Telephone Features 11-1
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Extension Language

Release 1.1 and 2.0 Only
Use this procedure to change the language for an MLX telephone.

Summary: Extension Language

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

Users and system manager

All

Not required

Form 4d, MLX Telephone
Form 5b, Direct-Line Console (DLC)-Digital
Data Form 2b, Digital Data Station

English

English, French, Spanish

No

No

To program a single extension:
More → Language → Extensions → Single →
Dial ext. no. → Enter → Select a language → Enter
→ Exit → Exit
To program a block of extensions:
More → Language → Extensions → Block → Dial
starting ext. no. → Enter → Dial ending ext. no. →
Enter → Select a language → Enter → Exit →
Exit

To program a single extension:
[PgUp]  → [F6] → [F2] → [F1] → Type ext. no. →
[F10] → Select a language → [F10] → [F5] → [F5]

To program a block of extensions:
[PgUp]  → [F6]  → [F2]  → [F2]  → Type starting ext.
no. → [F10] → Type ending ext. no. → [F10] →
Select a language → [F10] → [F5] → [F5]
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Pool Dial-Out Code

Use this procedure to allow or restrict the dialing of pool dial-out codes and
the placing of calls on specific trunk pools. Entering a code and then deleting
that code restricts the user from using the pool associated with that pool dial-
out code.

Summary: Pool Dial-Out Code

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Telephone idle

Form 4b, Analog Multiline Telephone
Form 4d, MLX Telephone
Form 4e, MFM Adjunct — MLX Telephone
Form 4f, Tip/Ring Equipment
Form 5a, Direct-Line Console (DLC) – Analog
Form 5b, Direct-Line Console (DLC) – Digital
Form 5c, MFM Adjunct (DLC) — Digital
Form 5d, Queued Call Console (QCC)
Data Form 2a, Analog Data Station
Data Form 2b, Digital Data Station

All telephones can dial any trunk pool dial-out code

Pool numbers

Yes

No

Extensions → Dial OutCd → Dial ext. no. →
Enter → Dial pool dial-out code → Enter → Exit
→ Exit

[F6]  → [F3]  → Type ext. no. → [F10]  → Type pool
dial-out code → [F10] → [F5] → [F5]
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Call Restrictions

Use this procedure to change individual telephone calling restrictions to one
of the following:

■   unrestricted
■   restricted from making all outgoing calls
■   restricted from making toll calls

Summary: Call Restrictions

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Telephone idle

Form 4b, Analog Muitiline Telephone
Form 4d, MLX Telephone
Form 4e, MFM Adjunct — MLX Telephone
Form 4f, Tip/Ring Equipment
Form 5a, Direct-Line Console (DLC) – Analog
Form 5b, Direct-Line Console (DLC) – Digital
Form 5c, MFM adjunct-DLC
Form 5d, Queued Call Console (QCC)
Data Form 2a, Analog Data Station
Data Form 2b, Digital Data Station

Unrestricted

Unrestricted, Outward restricted, Toll restricted

No

Yes

Extensions → Restriction → Dial ext. no. →
Enter → Select restriction → Enter → Exit

[F6]  → [F4]  → Type ext. no. → [F10]  → Select
restriction → [F10]  → [F5]
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Copy Call Restrictions

Use this procedure to copy calling restrictions, Allowed Lists, and Disallowed
Lists. Feature assignment must be completed for the “copy from” telephone
and can be copied to an individual telephone or block of telephones with
identical calling restriction requirements.

If you are copying restrictions to a block of telephones and one of the
extensions in the block is in use, you will see the Station Busy - Pls
Wait message on your screen. The copy for the rest of the extensions in the
block is delayed until the extension becomes idle. The specific busy
extension is not shown; however, if a DSS is attached, the LED associated
with the busy extension is on. If you exit without waiting for the extension to
become idle, copying for the rest of the extensions in the block is canceled,
but the copying that has been completed is recorded.

If you are copying restrictions to a block of extensions, they must be
sequentially numbered.

The telephones you are copying to and from can be both operator and non-
operator positions.

NOTE:
Dial-out code restrictions are not copied.
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Summary: Copy Call Restrictions

Programmable by System manager

Mode All

Idle Condition “Copy to” telephone(s) idle

Planning Form Form 4b, Analog Multiline Telephone
Form 4d, MLX Telephone
Form 4e, MFM Adjunct — MLX Telephone
Form 5a, Direct-Line Console (DLC) – Analog
Form 5b, Direct-Line Console (DLC) – Digital
Form 5c, MFM Adjunct-DLC
Form 5d, Queued Call Console (QCC)
Data Form 2a, Analog Data Station
Data Form 2b, Digital Data Station

Factory Setting Not applicable

Valid Entries Not applicable

Inspect No

Copy Option Not applicable

Console Procedure To copy to a single telephone:
Extensions → RestrctCopy → Single → Dial
copy from ext. no. → Enter → Dial copy to ext. no.
→ Enter → Exit → Exit → Exit

To copy to a block of telephones:
Extensions → RestrctCopy → Block → Dial
copy from ext. no. → Enter → Dial first no. in copy to
block → Enter → Dial last no. in copy to block →
Enter → Exit → Exit → Exit

11-6  Copy Call Restrictions
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PC Procedure To copy to a single telephone:
[F6]
[F10]
[F5]

→ [F6] → [F1] → Type 
→ Type copy to ext. no.

→ [F5]

To copy to a block of telephones:

copy from ext. no. →
→ [F10] → [F5] →

[F6]
[F10]
Type
[F5]

→ [F6]  → [F2]  → Type copy from ext. no. →
→ Type first no. in copy to block → [F10] →

last no. in copy to block → [F10] → [F5] →
→ [F5]
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ARS Restriction Level For Extensions

Use this procedure to assign an ARS restriction level to an extension. Only
outgoing calls are affected; users can receive inside, local, and toll calls on
restricted telephones and can join any type of call in progress. The wildcard
character “pause” cannot be used in system programming to enter an area
code.

Summary: Assigning ARS Restriction for an
Extension

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

System manager

Hybrid/PBX only

Not required

Form 4b, Analog Multiline Telephone
Form 4d, MLX Telephone
Form 4e, MFM Adjunct—MLX Telephone
Form 4f, Tip/Ring Equipment
Form 5a, Direct-Line Console (DLC) – Analog
Form 5b, Direct-Line Console (DLC) – Digital
Form 5c, MFM Adjunct—DLC
Form 6i, Call Restriction Assignments and Lists

3

0-6 (0 is most restrictive and 6 is Ieast restrictive)

No

No

Extensions → More → ARS Restrct → Dial ext.
no. → Enter → Drop → Dial restriction level →
Enter → Exit

PC Procedure [F6]  → [PgUp] → [F6]  → Type ext. no. → [F10]  →
[Alt] + [P] → Type restriction level → [F10] →
[F5]
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Forced Account Code Entry

Use this procedure to assign or remove Forced Account Code Entry. When
this feature is programmed on individual telephones, the user must enter a 1-
to 16-digit account code before making an outside call.

Summary: Forced Account Code Entry

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 4b, Analog Multiline Telephone
Form 4d, MLX Telephone
Form 4e, MFM Adjunct — MLX Telephone
Form 4f, Tip/Ring Equipment
Form 5a, Direct-Line Console (DLC) – Analog
Form 5b, Direct-Line Console (DLC) – Digital
Form 5c, MFM Adjunct — DLC
Form 5d, Queued Call Console (QCC)
Data Form 2a, Analog Data Station
Data Form 2b, Digital Data Station

Not assigned

Assigned, not assigned

Yes

No

Extensions → Account → Toggle LED On/Off or
Dial ext. no. → Enter → Exit → Exit

[F6] → [F7] → Toggle letter R On/Off → Type ext.
no. or [F10]  → [F5] → [F5]
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Microphone Operation

Use this procedure to enable or disable microphones on MLX telephones
(except QCC operator positions). When the microphone is disabled, users
cannot use the speakerphone to carry on conversations.

NOTE:
The microphone cannot be disabled on analog multiline telephones or on
MLX telephones used as QCC operator positions.

Summary: Microphone Operation

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 4d, MLX Telephone
Form 5b, Direct-Line Console (DLC) – Digital

Enabled

Enabled, disabled

Yes

No

Extensions → More → Mic Disable → Toggle
LED On/Off or Dial ext. no. → Enter → Exit →
Exit

[F6]  → [PgUp]  → [F7]  → Toggle letter R On/Off or
Type ext. no. → [F10] → [F5] → [F5]
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Remote Call Forwarding

Use this procedure to allow or disallow the Remote Call Forwarding capability,
which allows users to forward calls to an outside number.

If a telephone with Remote Call Forwarding has one or more personal lines
assigned, that telephone can be assigned as the principal user, and calls
received on that line are forwarded to outside numbers. (See “Principal User
of Personal Line.”)

NOTE:
This feature is not recommended unless you have ground-start trunks.
See “Disconnect Signaling Reliability” and “Hold Disconnect Interval.”
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Summary: Remote Call Forwarding

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Not required

Form 4b, Analog Multiline Telephone
Form 4d, MLX Telephone
Form 4e, MFM Adjunct — MLX Telephone
Form 4f, Tip/Ring Equipment
Form 5a, Direct-Line Console (DLC) – Analog
Form 5b, Direct-Line Console (DLC) – Digital
Form 5c, MFM Adjunct — DLC
Form 5d, Queued Call Console (QCC)
Data Form 2a, Analog Data Station
Data Form 2b, Digital Data Station

Disallowed

Disallowed, allowed

Yes

No

Extensions → More → Remote Frwd → Toggle
LED On/Off or Dial ext. no. → Enter → Exit →
Exit

[F6] → [PgUp] → [F8] → Toggle letter R On/Off or
Type ext. no. → [F10] → [F5] → [F5]
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The procedures in this chapter affect feature programming for both DLC and
QCC operator positions. The following procedures are included:

■   Operator Hold Timer

■   DLC Operator Automatic Hold

■   QCC Optional Features

—
—
—
—
—
—
—
—
—
—
—

Hold Return
Automatic Hold or Release
Queue over Threshold
Elevate Priority
Calls-In-Queue Alert
QCC Operator to Receive Call Types
Call Type Queue Priority Level
Message Center Operation
Automatic or Manual Extended Call Completion
Return Ring
Position Busy Backup
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Operator Hold Timer

Use this procedure to set the length of the Operator Hold Timer for all DLCs
and QCCs. If the system operator does not pick up the call within the time
programmed, an abbreviated ring is a reminder that a call is being held.

This option cannot be programmed for individual operator positions.

Summary: Operator Hold Timer

Programmable by System manager

Mode All

Idle Condition Not required

Planning Form Form 6a, Optional Operator Features

Factory Setting 60 seconds

Valid Entries 10 - 255 seconds

Inspect No

Copy Option No

Console Procedure Operator → Hold Timer → Drop → Dial no. of
seconds → Enter → Exit

PC Procedure [F3]  → [F3]  → [Alt]  + [P]  → Type no. of seconds
→ [F10] → [F5]
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DLC Operator Automatic Hold

Use this procedure to enable or disable the DLC Operator Automatic Hold
feature for DLC operator positions. When this feature is enabled, it prevents
accidental disconnection of calls.

Summary: DLC Operator Automatic Hold

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6a, Optional Operator Features

Disabled

Disabled, enabled

No

No

Operator → DLC Hold → Enable or Disable
Automatic Hold → Enter → Exit

[F3] → [F4] → Enable or Disable Automatic Hold →
[F10]  → [F5]
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QCC Optional Features

NOTE:
These options are available in Hybrid/PBX mode only.

The following options can be provided for QCC operator positions:

Hold Return

Automatic Hold or Release

Queue over Threshold

Elevate Priority

Calls-in-Queue Alert

QCC Operator to Receive Call Types

Call Type Queue Priority Level

Message Center Operation

Automatic or Manual Extended Call Completion

Return Ring

Position Busy Backup

12-4  QCC Optional Features
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Hold Return

Use this procedure to determine whether calls on hold are returned to the
QCC queue or remain on hold on the QCC operator console after the hold
timer has expired twice. After the hold timer expires the first time, the operator
hears an abbreviated ring as a call-on-hold reminder. If another call is
received at the same time the hold timer expires, 10 seconds are added to
the programmed operator hold timer interval. If the QCC operator does not
pick up a call by the time the hold timer expires twice, the call can be
programmed to either remain on hold or return to the QCC queue. 

This option cannot be programmed for individual QCC operator positions; the
single setting applies to all QCC operator positions.

Summary: Hold Return

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 6a, Optional Operator Features

Calls remain on hold

Remain on hold, Return to QCC queue

No

No

Operator → Queued Call → Hold Rtrn → Select
the hold return → Enter

[F3] → [F2] → [F1] →
[F10] → [F5] → [F5]

→ Exit → Exit

Select the hold return  →
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Automatic Hold or Release

Use this procedure to specify whether a call in progress on a call button is
automatically put on hold (Automatic Hold) or disconnected (Automatic
Release) when the operator presses another button.

This option cannot be programmed for individual QCC operator positions; the
single setting applies to all QCC operator positions.

Summary: Automatic Hold or Release

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 6a, Optional Operator Features

Automatic Release

Auto Hold, Auto Release

No

No

Operator → Queued Call → HoldRelease →
Select Auto Hold or Auto Release → Enter →
Exit → Exit

[F3]  → [F2]  → [F2]  → Select Auto Hold or Auto
Release → [F10] → [F5] → [F5]
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Queue over Threshold

Use this procedure to specify the maximum number of calls (threshold) in the
QCC queue before system operators are notified with a tone that the threshold
has been reached or exceeded. If the threshold is set to 0, operators are not
notified.

Summary: Queue over Threshold

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 6a, Optional Operator Features

0

0 - 99

No

No

Operator → Queued Call → Threshold → Drop
Dial no. of calls → Enter → Exit → Exit

[F3] → [F2] → [F3] → [Alt]  + [P] → Type no. of
calls → [F10] → [F5] → [F5]
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Elevate Priority

Use this procedure to specify the length of time before calls waiting in the
QCC queue are automatically reprioritized to a higher level. If priority is set to
0, calls are not prioritized.

Summary: Elevate Priority

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 6a, Optional Operator Features

0 seconds

0 and 5 - 30

No

No

Operator → Queued Call → ElvatePrior →
Drop → Dial no. of seconds → Enter → Exit →
Exit

[F3] → [F2] → [F4] → [Alt] + [P] → Type no. of
seconds → [F10] → [F5] → [F5]
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Calls-In-Queue Alert

Use this procedure to specify whether each QCC operator is notified (with a
single beep) when a new call enters the QCC queue.

Summary: Calls-In-Queue Alert

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 6a, Optional Operator Features

Disable

Enable, Disable

Yes

No

Operator → Queued Call → InQue Alert →
Dial ext. no. → Enter → Enable or disable alert →
Enter → Exit → Exit

[F3] → [F2] → [F6] → Type ext. no. → [F10] →
Enable or disable alert → [F10]  → [F5]
→ [F5]
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QCC Operator to Receive Call Types

Use this procedure to specify which QCC operators receive the following
types of calls:

■    Dial 0 calls (internal calls to the system operator)
■    DID calls to invalid destinations (unassigned extension numbers)
■    Calls to the Listed Directory Number (extension for the QCC queue)
■    Calls programmed to return to the QCC queue (returning from

extending, camped-on, held calls, and operator parked calls)
■    Group Coverage calls
■    Forward/Follow Me calls

The QCC queue can be a receiver for the maximum number of coverage
groups (30).

NOTE:
If you want a QCC operator position to operate as a Message Center
(receiving returning parked and extended calls, Group Coverage calls,
and calls to unassigned DID numbers), program the Message Center
option before you assign the operator to receive call types.

This procedure does not include use of the menu selections Follow/Frwd or
QCC Ext. These two options are used to assign queue priorities and are not
associated with individual QCC operators. See “Call Type Queue Priority
Level” in this section.

This procedure does not include programming the operator to receive calls on
individual trunks. See “QCC Operator to Receive Calls” in the Lines and
Trunks” section of this manual.

Programming an operator to receive DID calls to invalid destinations does not
cause the calls to ring into the QCC queue unless you program such calls to
be sent to a backup extension. See “Invalid Destination” in this section.

When no operator is assigned to receive the call types, the call does not ring
into the QCC queue, and the caller hears an error tone.

12-10  QCC Operator to Receive Call Types
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Summary: QCC Operator to Receive Call Types

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 6a, Optional Operator Features

QCC operator receives the following calls:

■   Dial 0

■   Unassigned DID

■   Listed Directory Number

■   Returning

Not applicable

Yes

No

Operator → Queued Call → Call Types →
Select a call type → Operator → Dial Coverage
Group no. → Enter → Dial ext. no. → Enter or
Delete call type → Exit → Exit → Exit → Exit →
Exit

[F3] → [F2] → [F7] → Select a call
Type Coverage Group no. → [F10] → Type ext. no.

type → [F2]  →

→ Enter or delete cal type → [F5] → [F5] → [F5]
→ [F5] → [F5]
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Call Type Queue Priority Level

Use this procedure to assign a priority value (1-7) that determines the order in
which calls programmed to ring into the QCC queue are sent to QCC system
operator positions. A value of 1 is the highest priority. The QCC queue
priority level is assigned for the following types of calls:

■    Dial 0 calls (internal calls to the system operator)

■    DID calls to invalid destinations (unassigned extension numbers)

■    Calls to the Listed Directory Number (extension for the QCC queue)

■    Calls programmed to return to the QCC queue (returning from
extending, camped-on, held calls, and operator parked calls)

■    Group Coverage calls

■    Calls signed in (Follow) or forwarded to the system operator

■    Calls to a system operator extension number

This procedure does not include programming the QCC queue priority level
for individual trunks to ring into the queue. See “QCC Queue Priority Level.”

12-12  Call Type Queue Priority Level
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Summary: Call Type Queue Priority Level

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 6a, Optional Operator Features

4

1 - 7

No

No

Operator → Queued Call → Call Types →
Press button next to selection → Priority → Drop
→ Dial priority level → Enter → Exit → Exit →
Exit → Exit

[F3]  → [F2]  → [F7]  → Press function key next to
selection → [F1] → [Alt]  + [P]  → Type priority
level → [F10] → [F5] → [F5] → [F5] → [F5]
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Message Center Operation

Use this procedure to designate one or more QCC operator positions to
operate as a Message Center. The following options are automatically set for
the Message Center position:

■    Incoming calls are not directed to this position.
■ Returning calls are directed to this position (return from extending and

operator parked calls).
■    All Group Coverage calls are directed to this position.
■    All DID calls to invalid destinations are directed to this position.

Designating a Message Center operation does not change any call type
option programming except that the call types mentioned above are added to
the calls received at the QCC Message Center.

Summary: Message Center Operation

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 6a, Optional Operator Features

Not applicable

QCC extension numbers

Yes

No

Operator → Queued Call → Msg Center → Dial
ext. no. → Enter → Exit → Exit → Exit
[F3]  → [F2]  → [F8]  → Type ext.no. → [F10]  →
[F5]  → [F5]  → [F5]
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Automatic or Manual Extended Call
Completion

Use this procedure to specify one of two basic options for QCC operator
positions with a DSS only:

■    Automatic completion – allows one touch call transfer; that is, calls are
transferred by touching only an extension button on the DSS. The
operator does not have to press the Release button.

■ Manual completion – QCC operators must press the Release button to
extend a call using a DSS.

This option cannot be programmed for individual QCC operator positions; the
setting applies to all QCC operator positions.

Summary: Extended Call Completion

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

System manager

Hybrid/PBX

Not required

Form 6a, Optional Operator Features

Automatic Extended Completion

Automatic, Manual

No

No

Operator → Queued Call → ExtndComplt
Select automatic or manual complete → Enter
Exit → Exit

→
→

PC Procedure [F3]  → [F2]  → [F9]  → Select automatic or manual
complete → [F10] → [F5] → [F5]

Automatic or Manual Extended Call Completion 12-15
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Return Ring Interval

Use this procedure to specify the number of rings before an unanswered
extended call is returned to the QCC queue or QCC Message Center position.

This option cannot be programmed for individual QCC operator positions; the
setting applies to all QCC operator positions.

NOTE:
If you want unanswered calls to proceed to voice mail, lengthen the return
ring setting.

Summary: Return Ring Interval

Programmable by System manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form Form 6a, Optional Operator Features

Factory Setting 4 rings

Valid Entries 1 - 15 rings

Inspect No

Copy Option No

Console Procedure Operator → Queued Call → Return Ring →
Drop → Dial no. of rings → Enter → Exit → Exit

PC Procedure [F3]  → [F2]  → [F10] → [Alt] + [P] → Type no. of
rings → [F10] → [F5] → [F5]
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Position Busy Backup

Use this procedure to designate the calling group to provide the backup
position for the QCC queue, that is, to receive incoming calls when all QCC
operator positions are in a Position Busy mode.

Position Busy backup is programmed for the QCC queue rather than for
individual QCC operator positions. The calling group designated as the QCC
queue backup serves as the backup for the Remote Access feature and as
backup when the QCC is being used as the system programming console.

Only one Position Busy backup can be programmed per system.

Summary: Position Busy Backup

Programmable by System manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form Form 6a, Optional Operator Features

Factory Setting No backup

Valid Entries Calling group number

Inspect No

Copy Option No

Console Procedure Operator
Backup →

→ Queued Call → More → QCC
Drop → Dial ext. number → Enter →

Exit → Exit

PC Procedure [F3] → [F2] → [PgUp] → [F1] → [Alt] + [P] →
Type ext. number → [F10] → [F5] → [F5]

Position Busy Backup 12-17



Optional Group-Assigned
Features 13

The procedures in this chapter describe how to program the following
optional features:

■   Call Pickup Groups

■   Group Paging

■   Group Coverage Member Assignments

■   Group Coverage Delay Interval

■   Group Calling Member Assignments

■   Group Calling Trunk or Pool Assignments

■   Optional Group-Calling Features

—
—
—
—
—
—
—
—

Hunt Type
Group Calling Delay Announcement
Group Coverage Receiver
Group Calling Overflow and Threshold
Group Calling Message Waiting Indicator
Group Calling Calls-In-Queue Alarm Threshold
Group Calling External Alert for Calls-In-Queue Alarms
Group Type

Optional Group-Assigned Features 13-1
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Call Pickup Groups

Use this procedure to assignor remove a telephone from a call pickup group,
consisting of telephone users who can answer one another’s calls by pressing
a button or by dialing a code.

A maximum of 30 call pickup groups with a maximum of 15 telephones per
group are allowed. A telephone can belong to only one group.

Before reassigning a telephone to a new group, you must remove it from its
current group.

Summary: Call Pickup Groups

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6d, Group Coverage

Not applicable

Call pickup group number, extension number

Yes

No

Extensions → Call Pickup → Dial pickup group
no. → Enter → Dial ext. no. → Enter → Exit →
Exit

[F6]  → [F9]  → Type pickup group no. → [F10] →
Type ext. no. → → [F10] → [F5] → [F5]

13-2  Call Pickup Groups
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Group Paging

Use this procedure to assignor remove a telephone from a paging group,
consisting of telephone users who hear common announcements over the
telephone speakerphone. Only MLX telephones and analog multiline
telephones with speakerphones can be members of a paging group.

A maximum of six paging groups with a maximum of 10 telephones per group
is allowed. A seventh paging group, called the Page All group, is not limited
and includes all telephones connected to the system. Telephones cannot be
added to or removed from the Page All group.

To reassign a telephone to a new paging group, just assign it; the telephone
is automatically removed from its old paging group.

Summary: Group Paging

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6c, Group Paging

Not applicable

Extension number

Yes

No

Extensions → More → Group Page → Dial paging
group no. → Enter → Dial ext. no. → Enter → Exit
→ Exit

[F6]  → [PgUp]  → [F2]  → Type paging group no. →
[F10] → Type ext. no. →→ [F10] → [F5] → [F5]
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Group Coverage Member
Assignments

Use this procedure to assign or remove a telephone from a coverage group.
Coverage is an arrangement in which calls from a group of senders are
redirected to one or more receivers. A

NOTE:
This procedure assigns senders; make
coverage group are also programmed.

coverage group is a group of senders.

sure that receivers for the
Receivers can be assigned either

through individual or centralized telephone programming. See Chapter 4
in System Programming for information on the appropriate centralized
programming procedure.

A maximum of 30 coverage groups is allowed, each with an unlimited number
of members. Up to eight receivers can be assigned per coverage group.

A telephone can be a sender in only one group; it can be a receiver for more
than one coverage group. A calling group can be assigned as a receiver for
a coverage group (see “Group Coverage Receiver”). In Hybrid/PBX mode
only, the QCC queue can be a receiver for up to 30 coverage groups (see
“QCC Operator to Receive Calls”).

If the sender’s telephone has one or more personal lines assigned, the sender
can be assigned as the principal user so that calls received on the personal
line are sent to receivers programmed for Individual or Group Coverage (see
“Principal User for Personal Line”).

To reassign a telephone to a new coverage group, just make the assignment;
the telephone is automatically removed from its old group.

NOTE:
Use Integrated Administration to assign coverage receivers.
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Summary: Group Coverage Member
Assignments

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6d, Group Coverage

Not applicable

Extension numbers

Yes

No

Extensions → More → Group Cover → Dial
group no. → Enter → Dial ext. no. → Enter → Exit
→ Exit

[F6] → [PgUp]  → [F3] → Type group no. → [F10] →
Type ext. no. → [F10] → [F5] → [F5]

Group Coverage Member Assignments 13-5
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Group Coverage Delay Interval

Use this procedure to specify the number of rings before a call is sent to
Group Coverage receivers.

Summary: Group Coverage Delay Interval

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager, Integrated Administration

All

Not required

Form 6d, Group Coverage

3 rings

1 - 9 rings

No

No

Options → More → Cover Delay → Drop → Dial
no. of rings → Enter → Exit

[F7] → [PgUp]  → [F6] → [Alt] + [P] → Type no. of
rings → [F10] → [F5]
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Group Calling Member Assignments

Use this procedure to assign or remove a telephone from a calling group. A
calling group is used to direct calls to a group of people who all handle the
same type of call. A single extension number is assigned to the group and is
used by both inside and outside callers to reach the group.

NOTE:
If a linear hunting pattern is indicated on the back of the form, be sure to
assign telephones to the group in the exact order that they are shown on
the form. The system searches for an available member in the order that
you assign the telephones to the group.

A maximum of 32 calling groups with a maximum of 20 telephones per group
is allowed.

A telephone can belong to only one calling group. A QCC cannot be a
member of a calling group. The delay announcement device should not be
programmed as a calling group member.

The extension status feature must be set to the Calling Group or CMS mode
before you assign members to the group. See “Extension Status” for more
information.

To reassign a telephone to a new calling group, you must remove it from its
old group before programming the new assignment.

Group Calling Member Assignments 13-7
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Summary Group Calling Member Assignments

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6d, Group Coverage

Not applicable

Extension numbers

Yes

No

Extensions → More → Grp Calling → Members
→ Dial calling group ext. no. → Enter → Dial ext. no.
→ Enter → Exit → Exit → Exit

[F6] → [PgUp]  → [F4] → [F9] → Type calling group
ext. no. → [F10] → Type ext. no. → [F10] →
[F5] → [F5] → [F5]
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Group Calling Trunk or Pool
Assignments

Use this procedure to assignor remove trunks or pools (Hybrid/PBX only) that
ring directly into a calling group.

Incoming calls on each trunk or pool can be directed to only one calling
group.

To reassign a trunk or pool to a new calling group, you must remove it from its
old group before making the new assignment.

Summary: Group Calling Trunk or Pool
Assignments

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6e, Group Calling

Not applicable

Line/trunk number

Yes

No

Extensions → More → Grp Calling →
Line/Pool → Dial calling group ext. no. → Enter →
Dial trunk no. → Enter → Exit → Exit → Exit

[F6] → [PgUp]  → [F4] → [F10] → Type calling group
ext. no. → [F10] → Type trunk no. → [F10] →
[F5] → [F5] → [F5]

Group Calling Trunk or Pool Assignments 13-9
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Optional Group-Calling Features

The following options are available for calling groups:

■   Hunt Type

■   Group Calling Delay Announcement

■   Group Coverage Receiver

■   Group Calling Overflow and Threshold

■   Group Calling Message Waiting Indicator

■   Group Calling Calls-in-Queue Alarm Threshold

■   Group Calling External Alert for Calls-in-Queue Alarms

■   Group Type

13-10  Optional Group-Calling Features
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Hunt Type

Use this procedure to assign one of the following hunt-type patterns to caIling 
groups:

■   Circular hunting pattern-The system distributes calls to group
members by hunting in a circular pattern for the first available
telephone after the one that received the last call to the group.

■   Linear hunting pattern-The system searches for an available group
member in the order in which telephones were assigned to the calling
group.

Summary: Hunt Type

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6e, Group Calling

Circular hunting pattern

Circular, Linear

No

No

Extensions → More → Grp Calling → Hunt
Type → Dial calling group ext. no. → Enter →
Circular/Linear → Enter → Exit → Exit →
Exit

[F6] → [PgUp] → [F4] → [F1] → Type calling group
ext. no. → [F10] → [F1] / [F2] → [F10] → [F5] →
[F5] → [F5]
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Group Calling Delay Announcement

Use this procedure to designate the announcement device used to play
messages to callers while they are waiting in the queue.

Only one announcement device can be designated for each calling group;
however, more than one calling group can use the same announcement
device.

The delay announcement device should not be programmed as a calling
group member.

If the station jack or MFM was previously programmed as a regular station,
you must remove all trunk button assignments before you designate the
station jack as a delay announcement device.

Summary: Group Calling Delay Announcement

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6e, Group Calling

No delay announcement devices are assigned.

Announcement, No announcement

No

No

Extensions → More  → Grp Calling →
DelayAnnce → Dial calling group ext. no. → Enter
→ Dial ext. no. of announcement device → Enter →
Exit → Exit

[F6] → [PgUp] → [F4] → [F2] → Type calling group
ext. no. → [F10] → Type ext. no. of announcement
device → [F10] → [F5] → [F5]
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Group Coverage Receiver

Use this procedure to assign or remove a calling group as receiver for a
coverage group.

Calling group member assignments must be made before you assign the
group as a receiver for a coverage group.

NOTE:
Integrated Administration uses calling group 30 as the default group to
cover AUDIX Voice Power.

Summary: Group Coverage Receiver

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager, Integrated Administration

All

Not required

Form 6d, Group

Not applicable

Group numbers

Yes

No

Coverage

Extensions → More → Grp Calling → Grp
Coverage → Dial calling group ext. no. → Enter →
Dial coverage group no. → Enter → Exit → Exit
→ Exit

[F6] → [PgUp] → [F4] → [F3] → Type calling group
ext. no. → [F10] → Type coverage group no. →
[F10] → [F5] → [F5] → [F5]
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Group Calling Overflow and
Threshold

Use this procedure to designate another calling group or the QCC queue
(Hybrid/PBX only) to receive calls when the number of calls waiting in the
queue for a calling group is equal to or greater than the programmed
threshold.

Overflow coverage can be provided only by calling groups or the QCC queue
(Hybrid/PBX only), not by individual telephones. Group members can be
notified when the number of calls waiting in the queue reaches the threshold.

A calling group or the QCC queue (Hybrid/PBX only) can provide overflow
coverage for more than one calling group; however, which group’s calls go to
an available member in the overflow calling group is unpredictable.

The factory-set extension number for QCC Listed Directory Number is 800.
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Summary: Group Calling Oveflow and
Threshold

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

[F6] → [PgUp]  → [F4] → [F8] → Type calling group
PC Procedure

System manager

All

Not required

Form 6e, Group Calling

Overflow coverage - none; threshold - 1 call

Backup extension number; 1 - 99 calls

No

No

Extensions → More → Grp Calling →
Overflow → Dial calling group ext. no. → Enter →
Dial ext. no. → Enter → Drop → Dial no. of calls →
Enter → Exit → Exit

ext. no. → [F10]  → Type backup ext. no. → [F10]  →
[Alt] + [P] → Type no. of call → [F10]  → [F5] →
[F5]

Group Calling Overflow and Threshold 13-15
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Group Calling Message Waiting
Indicator

Use this procedure to designate a telephone to receive calling group
message-waiting indications (MWI).

Only one telephone can be designated as a message-waiting receiver for
each calling group; however, more than one calling group can use the same
message-waiting receiver. The telephone assigned as a message-waiting
receiver does not have to be a member of the calling group.

Message-waiting indications cannot be sent to the extension assigned to the
group unless this option is programmed. The message-waiting receiver
cannot distinguish between messages left for the calling group and personal
messages.

Summary: Group Calling Message Waiting
Indicator

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6e, Group Calling

No message-waiting receiver assigned

Extension number

No

No

Extensions → More → Grp Calling → Message
→ Dial calling group ext. no. → Enter → Dial ext. no.
for MWI receiver → Enter → Exit → Exit

[F6] → [PgUp]  → [F4] → [F4] → Type calling group
ext. no. →  [F10] → Type ext. no. for MWI receiver →
[F10] → [F5] → [F5]
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Group Calling Calls-In-Queue Alarm
Threshold

Use this procedure to specify the number of unanswered calls waiting in the
calling group queue before group members are notified with either an external
alert or a light on the telephone. Group members are notified when the
number of calls waiting in the queue is equal to or greater than the
programmed threshold.

Summary: Group Calling Calls-In-Queue Alarm
Threshold

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6e, Group Calling

1 call

1 - 99

No

No

Extensions → More → Grp Calling → Queue
Alarm → Dial calling group ext. no. → Enter →
Drop → Dial no. of calls → Enter → Exit → Exit

[F6] → [PgUp]  → [F4] → [F6] → Type calling group
ext. no. → [F10] → [Alt] + [P] → Type no. of calls →
[F10] → [F5] → [F5]

Group Calling Calls-In-Queue Alarm Threshold 13-17
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Group Calling External Alert for
Calls-In-Queue Alarms

Use this procedure to designate the external alert device used to notify calling
group members when the number of calls in the queue reaches the
programmed threshold.

Only one external alert device can be designated for each calling group.

Since the external alert signal is continuous, it is recommended that only
lamp-type external alert devices be designated for use for the CalIs-in-Queue
alarm.

Summary: Group Calling External Alert for
Calls-In-Queue Alarms

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6e, Group Calling

Not applicable

Extension number

No

No

Extensions → More → Grp Calling → Xtnl
Alert → Dial tailing group ext. no. → Enter →
Drop → Dial ext. no. for alert → Enter → Exit →
Exit

[F6] → [PgUp]  → [F4] → [F7] → Type calling group
ext. no. → [F10] → [Alt] + [P] → Type ext. no. for
alert → [F10] → [F5] → [F5]

13-18 Group Calling External Alert for Calls-In-Queue Alarms



Optional Group-Assigned Features

Group Type

Use this procedure to determine whether or not the system automatically logs
in members of a calling group after a power failure. This setting also
determines the type of voice messaging interface when the calling group is
used to connect voice messaging or automated attendant applications. The
following are the possible settings:

■

■

■

■

Automatic Log Out – Used for calling groups to specify that the system
does not automatically log in calling group members after a power
failure. Calling group members must manually log themselves into the
group.

Automatic Log In – Used for calling groups that consist of fax
machines or data ports (also called data hunt groups) to specify that
the system automatically logs in calling group members after a power
failure. This setting can also be used for calling groups consisting of
telephones.

Integrated VMI – Used when a voice messaging system that requires
special signaling for integrated operation (for example, AUDIX Voice
Power-lS II or MERLIN MAIL Voice Messaging System) is connected to
one or more station jacks assigned to a calling group. The system
automatically logs in the group members after a power failure.

Generic VMI – Used when a voice messaging system that does not
need special signaling (for example, MERLIN Attendant) is connected
to one or more station jacks assigned to a calling group. The system
automatically logs in the group members after a power failure.
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Summary: Group Type

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6e, Group Calling

Automatic Log Out

Automatic log in, automatic log out, integrated VMl,
generic VMI

No

No

Extensions → More → Grp Calling → More →
Group Type → Dial calling group ext. no. → Enter
→ Specify login type → Enter → Exit → Exit

[F6] → [PgUp] → [F4] → [PgUp] → [F1] → Type
calling group ext. no. → [F10] → Specify Iogin type →
[F10] → [F5] → [F5]

13-20 Group Type
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The procedures in this chapter consist of instructions for programming
optional system features that affect all or most system users. The following
procedures are included:

■

■

■

■

■

■

■

■

■

■

■

■

Transfer Return Time

One-Touch Transfer/Hold

Transfer Audible

Type of Transfer

Camp-On Return Time

Call Park Return Time

Delay Ring Interval

Automatic Callback Interval

Extension Status

SMDR Language

SMDR Call Report Format

SMDR Call Length

■     SMDR Calls Recorded on Call Report

System Features 14-1
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■

■

■

■

■

■

■

■

■

■

■

■

■

■

Inside Dial Tone

Reminder Service Cancel

Redirect Outside Calls to Unassigned Extension Numbers

Host System Dial Codes for Behind Switch Mode

Recall Timer

Allowed Lists

Assign Allowed Lists to Telephones

Disallowed Lists

Assign Disallowed Lists to Telephones

Remote Access Trunk Assignment

Remote Access Automatic Callback

Remote Access without Barrier Codes

Remote Access Barrier Codes

Remote Access with Barrier Codes

14-2 System Features
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Transfer Return Time

Use this procedure to specify the number of rings before a call transferred to
another inside telephone is returned to the originator. A setting of 0 means
that transferred calls are never returned to the originator.

The transfer return time should not be set to 0 in a system with single-line
telephones.

Summary: Transfer Return Time

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager, Integrated Administration

All

Not required

Form 6f, System Features

4 rings (Integrated Administration – 6 rings)

0 - 9 rings

No

No

Options → Transfer → Return Time → Drop →
Dial no. of rings  → Enter → Exit → Exit
[F7] → [F1] → [F1] → [Alt]  + [P] → Type no. of
rings → [F10] → [F5] → [F5]
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One-Touch Transfer/One-Touch Hold

Use this procedure to assign the One-Touch Transferor One-Touch Hold
feature. One-Touch Transfer allows users to initiate transfers to another
person by pressing an Auto Dial or DSS button for that person.

The One-Touch Transfer feature is not available on single-line telephones.

If the One-Touch Transfer feature is assigned, you must also specify whether
the transfer completion is manual (the user has to press another button to
complete the transfer) or automatic (the transfer is completed automatically).

One-Touch Hold applies to incoming central office calls only. When the user
presses an Auto Dial or DSS button to initiate a transfer, the outside caller is
put on hold. The system automatically selects an intercom facility and dials
the transfer destination. There is no transfer return function with this method.
Consequently, if the transfer destination does not answer or is busy, the user
who initiates the transfer must notify the outside caller, or the outside caller will
remain on hold.

One-Touch Hold is the factory setting in the Behind Switch mode only.

14-4  One-Touch Transfer/One-Touch Hold
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Summary: One-Touch Transfer/Hold

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

A l l

Not required

Form 6f, System Features

One-Touch Transfer, automatic completion (One-
Touch Hold is the factory setting in Behind Switch
mode)

Transfer, Hold

N o

N o

To program One-Touch Transfer:
Options → Transfer → One Touch → Transfer
→ Enter → Manual/Automatic → Enter → Exit
→ Exit

To Program One-Touch Hold:
Options → Transfer → One Touch → Hold →
Enter → Exit → Exit

To program One-Touch Transfer:
[F7] → [F1] → [F2] → [F1] → [F10] → [F1] /
[F2] → [F10] → [F5] → [F5]

To program One-Touch Hold:
[F7] → [F1] → [F2] → [F2] → [F10]  → [F5] →
[F5]

One-Touch Transfer/One-Touch Hold 14-5
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Transfer Audible

Use this procedure to specify whether an outside caller hears ringing (also
called ringback) or Music-on-Hold while being transferred. Inside calls hear
ringback.

NOTE:
If you use equipment that rebroadcasts music or other copyrighted
materials, you may be required to obtain a copyright license from and pay
license fees to a third party (such as the American Society of Composers,
Artists, and Producers or Broadcast Music Incorporated).

Magic on Hold® requires no such license and can be purchased from
your authorized dealer.

Summary: Transfer Audible

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6f, System Features

Music-on-Hold

Music-on-Hold, Ringback

No

No

Options → Transfer → Audible → Music-on-
Hold/Ringback → Enter → Exit → Exit

[F7] → [F1] → [F3] → [F1] / [F2] → [F10]  →
[F5] → [F5]

14-6 Transfer Audible



System Features

Type of Transfer

Use this procedure to specify whether the system automatically selects an
Intercom or System Access Ring or Voice button when the Transfer button or
an Auto Dial or DSS button (for One-Touch Transfer) is pressed.

Summary Type of Transfer

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6f, System Features

Ring button (Intercom or SA) is automatically
selected

Voice Announce, Ring

No

No

Options → Transfer → Type → Voice
Announce/Ring → Enter → Exit → Exit

[F7] → [F1] → [F4] → [F1] / [F2] → [F10]  →
[F5]  → [F5]
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Camp-On Return Time

Use this procedure to specify the number of seconds before a camped-on
call (a call transferred to a busy telephone with the Camp-On feature) is
returned to the originator.

Summary Camp-On Return Time:

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6f, System Features

90 seconds

30 - 300 seconds, in 10-second increments

No

No

Options → CampOn → Drop → Dial no. of seconds
→ Enter → Exit

[F7]  → [F2]  → [Alt]  + [P]  → Type no. of seconds

→ [F10] → [F5]
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Call Park Return Time

Use this procedure to specify the number of seconds before a call put on hold
with the Park feature is returned to the originator.

Summary: Call Park Return Time

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6f, System Features

180 seconds

30 - 300 seconds, in 10-second increments

No

No

Options → CallParkRtn → Drop → Dial no. of
seconds → Enter → Exit
[F7]  → [F3]  → [Alt]  + [P] → Type no. of seconds
→ [F10] → [F5]

Call Park Return Time 14-9
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Delay Ring Interval

Use this procedure to specify the number of rings for the Delay Ring Interval,
which applies when a Primary, Secondary, or Group Cover button is set to
delay ring.

Summary: Delay Ring Interval

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6d, Group Coverage

2 rings

1 – 6 rings

No

No

Options → Delay Ring → Drop → Dial no. of rings
→ Enter → Exit

[F7]  → [F4]  → [Alt]  + [P]  → Type no. of rings →
[F10]  → [F5]

14-10  Delay Ring Interval
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Automatic Callback Interval

Use this procedure to specify the number of rings at the originator’s telephone
before the system cancels a Callback request.

Summary: Automatic Callback Interval

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6f, System Features

3 rings

1 - 6 rings

No

No

Options → Callback → Drop → Dial no. of rings →
Enter → Exit

[F7] → [F4] → [Alt] + [P] → Type no. of rings →
[F10] → [F5]

Automatic Callback Interval 14-11
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Extension Status

Use this procedure to specify whether the Extension Status feature is used in
Hotel or Group CaIling/Call Management System (CMS) mode.

The calling mode selected affects the meaning of the LEDs and use of Auto
Dial or DSS buttons when the DLC operator position is in the Extension Status
mode.

In the Hotel mode, telephones are restricted from making calls in Extension
Status states 1 and 2 (ES1 and ES2). In Group Calling/CMS mode, ES states
reflect member or agent status without restricting the telephones.

In the Group Calling/CMS mode, Extension Status is used by the agents to log
in and out, and by the supervisor to see agent status.

Summary: Extension Status

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6f, System Features

Group Calling/CMS mode

Group Calling/CMS mode, Hotel mode

No

No

Options → Ext Status → Specify ext. status →
Enter → Exit

[F7] → [F7] → Specify ext. status → [F10] → [F5]
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SMDR Language

Release 1.1 and 2.0 Only

Use this procedure to change the language of the SMDR reports. The default
language is the same as the system language. See “System Language.”

Summary SMDR Language

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 1, System Planning

English (matches system language)

English, French, Spanish

No

No

More → Language → SMDR → Select language
→ Enter → Exit

[PgUp] → [F6] → [F3] → Select language → [F10]
→ [F5]

SMDR Language 14-13
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SMDR Call Report Format

Use this procedure to specify whether SMDR call reports are printed in basic
format or ISDN format. In ISDN format, automatic number identification
service appears in the calling number field instead of “IN,” as in the basic
report format. The call recording type for these calls is “l” in the ISDN format
and “V” in the basic format.

ISDN format should be used only in conjunction with automatic number
identification service subscription.

Summary: SMDR Call Report Format

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6f, System Features

Basic format

Basic, ISDN

No

No

Options → SMDR → Format → Basic SMDR/ISDN
SMDR → Enter → Exit → Exit

[F7] → [F8] → [F1] → [F1] / [F2] → [F10]  →
[F5]  → [F5]

14-14  SMDR Call Report Format
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SMDR Call Length

Use this procedure to set the minimum length of time before a call is recorded
on SMDR call reports.

Summary: SMDR Call Length

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6f, System Features

40 seconds

0 - 255 seconds

No

No

Options → SMDR → Call Length → Drop → Dial
no. of seconds → Enter → Exit → Exit

[F7] → [F8] → [F2] → [Alt]  + [P] → Type no. of
seconds → [F10] → [F5] → [F5]

SMDR Call Length 14-15
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SMDR Calls Recorded on Call Report

Use this procedure to specify whether SMDR information is to be recorded for
both incoming and outgoing calls, or only for outgoing calls.

NOTE:
The New Page option merely inserts a page break in the report.

Summary: SMDR Calls Recorded on Call
Report

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6f, System Features

Incoming and outgoing

In/Out, Out Only

No

No

Options → SMDR → Call Report → In/Out or
Out Only → Enter → Exit → Exit

[F7] → [F8] → [F3] → [F1] / [F2] → [F10]  →
[F5] → [F5]

14-16 SMDR Calls Recorded on Call Report



System Features

Inside Dial Tone

Use this procedure to set the system dial tone to be either different from or the
same as the outside line/trunk dial tone.

NOTE:
The system dial tone must be the same as the outside dial tone when the
internal dial tone is not recognized by software applications or modems.

Summary: Inside Dial Tone

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6f, System Features

Inside dial tone is different from outside dial tone

Inside, outside

No

No

Options → InsideDial → Inside/Outside →
Enter → Exit
[F7] → [F9] → [F1] / [F2] → [F10] → [F5]

Inside Dial Tone 14-17
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Reminder Service Cancel

Use this procedure to set the time of day when all programmed Reminder
Service calls are automatically canceled.

Enter the time in 4-digit, 24-hour format, using leading zeros as necessary.

To deactivate Reminder Service Cancel, erase the currently programmed time
and do not enter a new time.

Summary: Reminder Service Cancel

Programmable by System manager

Mode All

Idle Condition Not required

Planning Form Form 6f, System Features

Factory Setting Not applicable

Valid Entries 0000 - 2359

Inspect No

Copy Option No

Console Procedure To deactivate Reminder Service Cancel:
Options → Reminder Srv → Drop → Enter →
Exit

To set Reminder Service cancel time:
Options → Reminder Srv → Drop → Dial time →
Enter → Exit

PC Procedure To deactivate Reminder Service Cancel:
[F7] → [F10]  → [Alt] + [P] → [F10] → [F5]

To set Reminder Service cancel time:
[F7] → [F10] → [Alt] + [P] → Type time → [F10]
→ [F5]
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Redirect Outside Calls to Unassigned
Extension Numbers

Use this procedure to specify the extension number to receive redirected
calls made to unassigned numbers by Remote Access users, by users on DID
trunks (Hybrid/PBX only), or by users on dial-in tie trunks. Calls can be
redirected to the following:

■   the QCC queue (Hybrid/PBX only)

■   another extension number

■   a calling group

In Hybrid/PBX mode only: This setting does not affect calls received on DID
trunks if you have specified that calls to unassigned DID extensions are to
receive a fast busy signal. See “Invalid Destination.”
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Summary: Redirect Outside Calls to Unassigned
Extension Numbers

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6f, System Features

Extension number of primary operator

QCC queue extension number, other extension
number

No

No

To select QCC queue:
Options → More → Unassigned → QCC Queue →
Enter → Exit

To select extension or calling group:
Options → More → Unassigned → Extension or
Grp Calling → Enter → Dial ext. no. → Enter →
Dial group no. → Enter → Exit

To select QCC queue:
[F7] → [PgUp]  → [F1] → [F1] → [F10]  → [F5]

To select extension
[F7] → [PgUp] → 
[F5]

or calling group:

[F1] → [F2] / [F3] → [F10] →
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Host System Dial Codes for Behind
Switch Mode

Use this procedure to assign the host system dial codes for Transfer,
Conference, and Drop.

NOTE:
This procedure applies in Behind Switch mode only.

When multiline telephone users press the Transfer, Conference, and Drop
buttons, a signal is sent to the host system. Assigning the host dial codes
ensures that users can take advantage of these features through the host
system.

Summary: Host System Dial Codes for Behind
Switch Mode

Programmable by System manager

Mode Behind Switch

Idle Condition Not required

Planning Form Form 1, System Planning

Factory Setting No host dial codes are assigned

Valid Entries Not applicable

Inspect No

Copy Option No

Console Procedure Options → More → BehndSwitch → Select feature
→ Drop → Dial host system dial code → Enter →
Exit → Exit

PC Procedure [F7] → [PgUp] → [F2] → Select feature → [Alt] +
[P] → Type host system dial code → [F10] → [F5]
→ [F5]
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Recall Timer

Use this procedure to designate the length of the timed flash that is sent when
Recall is used to disconnect a call and get a new dial tone without hanging
up. The interval of the timed flash and how Recall works depend on the type
of telephone and system operating mode.

The Recall Timer should be reset if multiline telephone users experience either
of the following problems:

■    When the user presses the Recall button on an outside call, nothing
happens. This indicates that the interval is too short and should be
increased to 650 milliseconds or 1 second.

■    In a system operating in Behind Switch mode, when the user presses
the Recall button on an outside call, the call is disconnected. This
indicates that the interval is too long and should be decreased to 350
milliseconds.

Summary Recall Timer

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6f, System Features

450 ms

350 ms, 450 ms, 650 ms, 1 second

No

No

Options → More → → Select RecallTimer →
Select time → Enter → Exit

[F7]  → [PgUp] → [F3]  → Select time → [F10] →
[F5]
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Allowed Lists

Use this procedure to establish Allowed Lists, consisting of telephone
numbers that can be dialed from specified telephones, regardless of calling
restrictions assigned to the telephones.

A maximum of eight lists, numbered 0 through 7, with a maximum of 10
numbers each, numbered 0 through 9, is allowed. Each allowed number can
be no more than 6 digits (an area code plus an exchange) or 6 digits with a
leading 1, where required.

If you program 0 as the first digit of a list entry, any toll restriction assigned to
the station is removed for calls that can be placed by a toll operator.

Special characters (such as “pause”) are not permitted in Allowed List entries.

Summary: Allowed Lists

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

System manager

All

Not required

Form 6g, Allowed

Not applicable

Not applicable

Yes

No

Lists

Console Procedure Tables → AllowList → Dial list no. and entry no.
→ Enter → Drop → Dial no. → Enter → Exit

PC Procedure [F8] → [F1] → Type list no. and entry no. → [F10]
→ [Alt] + [P] → Type no. → [F10] → [F5]
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Assign Allowed Lists to Telephones

Use this procedure to assign access to established Allowed Lists to individual
telephones. More than one Allowed List can be assigned to a telephone.

If you do not enter a list number, list 0 is assigned.

Summary: Assign Allowed Lists to Telephones

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6g, Allowed Lists

Not applicable

0 - 7

Yes

Yes

Tables → AllOwTo → Dial list no. → Enter → Dial
ext. no. → Enter → Exit → Exit

[F8]  → [F2]  → Type list no. → [F10] → Type ext.
no. → [F10]   → [F5]  → [F5]
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Use this procedure to establish Disallowed Lists, consisting of telephone
numbers that cannot be dialed from specified telephones (including
unrestricted telephones).

A maximum of eight lists, numbered 0 through 7, with 10 entries each,
numbered 0 through 9, is allowed. Each number can have a maximum of 11
digits, including a wildcard.

Summary: Disallowed Lists

System Features

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6h, Disallowed Lists

Not applicable

Not applicable

No

No

Tables → Disallow → Dial list no. and entry no. →
Enter → Drop → Dial no. → Enter → Exit

[F8] → [F3] → Type list no. and entry no. → [F10]
→ [Alt] + [P] → Type no. → [F10] → [F5]
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Assign Disallowed Lists to
Telephones

Use this procedure to assign established Disallowed Lists to individual
telephones. Each restricted telephone can be assigned to more than one list.

Summary: Assign Disallowed Lists to
Telephones

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 6h, Disallowed Lists

Not applicable

0 - 7

Yes

Yes

Tables → DisallowTo → Dial list no. → Enter →
Dial ext. no. → Enter → Exit → Exit

[F8]  → [F4]  → Type list no. → [F10] → Type ext.
no. → [F10] → [F5] → [F5]

14-26 Assign Disallowed Lists to Telephones



System Features

Remote Access Features

The following Remote Access features are available:

■   Remote Access

■   Remote Access

■   Remote Access

■   Remote Access

■   Remote Access

Trunk Assignment

Automatic Callback

without Barrier Codes

Barrier Codes

with Barrier Codes

Security of Your System—Preventing Toll Fraud
As a customer of a new telephone system, you should be aware that there
exists an increasing problem of telephone toll fraud. Telephone toll fraud can
occur in many forms, despite the numerous efforts of telephone companies
and telephone equipment manufacturers to control it. Some individuals use
electronic devices to prevent or falsify records of these calls. Others charge
calls to someone else’s number by illegally using lost or stolen calling cards,
billing innocent parties, clipping on to someone else’s line, and breaking into
someone else’s telephone equipment physically or electronically. In certain
instances, unauthorized individuals make connections to the telephone
network through the use of remote access features.

The Remote Access feature of your system, if you choose to use it, permits
off-premises callers to access the system from a remote telephone by using
an 800 number or a 7- or 10-digit telephone number. The system returns an
acknowledgement signaling the user to key in his or her authorization code,
which is selected and administered by the system manager. After the
authorization code is accepted, the system returns dial tone to the user. If
you do not program specific egress restrictions, the user will be able to place
any call normally dialed from a telephone associated with the system. Such
an off-premises network call is originated at, and will be billed from the system
location.

The Remote Access feature, as designed, helps the customer, through proper
administration, to minimize the ability of unauthorized persons to gain access
to the network. Most commonly, phone numbers and codes are
compromised when overheard in a public location, through theft of a wallet or
purse containing access information, or through carelessness (writing codes
on a piece of paper and improperly discarding it). Additionally, hackers may
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use a computer to dial an access code and then publish the information to
other hackers. Enormous charges can be run up quickly. It is the customer’s
responsibility to take the appropriate steps to properly implement the features,
evaluate and administer the various restriction levels, protect access codes,
and distribute access codes only to individuals who have been fully advised
of the sensitive nature of the access information.

Common carriers are required by law to collect their tariffed charges. While
these charges are fraudulent charges made by persons with criminal intent,
applicable tariffs state that the customer of record is responsible for payment
of all long-distance or other network charges. AT&T cannot be responsible for
such charges and will not make any allowance or give any credit for charges
that result from unauthorized access.

To minimize the risk of unauthorized access to your communications system:

Use a nonpublished Remote Access number.

Assign authorization codes randomly to users on a need-to-have basis,
keeping a log of ALL authorized users and assigning one code to one
person.

Use random sequence authorization codes, which are less likely to be
easily broken.

Deactivate all unassigned codes promptly.

Ensure that Remote Access users are aware of their responsibility to
keep the telephone number and any authorization codes secure.

When possible, restrict the off-network capability of off-premises
callers, via use of Call Restrictions and Disallowed List capabilities.

When possible, block out-of-hours calling.

Frequently monitor system call detail reports for quicker detection of
any unauthorized or abnormal calling patterns.

Limit Remote Call Forward to persons on a need-to-have basis.

14-28 Remote Access Features



Remote Access Trunk Assignment

Use this procedure to assign or remove the trunks used for Remote Access.
In addition, you can use this procedure to specify whether the Remote
Access feature is dedicated (always used for Remote Access) or shared
(used for Remote Access only when Night Service is activated).

Trunks used for dedicated Remote Access must not be assigned to ring into a
calling group or the QCC queue.

In the Hybrid/PBX mode, if a trunk assigned to ring into the QCC queue is also
used for shared Remote Access, perform this procedure before you perform
the “QCC Operator to Receive Calls” procedure.

Summary: Remote Access Trunk Assignment

System Features

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 3a, incoming Trunks - Remote Access

Remote Access is not assigned

Dedicated, shared, no remote

Yes

No

Lines Trunks → RemoteAccss → Lines Trunks →
Dial line/trunk no. → Enter → Specify how trunk is
used → Enter → Exit → Exit

[F4]  → [F8]  → [F1]  → Type line/trunk no. → [F10]
→ Specify how trunk is used → [F10]  → [F5]  →
[F5]
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Remote Access Automatic Callback

Use this procedure to allow Remote Access users to use the Automatic
Callback feature to request busy lines/trunks or pools or to prevent use of the
Automatic Callback feature.

NOTE:
This feature applies in Hybrid/PBX mode only.

Summary: Remote Access Automatic Callback

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 3a, Incoming Trunks - Remote Access

Disable

Disable, enable

No

No

Lines Trunks → RemoteAccss → AutoQueuing →
Enable/Disable → Enter → Exit → Exit
[F4] → [F8] → [F6] → [F1] / [F2] → [F10] →
[F5] → [F5]
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Remote Access without Barrier Codes

Use this procedure to change the class of restriction for one of the following:

■   all non-tie lines/trunks

■   all tie trunks and DID trunks with Remote Access

■   the DID remote access code

NOTE:
If barrier code requirements have been established for Remote Access
users, do not use this procedure; use “Remote Access with Barrier
Codes.”

The class of restriction assigned is one of the following:

Restriction – determines whether Remote Access users can make local
and/or toll calls; the following settings are included:

—   unrestricted

—   toll restricted

—   outward restricted

ARS Facility Restriction Level (Hybrid/PBX only) – allows or disallows
use of outgoing trunks by assigning a facility restriction level from 0
through 6. (The value assigned is the opposite from the FRL assigned
to the ARS route, where a value of 0 is the most, and a value of 6 is the
least restrictive.)

Allowed List Assignment – assigns Allowed Lists and is used when
Remote Access users are restricted from making local or toll calls.

Disallowed List Assignment – assigns Disallowed Lists and is used
when Remote Access users are not restricted from making local or toll
calls.

A maximum of eight Allowed or Disallowed Lists can be assigned to trunks.
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Class of restriction settings are assigned either to all non-tie trunks or to all tie
trunks and DID trunks. They cannot be assigned to each trunk on an
individual basis.

Summary: Remote Access without Barrier Codes

Programmable by System manager

Mode All

Idle Condition Not required

Planning Form Form 3a, Incoming Trunks - Remote Access

Factory Setting Call restriction: outward restricted; ARS restriction
level: 3

Valid Entries Unrestricted, toll restricted, outward restricted; 0- 6

Inspect No

Copy Option No

Console Procedure To change Call Restrictions:
LinesTrunks → RemoteAccss → Non-TIE/TIE
Lines → Restriction → Select restrict →
Enter → Exit → Exit → Exit → Exit

To change ARS FRL:
LinesTrunks → RemoteAccss → Non-TIE/TIE
Lines → ARS Restrict → Drop → Dial FRL value
→ Enter → Exit → Exit → Exit → Exit

To assign/remove Allowed Lists:
LinesTrunks → RemoteAccss → Non-TIE/TIE
Lines → Allow List → Dial list no. → Enter →
Exit → Exit → Exit → Exit

To assign/remove Disallowed Lists:
LinesTrunks → RemoteAccss → Non-TIE/TIE
Lines → DisallowLst → Dial list no. → Enter →
Exit → Exit → Exit → Exit
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PC Procedure To change Call Restrictions:
[F4] → [F8] → [F2] / [F3] → [F2] → Select
restriction → [F10] → [F5] → [F5] → [F5] → [F5]
To change ARS FRL:
[F4] → [F8] → [F2] / [F3] → [F3] → [Alt] + [P]
→ Type FRL value → [F10] → [F5] → [F5] → [F5]
→ [F5 ]

To assign/remove Allowed Lists:
[F4] → [F8] → [F2] / [F3] → [F4]
→ [F10] → [F5]  → [F5]  → [F5]  →

To assign/remove Disallowed Lists:
[F4] → [F8] → [F2] / [F3] → [F6]
→ [F10] → [F5]  → [F5] → [F5]  →

→ Type list no.
[F5]

→ Type list no.
[F5]
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Remote Access Barrier Codes

Use this procedure to establish or remove the requirement for barrier codes
as well as to establish or remove the barrier codes themselves. Barrier codes
are security passwords that restrict people from making unauthorized Remote
Access calls on non-tie lines/trunks and tie trunks.

A maximum of 16 four-digit barrier codes is allowed for all lines/trunks. Barrier
code 16 is automatically assigned for Remote Access by qualified support
personnel for system programming and maintenance.

Use “Remote Access with Barrier Codes - Class of Restriction” to allow or
deny use of system features for each barrier code assigned.

Summary: Remote Access Barrier Codes

Programmable by System manager

Mode All

Idle Condition Not required

Planning Form Form 3a, Incoming Trunks - Remote Access

Factory Setting No barrier codes

Valid Entries Not applicable

Inspect No

Copy Option No

are established

Console Procedure LinesTrunks → RemoteAccss → Non-Tie/TIE
Lines → BarrierCode → Specify whether barrier
codes are required → Enter → Exit →
BarrierCode → Codes → Dial barrier code no. →
Enter → Drop → Dial code → Enter → Exit →
Exit → Exit

PC Procedure [F4]  →
whether
→ [F4]
[A l t ] +
→ [F5]

[F8]  → [F2] / [F3]  → [F1]  → Specify
barrier codes are required → [F10] → [F5]
→ [F6] → Type barrier code no. → [F10] → 
[P] → Type code → [F10] → [F5] → [F5]
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Remote Access with Barrier Codes

Use this procedure to change the class of restriction for individual Remote 
Access barrier codes. The class of restriction assigned to each barrier code
allows or denies the use of the following system features:

NOTE:
If barrier code requirements have not been established or have been
removed for Remote Access users, do not use this procedure; use
“Remote Access without Barrier Codes.”

■

■

■

■

Restriction – determines whether Remote Access users can make local
and/or toll calls; the following settings are included:

—   unrestricted

—   toll restricted

—   outward restricted

ARS Facility Restriction Level (Hybrid/PBX only) – allows or restricts
users from using outgoing trunks by assigning a facility restriction level
from 0 through 6. (The value assigned is the opposite from the FRL
assigned to the ARS route, where a value of 0 is the most, and a value
of 6 is the least restrictive.)

Allowed List Assignment – assigns Allowed Lists and is used when
Remote Access users are restricted from making local or toll calls.

Disallowed List Assignment – assigns Disallowed Lists and is used
when Remote Access users are not restricted from making local or toll
calls.

A maximum of eight Allowed or Disallowed Lists can be assigned to each
barrier code. Class of restriction settings apply to individual barrier codes.
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Summary: Remote Access with Barrier Codes

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 3a, Incoming Trunks – Remote Access

Call restriction: Barrier Code – outward restricted; all
other barrier codes – unrestricted.
ARS restriction level – 3

Unrestricted, toll restricted, outward restricted; 0- 6

No

No

LinesTrunks → RemoteAccss → BarrierCode →
Restriction → Dial barrier code no. → Enter →
Select restriction → Enter → ARS Restrict → Dial
barrier code no. → Enter → Drop → Dial FRL value
→ Enter Allow List/Disallow List → Dial
barrier code no. → Enter → Dial list no. → Enter →
Exit → Exit → Exit → Exit

[F4]  → [F8]  → [F4]  → [F3]  → Type barrier code
no. → [F10] → Select restriction → [F10] → [F4] →
Type barrier code no. → [F10]  → [Alt] + [P] →
Type FRL value → [F10]  → [F6]  / [F7]  → Dial
barrier code no. → [F10] → Type list no. → [F10] →
[F5] → [F5] → [F5] → [F5]

14-36 Remote Access with Barrier Codes
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The following features can be programmed for Automatic Route Selection
(ARS):

■

■

■

■

■

■

■

■

■

■

1 + 7 Digit Dialing Requirements
ARS Tables
Start and Stop Times for Subpatterns
Pool Routing
Facility Restriction Level (FRL)
Digit Absorption
Other Digits
N11 Special Numbers Tables
Dial 0 Table
Voice and/or Data Routing

NOTE:
ARS applies only in the Hybrid/PBX mode.

Automatic Route Selection 15-1
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1 + 7 Digit Dialing Requirements

Use this procedure for calls placed within the same area code as the system.
The procedure allows you to specify whether or not the local telephone
company requires dialing 1 plus a 7-digit number. Two settings are available:

■    within area code – 1 plus a 7-digit number must be dialed; the system
checks the 1 + 7 digit tables for routing

■    not within area code – 1 does not have to precede the 7-digit number
(the system does this automatically)

Summary: 1 + 7 Digit Dialing Requirements

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 9b, Automatic Route Selection Tables

Not within area code

Not within area code, Within area code

No

No

Tables → ARS → ARS 1+7Dial → Within Area
Code/Not within Area Code → Enter → Exit
→ Exit
[F8] → [F6] → [F1] → [F1] / [F2] → [F10] →
[F5] → [F5]

15-2 1 + 7 Digit Dialing Requirements
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Automatic Route Selection

Use this procedure for the following tasks:

■   to specify type of table (6-digit, area code, exchange, or 1 + 7)

■   to add or change area codes to be included in each table

■   to add or change exchanges to be included in each table

A maximum of 16 tables can be established, numbered 1 through 16. Each
table can have a maximum of 100 entries, numbered 1 through 100. Tables
17 and 18, the Default Toll and Default Local tables respectively, cannot be
changed.

The first entry in a 6-digit table must be the area code. Subsequent entries
consist of exchanges within that area code.

Area code tables can contain only area codes.

Exchange and 1 + 7 tables can contain only exchanges.

The wildcard character (pause) cannot be used to enter area codes or
exchanges in ARS tables.

ARS Tables 15-3
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Summary: ARS Tables

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 9b, Automatic Route Selection Tables

Not applicable

Not applicable

Yes

No

Tables → ARS → ARS Input → Dial table no. →
Enter → Specify table type → Enter → Dial entry
no. → Enter → Drop → Dial no. → Enter → Exit
→ Exit

[F8]  → [F6]  → [F2]  → Type table no. → [F10]  →
Select table type → [F10] → Type entry no. → [F10]
→ [Alt]  + [P] → Type no. → [F10]  → [F5]  → [F5]

15-4 ARS Tables
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Start and Stop Times for Subpatterns

Use this procedure to specify the time of day when calls are routed using
Subpattern B routing information.

Subpatterns are used to provide two different routing patterns according to
the time of day. This allows you to take advantage of lower rates that may
apply to some or all lines or to change restrictions on some facilities during off
hours.

The stop time for Subpattern B is the start time for Subpattern A.

Enter times in 4-digit, 24-hour notation, using leading zeros as necessary.

Summary: Start and Stop Times for Subpatterns

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 9b, Automatic Route Selection Tables
Form 9c, Automatic Route Selection Default and
Special Numbers Tables

No time is specified, thus all calls are routed
according to Subpattern A

0000 - 2359

No

No

Tables → ARS → Sub B Start → Dial table no. →
Enter → Drop → Dial Start time → Enter → Sub B
Stop → Dial table no. → Enter → Drop → Dial stop
time → Enter → Exit → Exit

[F8]  → [F6]  → [F8]  → Type table no. → [F10] →
[Alt]  + [P]  → Type start time → [F10] → [F9] →
Type table no. → [F10] → [Alt] + [P] → Type stop
time → [F10] → [F5] → [F5]

Start and Stop Times for Subpatterns 15-5
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Pool Routing

Use this procedure to identify the trunk pools on which to route calls to area
codes and/or exchanges included in ARS tables.

A maximum of 6 routes (numbered 1 through 6) can be specified for each
subpattern. Pool routing is programmed for Tables 1 through 16. Table 17 is
the Default Toll table and Table 18 is the Default Local table.

Summary: Pool Routing

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 9b, Automatic Route Selection Tables
Form 9c, Automatic Route Selection Default and
Special Numbers Tables

Not applicable

Not applicable

No

No

Tables → ARS → Sub A Pools/Sub B Pool →
Dial table no. and pool route νο. → Enter → Dial pool
dial-out code → Enter → Exit → Exit

[F8]  → [F6]  → [F3]  / [F10]  → Type table no. and
pool route no. → [F10] → Type pool dial-out code →
[F10] → [F5] → [F5]

15-6 Pool Routing
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Facility Restriction Level

Use this procedure to assign a Facility Restriction Level (FRL) to each route.
The FRL ranges from 0 (least restrictive) through 6 (most restrictive) and is
used to restrict user access to the route. The FRL assigned to telephones
and Remote Access users is opposite from the FRL assigned to routes, where
0 is the most and 6 is the least restrictive.

NOTE:
Pool routes must be programmed before you assign Facility Restriction
Levels.

Facility Restriction Levels are assigned to Tables 1 through 18. Table 17 is
the default toll table and Table 18 is the default local table.

Summary: Facility Restriction Level

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 9b, Automatic Route Selection Tables
Form 9c, Automatic Route Selection Default and
Special Numbers Tables

3

0 - 6

No

No

Tables → ARS → Sub A FRL/ More and Sub B FRL
→ Dial table no. and pool route no. → Enter → Dial
restriction level → Enter → Exit → Exit

[F8]  → [F6] → [F4] / [PgUp] and [F1] → Type
table no. and pool route no. → [F10]  → Type
restriction level → [F10]  → [F5] → [F5]

Facility Restriction Level 15-7
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Digit Absorption

Use this procedure to specify how many of the digits dialed (0 through 11) by
the caller should be absorbed by the system (not sent to the telephone
company’s central office) when a call is made on an identified route.

NOTE:
Pool routes must be programmed before you assign digit absorption.

Values 1 through 11 indicate that the system should not send a certain
number of digits, starting with the first digit dialed by the user (after the dial-
out code).

Digit absorption is assigned to Tables 1 through 18.

Summary: Digit Absorption

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 9b, Automatic Route Selection Tables

0

0 - 11

No

No

Tables → ARS → SubA Absorb / More and SubB
Absorb → Dial table no. and pool route no. → Enter
→ Drop → Dial no. of digits to absorb → Enter →
Exit → Exit

[F8] → [F6] → [F6] / [PgUp] and [F2] → Type
table no. and pool route no. → [F10] → [Alt] + [P]
→ Type no. of digits to absorb → [F10] → [F5] →
[F5]

15-8 Digit Absorption
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Other Digits

Use this procedure to specify extra digits that must be added by the system
to the beginning of the number dialed by the caller when calls are placed on
an identified route.

NOTE:
Pool routes must be programmed before you assign other digits.

A maximum of 20 digits can be added, in any combination of the digits
0 through 9.

Special characters such as switchhook flash, stop, and # cannot be included
as extra digits. Pause is allowed, except in the first position.

Other digits are assigned to Tables 1 through 18.

Summary: Other Digits

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 9b, Automatic Route Selection Tables

0

20 digits (0 - 9)

No

No

Tables → ARS → Sub A Digit/ More → Sub B
Digit → Dial table no. and pool route no. → Enter
→ Drop → Dial digits to be added → Enter → Exit
→ Exit

[F8] → [F6] → [F7] / [PgUp] and [F3] → Type
table no. and pool route no. → [F10] → [Alt] + [P]
→ Type digits to be added → [F10] → [F5] → [F5]

Other Digits 15-9
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N11 Special Numbers Tables

Use this procedure to specify Facility Restriction Level (FRL) and/or digits that 
must be added when emergency numbers in the N11 Special Numbers table
are dialed (for example, 411, 811, or 911).

Subpattern B, absorb, and pool routing cannot be programmed for the
special numbers tables.

Summary: N11 Special Numbers Tables

Programmable by System manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form Form 9c, Automatic Route Selection Default and
Special Numbers Tables

Factory Setting Not applicable

Valid Entries Not applicable

Inspect No

Copy Option No

Console Procedure To change FRL:
Tables → ARS → More → SpeclNumber → ARS
FRL → Drop → Dial FRL value → Enter → Exit →
Exit → Exit

To program other digits:
Tables → ARS → More → SpeclNumber → ARS
Digit → Drop → Dial digits → Enter → Exit →
Exit → Exit
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PC Procedure To change FRL:
[F8] → [F6] → [PgUp] → [F4] → [F1] →
[Alt] + [P] → Type FRL value → [F10] → [F5]
→ [F5] → [F5]

To program other digits:

[F8] → [F6] → [PgUp]  → [F4] → [F2] →
[Alt]  + [P] → Type digits → [F10]  → [F5]
→ [F5] → [F5]

N11 Special Numbers Tables 15-11
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Dial 0 Table

Use this procedure to specify pool routing, Facility Restriction Level (FRL),
and Other Digits for the dial 0 table.

Only one route can be specified; the Subpattern B route cannot be specified
for this table. Digit absorption cannot be specified.

Summary: Dial 0 Table 

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 9c, Automatic Route Selection Default and
Special Numbers Tables

3

0 - 6

No

No

Tables → ARS → More → Dial 0 → Specify ARS
Pool/FRL/Digits → Dial code/value/digit → Enter →
Exit → Exit → Exit

[F8]  → [F6]  → [PgUp]  → [F6]  → Specify ARS
Pool/FRL/Digits → Type code/value/digit → [F10] →
[F5] → [F5] → [F5]

15-12 Dial 0 Table



Voice and/or Data Routing

Use this procedure for routing for voice, data, or voice and data. The
voice/data specification is mainly used in conjunction with PRI. See “PRI
Facilities.” Voice/data routes can be associated with Subpattern A or
Subpattern B.

Summary: Voice and/or Data Routing

Automatic Route Selection

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

Hybrid/PBX

Not required

Form 9c, Automatic Route Selection Default and
Special Numbers Tables

Voice

Voice Only, Data Only, Voice/Data

No

No

Tables → ARS → More → Sub A Data / Sub B
Data → Dial table no. and route no. → Enter →
Select capability → Enter → Exit → Exit

[F8] → [F6] → [PgUp] → [F7] / [F8] → Type table
no. and route no. → [F10] → Select capability →
[F10] → [F5] → [F5]

Voice and/or Data Routing 15-13
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The procedures in this chapter tell you how to program the following optional
Night Service features:

■   Night Service with Group Assignment

■   Night Service with Outward Restriction

■   Night Service with Time Set

Night Service 16-1
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Night Service with Group Assignment

Use this procedure to assign all extensions and calling groups to a Night
Service group for after-hours coverage.

A maximum of eight Night Service groups can be assigned (no more than one
for each operator position assigned). Any number of telephones can be
assigned to a Night Service group, and a telephone can belong to more than
one group.

Release 2.0 Only
A calling group can also be assigned to a Night Service group.

Summary: Night Service with Group
Assignment

Programmable by System manager

Mode All

Idle Condition Not required

Planning Form Form 7a, Night Service – Group Assignment

Factory Setting Not applicable

Valid Entries Not applicable

Inspect No

Copy Option No

Console Procedure To assign a calling group to a Night Service group:
NightSrvce → GroupAssign → Calling Group
→ Dial ext. no. of Night Service attendant → Enter
→ Dial calling group no. → Enter → Exit →
Exit

To assign an extension to a Night Service group:
NightSrvce → GroupAssign → Extensions →
Dial ext. no. of Night Service attendant → Enter →
Dial ext. no. of telephone → Enter → Exit → Exit

16-2 Night Service with Group Assignment
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PC Procedure To assign a calling group to a Night Service group:
[F10]  → [F1]  → [F2]  → Type ext. no. of Night
Service attendant → [F10] → Type calling group no.
→ [F10]  → [F5] → [F5]

To assign an extension to a Night Service group:
[F10]  → [F1]  → [F1]  → Type ext. no. of Night
Service attendant → [F10] → Type ext. no. of
telephone → [F10] → [F5] → [F5]

Night Service with Group Assignment 16-3
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Night Service with Outward
Restriction

Use this procedure to prevent unauthorized after-hours use of telephones.
This feature requires the user, in a non-emergency situation, to enter a
password to make a call when Night Service is activated. It also requires an
operator to enter a password in order to activate Night Service manually.

In addition, this procedure is used to establish the following lists:

■    Emergency Allowed List – telephone numbers that can be dialed
without a password

■    Exclusion List – telephones that are exempt from password
requirements

A maximum of six telephone numbers can be included on the Emergency
Allowed List, each number with a maximum of 12 digits.

Telephones included in the Exclusion List keep normal call restrictions (if any
are assigned); however, they are not protected in any other way from
unauthorized after-hours use.

AUDIX Voice Power ports are automatically included on the Exclusion List.
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Night Service

Summary: Night Service with Outward
Restriction

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 7b, Night Service – Outward Restrictions

No password

Any 4-digit combination of the digits 0 - 9

Yes (exclusion list)

No

NightSrvce → OutRestrict → Drop → Dial
password → Enter → Emergency → Dial item no. →
Enter → Drop → Dial telephone no. → Enter →
ExcludeList → Dial ext. no. → Enter → Exit →
Exit

[F10] → [F2] → [Alt] + [P] → Type password →
[F10] → [F3]  → Type item no. → [F10]  → [Alt]  +
[P] → Type telephone no. → [F10]  → [F4]  → Type
ext. no. → [F10]  → [F5] → [F5]

Night Service with Outward Restriction 16-5
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Night Service with Time Set

Use this procedure to specify the time of day and the days of the week when
Night Service is to be activated and deactivated.

Operators can override the timer and turn Night Service on and off manually.
This feature can be deactivated when out-of-the ordinary situations occur (for
example, a mid-week holiday).

Time of day is entered as four digits, using 24-hour notation. Day is entered
as a single digit (0 – 6); 0 is Sunday. If you enter an invalid number, the
system truncates the number.

Changing the system time while Night Service is active automatically
deactivates it; it must be manually reactivated.

NOTE:
The current day of the week for Night Service must be reset after system
programming information is loaded into memory from a backup.
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Summary: Night Service with Time Set

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Form 7c, Night Service – Time Set

Not applicable

0 - 6 (day); 0000 - 2359 (time)

No

No

To add or change start/stop time:
NightSrvce → Start → Drop → Dial start day and
time → Enter → Stop → Drop → Dial stop day and
time → Enter → Exit

To suspend:
NightSrvce → Day of Week → Dial 9 → Dial day
of week and time → Enter → Exit

To add or change start time:
[F10]  → [F6]  → [Alt]  + [P]  → Type start day and
time → [F10]  → [F7]  → [Alt] + [P]  → Type stop
day and time → [F10]  → [F5]

To suspend:
[F10]  → [F8] → Type 9 → Type day of week and
time → [F10] → [F5]

Night Service with Time Set 16-7
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The procedures in this chapter tell you how to add or change labels for the
following:

■   Extension Directory

■   Lines or Trunks

■   Posted Message

■   Group Calling

■   System Speed Dial Directory

These procedures can be accomplished with Integrated Administration. If
you are programming on the system programming console:
Use the buttons next to the display and line/feature buttons to specify
alphanumeric characters and punctuation for labels. Use the template
provided with the MLX-20L telephone to see which line buttons correspond to
which alphanumeric characters.

If you are programming with SPM:
Use the PC keyboard for labels. All letters will appear on the screen in
uppercase.

Labeling 17-1
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Extension Directory

Use this procedure to establish alphanumeric system labels used by display
set users to identify the person calling or leaving a message. This procedure
is also used to program the Extension Directory feature for MLX telephones.

A label can have a maximum of seven characters.

Summary: Extension Directory

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager, Integrated Administration

All

Not required

Form 2a, System Numbering- Station Jacks

Not applicable

Not applicable

No

No

More → Labeling → Directory → Extension →
Dial ext. no. → Enter → Drop → Enter label →
Enter → Exit → Exit → Exit

[PgUp] → [F1] → [F1] → [F2] → Type ext. no. →
[F10]  → [Alt] + [P] → Type label → [F6] → [F5]
→ [F5] → [F5]

17-2  Extension Directory
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Label Trunks

Use this procedure to establish alphanumeric system labels used by display
set users to identify the line or trunk being used.

Summary: Label Trunks

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager, Integrated Administration

All

Not required

Form 2c, System Numbering- Trunk Jacks

Not applicable

Not applicable

No

No

More → Labeling → LinesTrunks → Dial
line/trunk no. → Enter → Drop → Enter label →
Enter → Exit → Exit

[PgUp]  → [F1]  → [F2]  → Type line/trunk no. →
[F10]  → [Alt] + [P] → Type label → [F6] → [F5]
→ [F5]
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Posted Message

Use this procedure to add or change existing posted messages that let
callers with display telephones know why the person they called does not
answer.

Each posted message can have a maximum of 16 characters. Messages 2
through 10 can be changed through programming. Message 1, Do Not
Disturb, cannot be changed.

Summary: Posted Message

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager, Integrated Administration

All

Not required

Form 8a, Label Form - Posted Message

First 10 messages

1 - 20

No

No

More → Labeling → PostMessage → Dial
message no. → Enter → Drop → Enter message →
Enter → Exit → Exit

[PgUp]  → [F1]  → [F3]  → Type message no. →
[F10]  → [Alt]  + [P]  → Type message → [F6]  →
[F5] → [F5]

17-4 Posted Message
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Group Calling

Use this procedure to establish alphanumeric system labels for display
telephone users to identify calling groups.

A label can have a maximum of seven characters.

Summary: Group Calling

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager, Integrated Administration

All

Not required

Form 6e, Group Calling

Not applicable

Not applicable

No

No

More → Labeling → Grp Calling → Dial calling
group ext. no. → Enter → Drop → Enter label →
Enter → Exit → Exit

[PgUp]  → [F1] → [F4] → Type calling group ext. 
no. →  [F10]   →  [Alt] +  [P]  → Type label → [F6] →
[F5]  → [F5]

Group Calling 17-5
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System Speed Dial Directory

Use this procedure to establish System Speed Dial numbers for all system
users. This procedure is also used to enter the alphanumeric labels shown on
display telephones (for the system directory feature of the MLX telephone).

A total of 130 numbers (System Speed Dial plus System Directory) can be
entered with a maximum of 11 characters per label.

Dial code assignments are 600 through 729.

Summary System Directory

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager, Integrated Administration

All

Not required

Form 8b, System

Not applicable

Not applicable

No

No

Speed Dial

More → Labeling → Directory → System → Dial
dial code no. → Enter → Drop → Enter label →
Enter → Backspace → Dial telephone no. → Enter
→ Yes/No → Enter → Exit → Exit → Exit

[PgUp]  → [F1] → [F1] 
no. → [F10] → [Alt]  +
[F2] → Type telephone
→ [F6]  → [F5]  → [F5]

→
[P]
no.

[F1]  → Type dial code
→ Type label → [F6] →

→ [F6] → [F1] / [F2]
→ [F5]

17-6  System Speed Dial Directory
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18
Use the procedures in this chapter to change the language for system
reports and to print reports.

Print Reports 18-1
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Report Language

Release 1.1 and 2.0 Only

Use this procedure to change the language of system reports. Unless you
change the report language, reports are printed in the language chosen as
the system language.

Summary: Changing the Report Language

Mode All

Idle Condition Not required

Planning Form Form 1, System Planning

Factory Setting English

Valid Entries English, French, Spanish

Inspect No

Copy Option No

Console Procedure More → Language → Printer → Select printer
language → Enter → Exit

PC Procedure [PgUp]  → [F6] → [F4] → Select printer language →
[F10] → [F5]

18-2 Report Language
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Printing System Reports

The communications system can be used to print a variety of reports. You
can print individual reports or use the All option to print the entire set of
available reports, including all report sections and options. Appendix E
contains samples of print reports.

■    Use this procedure to print the following reports. With the exception of
Trunk Information, the bullet lists show the sections of each report that
automatically print when the report option is selected.

—   All
●   Each report
●   Report options

—   System Set Up
—   System Dial Plan

●   Pools
●   Telephone Paging Zones
●   Direct Group Calling
●   Lines/Trunks
●   Stations

—   Label Information
●   Telephone Personal Directory
●   Message Numbers and Posted Messages

—   Trunk Information ✱

●   TIE
●   DID
●   Loop/Ground
●   General

—   T1 Information
—   PRI Information

✱ Trunk option must be specified.
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— Remote Access
●   General Options
●   Non-TIE Restrictions
●   TIE Restrictions
●   Barrier Code Restrictions

Operator Information—
●

●

●

●

●

Position
General Options
DSS Options
QCC Operators
Operator Information

—
—
—
—
—

—
—
—
—
—
—
—
—
—

Allowed Lists
Allowed Lists Assigned to Extensions
Disallowed Lists
Disallowed Lists Assigned to Extensions
Automatic Route Selection

 ●   Tables
Extension Directory
System Directory
Group Page
Extension Information
Group Coverage
Group Calling
Night Service
Call Pickup Groups
Error Logs

■ If you select the All option, keep in mind that the reports take several
minutes to print. You may want to schedule use of the printer during
off-peak hours.

■    If you select a report for which there is no information, the report
header still prints.

■    Print reports if you cannot back up your system programming
information.

■    Do not print reports if your system must handle more than 100 calls per
hour.
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■    If you are printing from the console, your printer must
the SMDR port. If you are programming on a PC with
the following choices:

be connected to
SPM, you have

—   print reports on the SMDR printer (if available)

—   print reports on the PC printer

—   save reports (on hard disk or floppy)

—   view reports (browse)

Printing System Reports 18-5
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Summary: Printing Reports

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

Not required

Not applicable

Not applicable

Any saved report

No

No

To print trunk information:
More → Print → Select Trunk Info → Select
trunk type → Exit

To print extension information:
More → Print → More → Select Ext Info → Dial
extension number → Enter → Exit

To print all other reports:
More → Print → Select report → Exit

To print trunk information:
[PgUp] → [F3] → [F6] → Select trunk type → [F5]

To print extension information:
[PgUp] → [F3] → [PgUp] → [F10] → Type
extension number → [F10] → [F5]

To print all other reports:
[PgUp] → [F3] → Select report → [F5]

To save report on disk:
[PgUp] → [F3] → Select report → [F10] → GOTO
FLOPPY → [F10]

To view report:

[ C t r l ] + [ 8 ]

18-6  Printing System Reports
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The following procedure is provided in this section:

■ Analog Mutliline Telephones with Simultaneous Voice and Data

The other procedures for programming data features can be found in earlier
chapters of this book. Refer to the following table for specific information.

Table 19-1.  Data Features: Programming Procedures

Procedure Chapter

Assign Trunks or Pools to 9: “Telephones”
Data Stations

Copy Trunk Assignments 9: “Telephones”

Assign Intercom or 9: "Telephones”
System Access Buttons

Pool Dial-Out Code 11: “Optional Telephone
(Hybrid/PBX Only) Features”

Call Restrictions 11: “Optional Telephone
Features”

Copy Call Restrictions 11: “Optional Telephone
Features”

Continued on next page
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Table 19-1. – Continued

Procedure Chapter

Forced Account Code
Entry

Ringing Options

Assign Data Hunt Group
Members

Assign Data Hunt Group
Trunks or Pools

Group Type

11: “Optional Telephone
Features”

System Programming,
Chapter 4, “Centralized
Telephone Programming”

13: “Optional Group-
Assigned Features” in
section “Group Calling
Member Assignments”

13: “Optional Group-
Assigned Features” in
section “Group Calling
Trunk or Pool
Assignments”

13: “Optional Group-
Assigned Features”
(choice restricted to
Automatic Log In)
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Analog Multiline Telephones with
Simultaneous Voice/Data

Use this procedure to dedicate a voice/data pair to provide the Simultaneous
Voice and Data feature to an analog multiline telephone.

The extension number associated with the first (odd-numbered) station jack in
the pair is the telephone’s extension number. The extension number for the
second (even-numbered) station jack is dedicated to the Simultaneous Voice
and Data feature.

Calls cannot be placed to the station jack reserved for the
Simultaneous Voice and Data feature.

An extension number cannot be dedicated for both the Voice
Announce to Busy feature and the Simultaneous Voice and Data
feature.

When you select Enter after entering the voice extension number in
the data entry screeen, the system automatically assigns the data
station extension.

Use the Inspect feature to verify the entension pair.
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Summary: Analog Multiline Telephones with
Simultaneous Voice/Data

Programmable by

Mode

Idle Condition

Planning Form

Factory Setting 

Valid Entries

Inspect

Copy Option

Console Procedure

PC Procedure

System manager

All

System idle

Form 2a, System Numbering— Station Jacks
Form 4b, Analog Multiline Telephone
Form 5a, Direct-Line Console (DLC)—Analog
Data Form 2a, Analog

Not applicable

Extension numbers of

Yes

Yes

Data Station

analog sets

More → Data → Voice/Data → Dial ext. no. →
Enter → Exit

[PgUp]   → [F2] → [F1] → Type ext. no. →
[F10] → [F5]
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Capabilities

The Integrated Administration capability of Integrated Solution Ill (IS-III)
simplifies the programming of common information for the communications
system (the “switch” ), AUDIX Voice Power™ , and, if it is also installed, AT&T
FAX Attendant System™. Since the AUDIX Voice Power and FAX Attendant
applications use some of the same information programmed on the switch,
Integrated Administration lets the installer or system manager make changes
or additions to this information just once, instead of on both sides of the
connection. Using Integrated Administration reduces programming time and
effort and ensures that the switch and the applications are in agreement.

NOTE:
This feature applies only to Release 2.0 or later of the communications
system.

Integrated Administration is available in Hybrid/PBX and Key modes only.
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Common Information

The switch and the applications share the following information:

■    System numbering of extensions, trunks, and pools

■    System labeling — the user or other name associated with each
extension, trunk, and pool

■   The

■   The

■   The

■   The

■   The

Set Up

Coverage Group that sends its calls to the applications

Calling Group set up for each service of the applications

Reliable Disconnect setting for loop-start trunks

Delay Ring and Coverage Delay Interval settings

Transfer Return Time and VMS Transfer Return interval

You cannot program the common information until you have completed basic
setup programming for the communications system. Use SPM or the system
programming console to program the following:

■   Mode of operation

■   System numbering

■   System operator positions

■   Phantom extensions

■   Trunks to pools assignment

NOTE:
If you do not want all lines to have the same application services, you
must assign lines with the same services to the same pools
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Programmable Options

Once you have completed these system programming tasks, you can
program the following information through Integrated Administration.

Table 20-1. Programming through Integrated Administration

Option Factory Setting

Automated Attendant Calling Group
Call Answer Calling Group
FAX Response Calling Group
Information Service Calling Group
Message Drop Calling Group
Voice Mail Calling Group
Coverage Group
Reliable Disconnect
Delay Ring
Coverage Delay Ring
VMS Transfer Return Interval
Transfer Return Time

770
7926
7924
7927
7928
7925

30
yes

2 rings
3 rings
6 rings
6 rings

Range

1–30

1–6 rings
1–9 rings
0–9 rings
0–9 rings

The information programmed through Integrated Administration is shared with
the communications system control unit and does not have to be programmed
again when you program the communications system.

If the technician or system manager changes extension numbering on the
switch, using the MLX-20L console or SPM, the switch and the application
database will no longer be in agreement. To reduce the chance that such
changes will disrupt communication between the switch and the applications,
Integrated Administration includes an automatic reconciliation program that
runs every day at 3:00 a.m., comparing the application database to the switch
programming and bringing the two into agreement. The program makes
changes, as necessary, only to the application database, according to the
rules listed in Table 20-2. It does not change the switch programming.
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Table 20-2 Database Reconciliation Rules

Extension appears in . . .

Switch Application Database Action

yes yes

yes no

no yes
(regular extension)

no yes
(special extension)

yes yes
(special extension)

None.

Extension is added to database. Can be added as AUDIX
Voice Power or AUDIX Voice Power/FAX Attendant
subscriber through Extension Directory screen.

Extension is deleted from database and removed as an
AUDIX Voice Power or AUDIX Voice Power/
FAX Attendant subscriber.

Extension is retained as special-purpose extension
in database.

Extension is converted from special-purpose extension
to regular extension in database.

When you have finished programming the common information, you can
complete any remaining system programming procedures. See System
Refefence for additional information on Integrated Administration.

Complete information on IS-III can be found in Integrated Solution III System
Manager’s Guide, Order No. 555-601-010 and AT&T Integrated Solution III
lnstallation and Maintenance Guide, Order No. 555-601-011.
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Menu Hierarchy A
The system programming menu hierarchy details the sequence of menu
screens that appear when you select the system programming options. The
choice of an option on the first menu screen leads to either a second menu
screen or a data-entry screen. A secondary menu screen may lead to still
another menu screen, and soon up to six screens, as shown in the following
pages.

You can use the Inspect feature in system programming to display the
telephone or line/trunk numbers that are programmed with a specific feature.
Inspect is helpful when you must assign a feature to many lines/trunks or
extensions and you do not have a Direct Station Selector (DSS) attached to
the system programming console, or when you are programming using a PC
with SPM.

Inspect can be used with the menu options on the following pages that have
an asterisk ( ✱ ) next to them. To use Inspect in system programming, choose
an eligible option, and press Inspct or PgDn.
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- Manual
- Automatic

- Hold
● Audible

- Music On
Hold

- Ringback
● Type

- Voice
Announce

System Programming

System SysRenumber Operator Lines Trunks Extensions Options

I
Restart
SProg Port
M o d e
●  Key
●  Hybrid/PBX
●  Behind Switch
Board Renum
MaintenBusy
●  Enable

- Auto Busy Tie
Trunks
- Enable
- Disable

●  Disable
D a t e
Time

Default Numbering
●  2 Digit
●  3 Digit
●  Set Up Space
Single
● Lines ✱
●  Extensions ✱
●  Pools ✱
●  Group Page ✱
●  GrpCalling ✱
●  Adjuncts ✱
●  Park ✱ 
●  ARS DialOut 
●  Remote Accs
●  DSS Buttons ✱
●  ListDirctNo
Block

Positions
●  Direct Line ✱
●  Queued Call ✱
Queued Call
●   Hold Rtrn

-  Return to
Queue

-  Remain On
Hold

●  Hold Release
-  Auto Hold
-  Auto Release

●  Threshold
●  Elvate Prior
●  InQue Alert ✱

LS/GS/DS1
●  DS1

-  Type
-  T1 ✱

-  GroundStart ✱
- Loop Start ✱
-  TIE

-  TIE PBX ✱

TT/LS Disc
● OutMode
● LS Disconnect

-  Yes
-  No

DID
● Block†

-  ACCUNET
SDS

- SoftDelNetw
-  MULTI

QUEST
-  Megacom

WATS

Lines Trunks†
Line Copy
● Single
● Block
Dial OutCd†
Restriction

Transfer
● Return Time
● One Touch

- Transfer

● Unrestricted
● Outward Restrict

-  Toll ✱ ● Type
-  Unequipped ✱ -  Immed
-  All Ground -  Wink
-  All Loop ●  Disconnect
-  All TIE ●  ExceptDigit

-  TIE PBX ●  Delete Digit
-  Toll ●  Add Digits

-  All Unequip ●  Signaling
-  DID ✱ -  Rotary
-  All DID -  Touch Tone

-  PRI ●  InvalDstn
-  Framed Format -  Send To

-  D4 Backup

- Long Distance
-  Local

-  lNWATS
-  56/64 Digtl
-  VirtPrivNet
-  OUTWATS

-  Misc
-  Other
-  Any Service
-  No Service

-  Patterns
-  TotalDigits
-  DeleteDigit

● Toll Restrict
Restrict Copy
● Single
● Block
Account ✱
BIS/HFAI ✱
Call PickUp  ✱
VoiceSignl ✱
Ext Status ✱
Group Page ✱

- InQue Alert
Enable

- InQue Alert

- Ring
CampOn
CallParkRtn
Delay Ring
Callback
Ext Status

●  Lines
●  Extensions
●   Adjuncts

Disable
●  Call Types

-  Dial 0
- Priority
- Operator ✱

-  Follow Frwd
-  Unassign DID

-  Priority
-  Operator ✱

-  Listed Number
- Priority
- Operator ✱

- Qcc Ext
-  Returning

-  Priority
-  Operator ✱

-  Grp Coverage
-  Priority
-  Operator ✱

●  Mesg Center ✱

-  AMI -ZCS
-  B8ZS

-  Signaling

Compatible
-  Extended

Super Frame
-  Suppression

-  Robbed Bit
-  Common

Channel
-  Line Comp
-  Clock Sync

- Priority
-  Primary
-  Secondary
-  Tertary
-  None

-  Source

Extension
-  Return Fast Busy

PRI
●  Phonenumbr
●  B Channel Grp

-  B Channels ✱
-  Lines ✱ †
-  Network Serv

-  AT&T Toll
-  Megacom

WATS
-  ACCUNET

SDS
-  Soft Defnetwk
-  Megacom

800
-  MULTI

QUEST

-  Add Digits
●  Outgoing Tbl

-  Netwrk Select
-  Special Serv

-  Pattern
-  Operator

-  Local
Operator

- Presubscribed
Carrier

-  No Operator
- TypeOfNumber

-  National
-  International

-  DeleteDigit
-  CMC Service

-  Patterns
-  Voice/Data

Group Cover ✱
Group Calling
● Hunt Type

- Circular
- Linear

● Delay Annce
● GrpCoverage†
● Message
● Queue Alarm
● Xtnl Alert
● Overflow
● Members ✱
● Line/Pool ✱
● Group Type

- Auto Login
- Auto Logout
- Integ VMI
- Generic VMI

● Hotel
● GrpCall/CMR
S M D R

● Format
- Basic SMDR
- ISDN SMDR

● Call Length
● Call Report

- In/Out
- Out Only

● New Page
Inside Dial

● Outside
ReminderSrv
Unassigned
● QCC Queue

● Grp Calling
Behnd Switch
● Transfer

● Inside

●  ExtndComplt
-  Automatic

Complete
-  Manual

Complete
●  Return Ring
●  QCC Backup
Hold Timer
DCL Hold
●  Auto Hold Enable
●  Auto Hold Disable

ARS Restrict
Mic Disable ✱

Remote Frwd ✱

● Extension

-  Loop
-  Local

-  Activation
-  Activve-  Not Active

- Channel Unit
-  Foreign

Exchange
-  Special

Access
●  (4xx GS/LS)

-  Ground Start ✱
-  Loop Start ✱
-  All Ground
-  All Looop

●  (8xx GS/LS)
-  Ground Start ✱
-  Loop Start ✱
-  All Ground
-  All Loop

TIE Lines

-  Long Distance
-  Local
-  OUTWATS
-  56/64 Digits
- VirtPrivNet 
-  INWATS

-  Misc
-  Other
-  Call by Call

-  Copy Number
-  Copy PhnNumber

to Num To Send
-  Do not Copy

Phone Number
-  IncomingRtg

-  Routing by Dial
Plan

-  Route by Line

-  Voice Only
-  Data Only
-  Voice/Data

- Network Serv
- AT&T Toll

- Megacom
WATS

- ACCUNET SDS
- SoftDelNetwrk
- Long Distance

- Local
- OUTWATS
- 56/64 Digtl
- VitPrivNet

- Misc
- Other
- No Service

- Delete Digit

● Conference
● Drop
Recall Timer
● 350 ms
● 450 ms
● 650 ms
● 1 sec
Rotary
● Delay
● No Delay
Cover Delay

* ✱   The Inspect feature can be used with this
menu option. Press Inspect or PgDn. Lines Trunks

Continued
- Restriction

† The lnspect feature can be used in entry
mode with this menu option. Press
Inspect or PgDn while in entry mode. ●  Direction

-  Two Way
-  Outgoing
-  Incoming

●  Intype
-  Wink
-  Delay
-  Immed
-  Auto

●  Outtype
-  Wink
-  Delay
-  Immed
-  Auto

●  E&M Signal
-  Type1S
-  Type1C
-  Type5

Appearance
●  Numbr To Send

-  Extension Only
-  Base Number

with Ext
-  Line Telephone

Number
●  Test TelNum
●  Protocol

-  Timers
-  T200 Timer
-  T203 Timer
-  N200Counter
-  N201Counter
-  K Counter
-  T303 Tomer
-  T305 Timer
-  T308 Timer

Copy
●  Single
●  Block
Remote Access
●  Lines Trunks

- Dedicated
- Shared

- Unrestricted
- Outward

Restrict
- Toll

Restrict
- ARS Restrict
- Allow List ✱
- Disallow List ✱

● Barrier Code
- SProgMaint

- No Remote
●  Non TIE

- BarrierCode
- Barrier Code

Required
- Barrier Code

Not Required
- Restriction

- Unrestricted
- Outward

- Codes
- Restriction

- Unrestricted
- Outward

Restrict
- Toll Restrict

- ARS Restrict

●  Inmode†
●  Outmode†
●  Dialtone†
●  Anssupr†
●  Disconnect

-  T309 Timer
-  T310 Timer
-  T313 Timer
-  T316 Timer

-  TEI
●  Dial Planning

-  Service
-  AT&T Toll

-  Megacom
800

Restrict
- Toll Restrict

- ARS Restict
- Allow List ✱
- Disallow List ✱

● TIE Lines
- Barrier Code

- Barrie Code
Required

- Barrier Code
Not Required

- Allow List ✱
- Disallow List ✱

● AutoQueuing
- Enable
- Disable

Pools†
TollType†
HoldDiscnct†
PrncipalUsr
QCC Prior†
QCC Oper†
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Tables AuxEquip NightSrvce Labeling Data P r i n t Cntr-Prg Language

AllowList
AllowTo†
Disallow
DisallowTo†
ARS
● ARS 1+7 Dial

- Within Area
Code

- Not Within
Area Code

● ARS Input
- 6-Digit†
- Area Code†
- Exchange†
- 1+7†

MusicOnHold
LdspkrPage ✱
F a x
● Extension ✱
● Msg Waiting ✱
● Threshold
MaintAlarms
VMS/AA
● TransferRtn
● TT Duration
● TT Interval

GroupAssign†
● Extensions ✱
● Calling Grp
OutRestrict
Emergency
ExcludeList ✱
Start ✱
Stop ✱
Day of Week

Directory
● System
● Extension
● Personal
LinesTrunks
PostMessge
Grp Calling

VoiceData ✱ All
SysSet-up
Dial Plan
Labels
Trunk Info
● TIE
● DID
● Loop/Ground
● General
T1 Info
PRI Info
Rmote Access
Oper Info
AllowList
AllowListTo
DisallowLst

Program Ext
Copy Ext

SystemLang
● English
● French
● Spanish
Extensions
● Single

- English
- French
- Spanish

● Block
- English
- French
- Spanish

S M D R
● English
● French● Sub A Pools

● Sub A FRL
● Sub A Absorb
● Sub A Digit
● Sub B Start
● Sub B Stop
● Sub B Pool
● Sub B FRL
● Sub B Absorb
● Sub B Digit
● SpeclNumber

- ARS FRL
- ARS Digit

● Dial 0
- ARS Pool
- ARS FRL
- ARS Digits

● Sub A Data
- Voice Only
- Data Only
- Voice/Data

● Sub B Data
- Voice Only
- Data Only

DisallowTo
ARS
Ext Direct
Sys Direst
Grop Page
Ext Info
GrpCoverage
Grp Calling
Night Service
Call Picup
Error Log

● Spanish
P r i n t e r
● English
● French
● Spanish

✱ The lnspect featurr can be used with this menu option. Press Inspect or PgDn.

† The Inspect feature can be used in  entry mode with this menu option. Press
Inspect or PgDn while in entry mode.

- Voice/Data
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LED Displays B

Console LED Status

Tables B-1 and B-2 indicate LED status on the MLX-20L console. LED status
is indicated on the LEDs next to the 20 buttons below the display area on the
system programming console. LED status is simulated on the computer
screen when you use SPM.

Console LED Status B-1
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Table B-1.  Line or Trunk Feature Status
LED Status ✱

System
Green LED Red LEDProgram-

ming Menu
OFF FLASHING O N OFF FLASHINGOption

LinesTrunks
O p t i o n
Tie Lines
Inmode

ON

Incoming
tie line
is rotary

Incoming
tie line
is touch-
tone
Outgoing
tie line
is touch-
tone

dial†
Outgoing
tie line

Outmode

is rotary
d ia l†  
Local

LinesTrunks

Dialtone Remote
dial
tone†

dial
tone

TT/LS Disc
Line/Outmode Line/

trunk is
touch-
tone†

trunk is
rotary
dial

LinesTrunks Remote
Accss

Remote
access
is not
assigned
to line/trunk†

LinesTrunks Remote
access is
assigned to
line/trunk†

Trunk is Trunk is
not in pool

LinesTrunks Pools
in pool

✱ LED Status is indicated on LEDs next to the 20 buttons below the display area of the system programming
console or simulated on the computer screen when using SPM.

† This is the factory setting.

B-2  Console LED Status



LED Displays

Table B-1. - Continued

System
Programm-
ming Menu
Option
LinesTrunks

Option O N
Toll Type Must dial 1+

area code†

LinesTrunks HoldDisconct Long -
450 ms†

LinesTrunks Remote Frwd Line/trunk
assigned

Extensions LinesTrunks Line/trunk
or pool is
assigned
to button

Extensions Dial Out Cd Station can
use dial-out
code for pool
access

System SysProg Port

Operator Position
Direct Trunk
Queued Call

Operator
position

Other

Operator QueuedCall
Message
Center

InQueueAlert

LED Status ✱

Green LED Red LED

OFF FLASHING ON OFF FLASHING
 1 + dialing
is not
needed
Short-
50 ms
Line/trunk
not
assigned†
Line/trunk Trunk is
or pool is
not assigned
to button
Station
cannot use
dial-out
code for
pool

assigned
to a
pool
Trunk is
assigned
to a
pool

access
System Other Can be
programming assigned
port as system

programming
port

Message O t h e r
Center
Position

Position O t h e r
receives
In-Queue
Alert

Can be
assigned
as
operator
position
Can be
assigned
as
Message
Center
Position can 
receive
In-Queue
Alert

† This is the factory setting.
✱ LED Status is indicated on LEDs next to the 20 buttons below the display area of the system programming

console or simulated on the computer screen when using SPM.
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Table B-2.  Telephone Feature Status for DSS Console Only
System
Program- Red LED Status
ming Menu
Option Option O N OFF FLASHING

Call Types — Position Other Position
Dial 0, LDN receives call can receive
Unassigned type call type
DID, Grp
Coverage

Extensions Restriction None† Outward Toll
restricted restricted

Extensions Account Forced Forced
(FACE) Account Account

Code Entry Code Entry
assigned not
assigned†

Extensions BIS/HFAl Telephone Other
has BIS/HFAl
capability
(factory
setting for
analog
multiline
telephones)

Extensions Call Pickup Telephone Telephone
is assigned is not
to Call assigned
Pickup to Call
Group Pickup
Group†

Extensions VoiceSignl Voice Voice
Announce Announce
to Busy to Busy
assigned not
assigned†

Extensions Ext Status Extension Extension Extension
status Status not Status can
assigned assigned be assigned

Extensions Group Page Telephone Telephone
is in group is not in
group†

Extensions Group Cover Telephone Telephone
is in is not in
coverage coverage
group group†

†  This is the factory setting
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Table B-2. - Continued
System
Program- Red LED Status
ming Menu
Option Option ON OFF FLASHING
Extensions Group

Calling
Members Telephone Telephone

is is not
assigned assigned
to group to group†

Extensions Mic Telephone Telephone
Disable microphone microphone

is disabled is enabled
Extensions Remote Telephone Telephone

Frwd can transfer cannot
calls to a transfer calls
remote to a remote
telephone telephone
number number†

Night Group Telephone is Telephone is
Service Assign in group not in group†
Night Exclude Telephone is Telephone is
Service List excluded not

excluded†
Aux Msg Station is a Station is not
Equip Waiting fax message- a fax

waiting message-
station waiting
station

Aux Fax Station is a Station is not
Equip fax machine a fax machine
Aux VMS/AA VMS or AA Other† Operator
Equip jack position

Tables AIIowTo Allowed Allowed
List List
assigned to not
to assigned
telephone to telephone†

Tables DisallowTo Disallowed Disallowed
list assigned list not
to telephone assigned

to telephone†
Data Voice/

Data

†  This is the factory setting.

Console LED Status  B-5



General Feature Use and
Telephone Programming C

This appendix contains information on the general use of features for the MLX,
analog multiline, and single-line telephones. It covers telephone and operator
features and the acceptable programming codes for each. It also describes
how to program these features on MLX and analog multiline telephones.

General Feature Use Information C-2
Feature Table C-4
Telephone Programming C-9
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General Feature Use and Telephone Programming

General Feature Use Information

The following provides general instructions for feature use on MLX, analog
multiline, and single-line telephones. Features can be used in the following
ways:

■   by pressing a dedicated feature button

■   by pressing a programmed button

■   by dialing a feature code

■   by selecting the feature from the display (MLX display telephones only)

Dedicated Feature Buttons

All multiline telephones have a group of dedicated feature buttons that are
programmed and labeled at the factory. The functions of these buttons,
which include Conference, Transfer, and Speaker, cannot be changed. Press
the button for the feature you want to use.

Programmed Buttons

Any unlabeled line button on multiline telephones can be programmed with a
feature for one-touch activation. See Tables C-1 through C-4 for more
information on programming features onto line buttons.

Some features, such as Auto Dial, must be programmed onto line buttons in
order to use them. Other features, such as Privacy, are best used if
programmed onto line buttons — the LED next to the line button provides
visual indication that the feature is in use. The following features must be
programmed onto line buttons:

■   Auto Answer All

■   Auto Answer Headset

■   Auto Dial
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■   Barge-In

■   Coverage

—  Group Coverage

—  Primary Coverage

—  Secondary Coverage

—  Coverage Off

■   Do Not Disturb

■   Extension Status—Agent Login/Logout

■   Feature Button (analog multiline telephones only)

■   Headset/Handset Mute

■   Headset Status

■   Headset Hang Up

■   Notify

■ Posted Message (available from display on MLX display telephones)

■   Saved Number Dial

■   Signaling

Feature Codes

Feature codes are 1-, 2-, and 3-digit codes that activate features. A feature
code is used by first pressing the dedicated Feature button on MLX
telephones; pressing a programmed Feature button on analog multiline
telephones; dialing # on single-line telephones. Each of these methods
sends a signal to the system that a feature code is about to be dialed. When
the code is dialed, the feature is activated.
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NOTE:
Queued Call Console (QCC) system operators cannot use feature codes.

The following features can be used only by dialing feature codes:

■   Call Pickup

■   Forward/Follow Me—Cancel One

■   Forward/Follow Me—Cancel All

■   Message Cancel

■   Personal Speed Dial

■   System Speed Dial

NOTE:
Pressing the Conference, Transfer, Speaker, or Feature button while
activating a feature cancels the process. Pressing any other button, such
as the Mute, HFAI, Message Status, DSS Page, More, Message, Clock,
analog multiline display keys, or analog multiline disconnect button does
not cancel the feature activating-process.

Feature Table

Table C-1 lists the telephone and operator features that can be assigned to
telephones or consoles via Centralized Telephone Programming or by users
from their telephones.
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Table C-1.  Telephone and Operator Features
Analog
Multi-
line
KPB

MLX-
10D
KPB

Prog.
Code
✱ 82

Display
Label

Single-
Line
KP

MLX-
10
KPB

MLX-
28D
KPB

KPB

MLX-
20L
KPB

Feature
Account Code
Entry

Account Code

✱ 759
✱ 754

KPB
KPB

Alarm† Alarm KPB

Auto Answer
All
Auto Answer
Intercom
Auto Dial

Inside
Outside

Automatic Line
Selection

On
of f

AutoAns All

KPB✱ 753 AutoAnsIcom

KPB KPB

KPB

KPB
KPB

KPB

KPB
B
KPB

KPB

KPB

KPB

KPB
KPB

KPB

KPB
B
KPB

KPB

KPB

KPB

KPB
KPB

KPB

KPB
B
KPB

KPB

KPB

KPB

Auto Dial
Insida
Outside

AutoLinoSel

✱ 22 + ext. no.
✱ 21 + tel. no.

KPB

✱ 14
✱✱ 14

Barge-ln†‡ ✱ 58 KPB
KPB

KPB
KPB

Barge In
KP

KPB

Callback
Automatic

On
of f

Selective
Call Waiting

On

Cback Auto
On
off
Cback Sel

✱ 12
✱✱ 12
✱ 55

KPB KPBCallWaiting
On
off

Camp On

✱ 11
✱✱ 11of f

Camp-On ✱ 57 KPB
B
KPB

KPB
B
KPB

✱ 772Conference Conference

Coverage
Receiver buttons

Group
Primary
Secondary

Sender buttons
Cover inside
& outside calls

Coverage

✱ 42 + ext. no.
✱ 40 + ext. no.
✱ 41 + ext. no.

Group
Primary
Secondary

✱ 48 KPBCoverInside,
On

Cover outside
calls only KPB

KPB
KPB

✱✱ 48 CoverInside,
off
CoverageOffCoverage off

VMS off
Data Status

✱ 49
✱ 46
✱ 83 + ext. no. KPB KPB

K Key mode† Operator console
‡ Centralized Telephone Programming only P PBX mode

B Behind Switch mode
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General Feature Use and Telephone Programming

✱ 45

✱ 44

✱ 20

✱ 33

C-6 Feature Table

Table C-1. — Continued

Single-
Line

MLX-
20L

Analog
Multi-
line

MLX-
1 0

MLX-
10D

MLX-
28D

Display
Label

P r o g .
CodeFeature

Directory
System Directory

(system programming)
Extension Directory

(display only)
Personal Directory

KPB

KPB

KPB
B

KPB

KPB

KPB

KPB
B

KPB

KPB

KPB

KPB

KPB
B

(display only) 
Do Not Disturb
Drop

KPB
B

KPB
B

✱ 47
✱ 773 

DoNotDistrb
Drop

Extension Status
Direct-Line
Console†

status Off

KPB

KPB

KPB

KPB

KPB

KPB

KPB

KPB

KPB

✱ 760

✱ 761

✱ 762

OparatorES,
ESOff
OperatorES,
ES1
OperatorES,
ES2

Status 1

Status 2

KPBKPB KPBTelephones
(rooms or agents)

Status 1 ES Status,
ES1
ES Status,
ES2
Feature
Btn

Forward

Status 2

Feature button

KPBKPB KPB KPB

KPB

KPB

KPB

KPBForward
Forward (inside)
Remote Call Forward

(Outside)
Group Calling
In-Queue Alarm
button

Calling group
supervisor

Available (ES
Status 2)
Unavailable (ES
Status Off)

Calling group
members

Sign in (Available)
After-call work state

(CMS only)

KPB

KPB

KPB

KPB

KPB

KPB

KPB

✱ 22 + calling
group ext. no.

Group Call

✱ 762

✱ 760

OperatorES,
ES2
OperatorES,
ES Off

KPB

✱ 44

✱ 45

ES Status,
ES2
ES Status,
ES1

K Key mode† Operator console
P PBX mode
R Behind Switch mode
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Table C-1. — Continued

Single-
Line

Analog
Multi-
l i n e

M L X -
1 0

Feature
Group Page Auto
Dial button

KPB   KPB

Headset
Auto Answer
Hang Up‡
Mute (Headset/Handset)
status

Intercom buttons
Assign buttons‡

Originate Only
Change type of
Intercom button
Ring

KPB

(factory-set type is Ring)
Intercom

Voice

Last Number Dial
Messaging

Leave Message
Message LED off
Posted Message
Send/Remove†
Message

Receiving messages:
Delete Message*
Next Message*
Return Cal*
scroll*

Night Service†
Notify

Send
Receive

Park
Park Zone Auto Dial†

Personal Speed Dial

Personalized Ringing

†
‡

Operator console

Ping.
Code
✱ 22 + paging
group ext. no.

✱ 780
✱ 781
✱ 783
✱ 782

✱ 16
✱ 18

✱✱ 19

✱ 19

✱ 84

✱ 25
✱ 54
✱ 751
✱ 38

✱ 26
✱ 28
✱ 27
✱ 29

✱ 39

✱ 757 + ext. no.
✱ 758 + ext. no.
✱ 86
✱ 22 + park
zone
# + 01-24 +
✱ 21 + tel. no.
+ #

✱ 32 + ring
(1-8)

Centralized Telephone Programming only
Display telephones only.

Display
Label
Group Page

Hdset
Auto Answer
Hang Up
Mute
Status

SysAccess
SyAcc-00

Voice Annca,
Place Ring
Voice Annce,
Place Voice
LastNumDial

Leave Msg

Posted Msg
Send/RmvMsg

Messages
Delete Msg
Next Msg
Return Call

Night Srvc

Notify
Send
Receive

Park
Park Zone

PersonalRnq,
Pattern #1...
Pattern # 8

KPB KPB

KB KB

KB
KB

KP KPB KPB

KPB KPB KPB
KPB KPB
KPB  KPB
KPB

KPB
KPB
KPB
KPB

KPB
KPB KPB

MLX- MLX-
10D 28D

KPB KPB

KB KB

KPB KPB

KPB
KPB
KPB

KPB
KPB
KPB

KPB
KPB
KPB
KPB

KPB
KPB
KPB

KPB
KPB KPB

KP KPB KPB KPB KPB

KPB KPB

KP KPB KPB KPB

KPB KPB KPB KPB

 K Key mode

MLX-
20L
KPB

KPB

KB

KPB

KPB
KPB
KPB
KPB

KPB
KPB
KPB

KPB
KPB

KPB
KPB

KPB

P PBX mode
B Behind Switch mode

* Programming codes are used
with analog multiline telephones
only; MLX telephones use display.
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Table C-1. — Continued

Display
LabelFeature

Analog
Multi-
line
KPB

KPB
KPB
KPB

KPB

KPB

P

Prog.
Code

Single-
Line
KP

KP

KPB

P

MLX-
10
KPB

KPB
KPB
KPB

KPB

MLX-
10D
KPB

KPB
KPB
KPB

KPB

KPB

P

MLX-
28D
KPB

KPB
KPB
KPB

KPB

MLX-
20L
KPB

KPB
KPB
KPB

KPB

Pickup Pickup
General
Extension
Line
Group

General use
Specific extension

✱ 9
✱ 9 + ext. no.
✱ 9 + line no.
✱ 88

Specific line
Group

Privacy
Recall
Reminder Service

Set
Cancel
Missed†

Ringing/Idle Line
Preference
Cancel

✱ 31
✱ 775

Privacy

Recall
Reminder
Set
Cancel
Missed

✱ 81
✱✱ 81
✱ 752
✱ 343

✱ 344

Line Prefer,
On
Line Prefer,
Off

Ringing Options
Individual Lines

Immediate Ring
Delay Ring
No Ring

All Lines
Immediate Ring
Delay Ring
No Ring

Abbreviated Ring
On
Off

Send Ring (Shared SA)
On
Off

Saved Number Dial
Send/Remove Message†

Ring Options
One Line
Immed Ring
Delay Ring
No Ring
All Lines
Immed Ring
Delay Ring
No Ring
Abbreviated
On
Off
SharedSARng
On
Off

SaveNumDial

KPBKPB

P

KPB

KPB

KPB
✱ 37
✱ 36
✱ 35

✱ 347
✱ 346
✱ 345

✱ 341
✱ 342

✱ 15
✱✱ 15
✱ 85
✱ 38
✱ 23 + ext. no.

P P

KPB KPB KPB
KPB KPB

KPB
Send/RmwMsg KPB

KPB KPB  KPB  KPBSignaling (manual) Signal

P PBX mode† Operator console
K Key mode
B Behind Switch mode
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Table C-1. — Continued

Feature
System Access buttons
Assign buttons‡

System Access
Originate Only
Shared System Access

Change type of System
Access button

Ring

Voice

System Speed Dial
Transfer Transfer

Voice AnnceVoice Announce

On
Off

Prog.
Code

✱ 16
✱ 18
✱ 17 + primary
ext. no.

✱✱ 19

✱ 19

✱ 24 + code (600-729)
✱ 774

✱ 10
✱✱ 10

‡ Centralized Telephone Programming only

Telephone Programming

Display
Label

SysAccess
SysAcc-00
ShareSysAcc

Voice Annce,
Place, Ring
Voice Annce,
Place , Voice
SysSpeedD1

Receive
On
Off

Single-
Line

P
P
P

KP

Analog
Multi-
line
P

KPB
B
KPB

MLX-
10
P

KPB
B
KPB

MLX-
10D
P

KPB
B
KPB

MLX-
28D
P

KPB
B
KPB

MLX-
20L
P

KPB
B
KPB

K Key mode
P PBX mode

 B Behind Switch mode

The following describes how to program features on MLX and analog mutliline
telephones. Since Personal Speed Dial is the only feature that single-line
telephone users can program, general programming instructions for single-
Iine telephones are not provided.

NOTE:
Features
Features

cannot be programmed on QCCs in system operator positions.
assigned to these consoles are fixed and cannot be changed.
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General Feature Use and Telephone Programming

Programming Methods

Telephones can be programmed by dialing programming codes or, on MLX
display phones, selecting features from the display. An analog multiline
telephone cannot be programmed by selecting features from the display.

To program a telephone, first enter programming mode:

■    On analog multiline telephones, slide the Test/Program (T/P) switch on
the side of the telephone to P, or lift the handset, or press
Speakerphone and dial #00.

■    On MLX-10 telephones, press the Feature button and dial

■    On MLX display telephones, use the same procedures as the MLX-10
or enter programming mode by selecting  Ext Program from the
menu screen on the display.

See the appropriate user or operator guide for more information.

NOTE:
Features can also be programmed onto individual telephones through
Centralized Telephone Programming. The steps for using programming
codes vary depending on the telephone. Tables C-2 through C-4 list the
basic steps for programming each telephone type.
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General Feature Use and Telephone Programming

Table C-2.  Programming Analog Multiline Telephones

Step Action
1 Label the button. ■

Note: Skip this step if the
feature will not be programmed
onto a button.

■

■

■

■

2 Begin programming.

3 Select the feature.

4 End programming.

Remove the clear label cover from the
telephone by the inserting the end of a
paper clip in the notch at the top of the
cover.
Write the feature name on the card next
to the button to be programmed.
Replace the cover.

Slide the T/P switch on the side of the
telephone to P.

Press the button you labeled.
If you have a display, it shows the name
of the feature currently programmed on
the button. If no feature is
programmed, the display indicates that
the button is blank.

Note: If the feature does not get
programmed onto a button, press any
line button. This does not affect the
button in any way.

Dial the programming code.
The feature is programmed.

Slide the T/P switch to the center
position.

■
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General Feature Use and Telephone Programming

Table C-3.  Programming MLX-10 Telephones

Step Action

1 Label the button. ■    Remove the clear label cover from the
Note: Skip this step if the telephone by pulling up on the tab that
feature will not be programmed extends from the top of the cover.

onto a button.
■    Write the feature name on the card next

to the button to be programmed.
■    Replace the cover.

2 Begin programming. ■    Press the Feature button and dial then
00.

3 Select the feature. ■    Press the button you labeled.

Note: If the feature does not get
programmed onto a button, press any
line button. This does not affect the
button in any way.

■    Dial the programming code.
The feature is programmed

4 End programming. ■    Press the Feature button and dial *00.
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General Feature Use and Telephone Programming

Table C-4.  Programming MLX Display Telephones Using the Display

Step Action
1 Label the button to be

programmed.
Note: Skip this step if the
feature will not be programmed
onto a button.

2 Begin programming.

3 Identify the button to be
programmed.

To delete the feature currently
programmed on the button:

■    Remove the clear label cover from the
telephone by pulling upon the tab that
extends from the top of the cover.

Write the feature name on the card next
to the button to be programmed.
Replace the cover.

Press Menu.

Select Ext Program from the display.
Select Start from the display.

Press the button you labeled.
Note: If the feature does not get
programmed onto a button, press any
line button. This does not affect the
button in anyway.

The display identifies the feature
currently programmed on the button. If
no feature is programmed, the display
indicates that the button is blank.

Select Delete from the display. The
button is now blank.
Press the button you labeled again to
continue programming.

Note: If the currently programmed
feature was not deleted from the button,
the new feature programmed onto it will
replace it.
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Table C-4. — Continued

Step Action

To continue programming: Select List Feature from the

4 Select the feature.

If the feature name is on the
display:

If the feature name is not on the
display:

To move through the list of
features

or

To jump
displays

page by page,

to the screen that
the feature name,

5 Respond to any additional
prompts on the display.

display.
The screen lists feature names in
alphabetical order.

Press the button next to or below the
name of the feature to be programmed.

Press More.

Select Find Feature from the
display.
Select the range of letters from the
display that corresponds to the first
letter of the feature name (for example,
if the feature begins with A, select ABC).
If the feature is not displayed on the
page that you jumped to, press More.

When you find the feature you want,
press the button next to or below it.

Select appropriate prompt (for example,
select On or Off to turn Inside
Coverage on or off), and/or enter
required information (for example, dial 0
phone number for Auto Dial).

Select Enter.
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General Feature Use and Telephone Programming

Table C-4. — Continued

Step Action
6 End programming.

To return to the Home screen: ■   Press Home or lift and replace the
handset.

To return to the Menu screen: ■    Press Menu.

NOTE:
MLX display telephones can also be programmed using the method
described for MLX-10 telephones. For example, the programming mode
can be entered by pressing the Feature button and dialing 00, then
referring to the display to continue the programming process. Or, enter
programming via the display and then dial a programming code to select
the feature rather than selecting it from the display.
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Button Diagrams D
This appendix contains the button diagrams for Hybrid/PBX systems as well
as button diagrams for Key and Behind Switch systems.
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Button Diagrams

3

2

8

7

6

5

4

1 3

1 2

1 1

1 0

9

18

17

16

15

14

28

SA Orig. 20Only   1

SA
Ring
SA
Ring

Figure D-1.  MLX Telephone Button Diagram (Hybrid/PBX Mode)
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Button Diagrams

34  BUTTON

22 BUTTON

10 BUTTON

5 BUTTON

❑
❑

❑
❑

❑
❑

❑
❑

❑
❑

❑
❑

❑
❑

❑
❑

❑
❑

SA ❑
❑

❑
❑

❑
❑Orig Only

❑
❑

S A ❑
❑

❑
❑

❑
❑Voice

❑

❑
S A ❑

❑
❑
❑

❑
❑R i n g

❑
❑

❑
❑

❑
❑

❑
❑

❑
❑

❑
❑

❑
❑

❑
❑

❑
❑

❑
❑

❑
❑

❑
❑

❑
❑

❑
❑

Figure D-2.  Analog Multiline Telephone Button Diagram (Hybrid/PBX
Mode)
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28

20

Icom
Voice

Icom
Ring

10

Key Mode:
Up to 8 personal line
buttons are assigned
beginning at button 3.

Behind Switch Mode:
One prime line button
is assigned to button 3.

Figure  D-3. MLX Telephone Button Diagram (Key and Behind Switch
Mode)
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34 BUTTON

22 BUTTON

10 BUTTON

5 BUTTON

❑
❑

❑

❑
❑  ❑
❑  ❑

❑
❑

❑
❑

❑  ❑
❑  ❑

❑
❑

❑

❑
❑  ❑
❑  ❑

❑
❑

Icom
Voice

❑
❑

❑  ❑
❑  ❑

❑

❑
Icom
Ring

❑
❑

❑  ❑
❑  ❑

❑  ❑
❑  ❑

❑  ❑
❑  ❑

❑  ❑
❑  ❑

❑  ❑
❑  ❑

❑  ❑
❑  ❑

❑  ❑
❑  ❑

❑  ❑
❑  ❑

Key Mode:
Up to 8 Personal line
buttons are assigned
beginning at button 3.

Behind Switch Mode:
One prime line button
is assigned to button 3.

Figure D-4.  Analog Multiline Telephone Button Diagram (Key and Behind
Switch Mode)
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Sample Reports E
This appendix includes samples of the print reports
communications system. Table E-1 lists the system
this appendix where samples can be found.

Table E-1.  Report Contents

generated by the
reports and the pages in

For... See...

System Information Report
Dial Plan Report
Label Information Report
Tie Trunk Information Report
DID Trunk Information Report
GS/LS Trunk Information Report
General Trunk Information Report
DS1 Information Report
PRI Information Report
Remote Access (DISA) Information Report
Operator Information Report
Allowed Lists Report
Access to Allowed Lists Report
Disallowed Lists Report
Access to Disallowed Lists Report

E-7
E-9
E-11
E-12
E-13
E-14
E-15
E-16
E-17
E-19
E-20
E-22
E-23
E-24
E-25

Continued on next page
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Sample Reports

Table E-1. - Continued

For...
Automatic Route Selection Report
Extension Directory Report
System Directory Report
Group Paging Report
Extension Information Report
Group Coverage Information Report
Direct Group Calling Information Report
Night Service Information Report
Group Call Pickup Report
Error Log Report

See...
E-26
E-28
E-29
E-30
E-31
E-33
E-34
E-35
E-36
E-37

Table E-2 lists all of the system reports and includes: the print menu option
used to print each report; the report name; and a brief description of each
report.

The menu options referred to in Table E-2 are accessed by selecting the
Print option on the System Programming menu. Refer to the “Print Reports”
section of this guide for details on the Print option.

E-2 Sample Reports



Sample Reports

Table E-2.  System Reports

Menu Option Report Name Description
All

SysSet-up

Dial Plan

Labels

Trunk Info

TIE

DID

Loop/
Ground

General

T1 Info

System Information

Dial Plan

Label Information

TIE Trunk Information

DID Trunk Information

GS/LS Trunk Information

General Trunk
Information
DS1 Information

Prints each of the reports available on the
Print menu, from SysSet-up to Error Log.

Note: When All is selected, the four Trunk
Information reports automatically print. See
Trunk Info.

System-wide information such as return
intervals, system mode, system
programming port, slot assignments, etc.

Extensions assigned to pools, paging
zones, calling groups, lines or trunks, and
stations; labels for lines/trunks and stations.
Labels assigned to stations Posted
Messages, and names and telephone
numbers included in MLX-20L user’s
Personal Directory.

Select to display four trunk options: TIE,
DID, Loop/Ground, General.
Extensions assigned to and signaling
attributes associated with TIE trunks.
Extensions assigned to and signaling
attributes associated with DID trunks.
Extensions assigned to and signaling
attributes associated with Ground- and
Loop-Start trunks.
All identified extensions and feature-related
attributes of each extension.
Options (line, signal, etc.) assigned to T1
trunks or lines.

Continued on next page
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Sample Reports

Table E-2 - Continued

Menu Option Report Name Description

PRI Info PRI Information PRI trunks/lines assigned to B-channel

Rmote Remote Access (DISA)
Access Information

Oper Info Operator Information

AllowList Allowed Lists

AllowListTo Access to Allowed Lists

DisallowLst Disallowed Lists

DisallowTo Access to Disallowed
Lists

groups.

Remote access dial code, class of
restriction, barrier code information.
For each system operator position; the
logical ID, extension number, Iabel, type
(DLC or QCC); all general system operator
options, such as backup position, etc.; call
types and priorities.
Telephone numbers included in Allowed
Lists. Lists are numbered 0 – 7, and entries
are numbered 0 – 9.
Lists are numbered 0 – 7. If the Allowed
List is assigned to Remote Access users
and barrier codes are used, the barrier
codes are numbered 0 – 16. If no barrier
codes are used, 17 means the Allowed List
is assigned to tie-trunk users, and 18
means the Allowed list is assigned to non-
tie-trunk users.
Telephone numbers included in Disallowed
Lists. Lists are numbered 0 – 7, and entries
are numbered 0 – 9.
Telephones to which Disallowed Lists are
assigned. Lists are numbered 0 – 7. If the
Disallowed List is assigned to Remote
Access users and barrier codes are used,
the barrier codes are numbered 0 – 16. If
no barrier codes are used, 17 means the
Disallowed List is assigned to tie-trunk
users, and 18 means the Disallowed list 

Continued on next page
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Sample Reports

Table E-2, - Continued

Menu Option Report Name Description

ARS

Ext Direct

Sys Direct

Group Page

Ext Info

Automatic Route
Selection

Extension Directory

System Directory

Group Paging

Extension Information

GrpCoverage Group Coverage
Information

assigned to non-tie-trunk users.
Access code; table types with area codes
and exchanges; routes for subpatterns A
and B, FRL, absorb digit, delete digit, Dial
0, and N11 tables.
Slot/port addresses, extensions, labels and
feature-related attributes. Column headings
are printed on the first page only and are 
not carried over to subsequent pages.
Column headings 4 through 10 (and 14
through 20) should be read vertically. That
is: FACE (Forced Account Code Entry);
HBIS (HFAI/BIS); RCFW (Remote Call
Forward); MICD (Microphone Disable); SIG
(Voice Signal); RSTR (Calling Restrictions);
ARSR (ARS Restriction Level).

System Speed Dial number, label and
telephone number in System Directory, and
whether number should display.
Extension number for each group and the
extension number of each telephone
assigned to the group.
For each specified extension, type of
equipment connected, features assigned to
station, and features assigned to each
button on the station.
Extension number for each group and the
extension number for each telephone
assigned to the group. Information is
printed only for calling groups with
members and/or lines/trunks assigned.

Continued on next page
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Sample Reports

Table E-2. - Continued

Menu Option Report Name Description

Grp Calling   Direct Group Calling Group calling options (hunt, type, message
Information waiting, station, etc.), the extension number

for each telephone assigned to the group,

Night
Service

Call Pickup

Error Log

and the lines or trunks assigned to the
group.

Night Service The operator, password required, time-of-
Information day, and Emergency Allowed List extension

numbers.

Group Call Pickup Extension numbers for telephones assigned
to each group. Pickup groups are
numbered 1 – 30.

Error Log Error message and code, time and day
error occurred, frequency of error. See the
Maintenance and Troubleshooting guide.
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Sample Reports

System Reports

System Information Report

Print Menu Option: Sys Set-up

SYSTEM INFORMATION

Current Date: 01/04/00

Current Time: 00:21:15

System : Mode AutoMaintBusy
.. Hybrid/PBX Disable

Language: SystemLang SMDR

English English

Direct Line Operators ..

Queued Call Operators ..

SysProg Port ..

Transfer : Type Audible

:  Ring MusicOnHold

VMS Transfer Return Interval :

Paging System Lines ..

Music On Hold Line ..

Camp On Time ..

Call Park Return Time ..

Delay Rings ..

Coverage Delay ..

Auto Callback Rings ..

Extension Status (ESS) ..

ESS Operators ..

14

10

10

AutoBusyTie

Disable

Printer

English

18 22 42

Password : craft

OneTouch (Complete) ReturnTimer

Transfer(Auto) 5 rings

4

804

90 sec

180 sec

2

3

3

Group Call / CMS
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System Information Report - Continued

SMDR: Min. CallTime

40 sec:

Intercom Dial Tone

Reminder Service Cancel

Behind Switch Code

Recall Timer

Rotary Line Cut Through

Unassigned Extension

slot # 1:

slot # 2:

slot # 3:

slot # 4:

slot # 5:

slot # 6:

slot # 7:

slot # 8:

slot # 9:

slot # 10:

slot # 11:

slot # 12:

slot # 13:

slot # 14:

slot # 15:

slot # 16:

slot # 17:

008 MLX

408

008

408

800 GS/LS

408 GS/LS-MLX

800

008

012

408 GS/LS

008

800

800 DID

400 EM

012

008 MLX

408

Format

Basic
CallReport

In/Out

.. Inside
. .. .

. Drop Transfer Conference.

:

: 450 msec
.. Delay
.. 10

* Not Present *
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Dial Plan Report

Sample Reports

Print Menu Option: Dial Plan
Sections: Pools; Telephone Paging Zones; Direct Group

Calling Group; Lines/Trunks; Stations

DIAL PLAN FOR POOLS

POOL # 1: 70

POOL # 2: 890

POOL # 3: 891

POOL # 4: 892

POOL # 5: 893

POOL # 6: 894

POOL # 7: 895

POOL # 8: 896

POOL # 9: 897

POOL # 10: 898

POOL # 11: 899

DIAL PLAN FOR TELEPHONE PAGING ZONES

TPZ # 1: 793

TPZ # 2: 794

TPZ # 3: 795

TPZ # 4: 796

TPZ # 5: 797

TPZ # 6: 798

TPZ # 7: 799

DIAL PLAN FOR DIRECT GROUP CALLING GROUP

DGCG # 1: 770

DGCG # 2: 771

DGCG # 3: 772

DGCG # 4: 773

DGCG # 5: 774
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Sample Reports

Dial Plan Report -  Continued

DIAL PLAN FOR LINES/TRUNKS

LINE # 1: 801 OUTSIDE

LINE # 3: 803 OUTSIDE

LINE # 5: 805 OUTSIDE

LINE # 7: 807 OUTSIDE

LINE # 9: 809 OUTSIDE

DIAL PLAN FOR STATIONS

STN #: 1

STN #: 3

STN #: 5

STN #: 7

STN #: 9

STN #: 11

STN #: 13

STN #: 15

STN #: 17

STN #: 19

STN #: 21

STN #: 23

STN #: 25

STN #: 27

STN #: 29

STN #: 31

STN #: 33

STN #: 35

STN #: 37

STN #: 39

STN #: 41

.

.

STN #: 53

10

11

12

13

14

15

16

17

18

20

22

24

26

28

30

32

34

36

38

40

42

54

OPERATR

EXT 13

EXT 14

EXT 18

OPERATR

AUDIXVP

AUDIXVP

EXT 42

EXT 54

LINE # 2: 802 OUTSIDE

LINE # 4: 804 OUTSIDE

LINE # 6: 806 OUTSIDE

LINE # 8: 808 OUTSIDE

LINE # 10: 810 OUTSIDE

STN #: 2

STN #: 4

STN #: 6

STN #: 8

STN #: 10

STN #: 12

STN #: 14

STN #: 16

STN #: 18

STN #: 20

STN #: 22

STN #: 24

STN #: 26

STN #: 28

STN #: 30

STN #: 32

STN #: 34

STN #: 36

STN #: 38

STN #: 40

STN #: 42

STN #: 54

710

711

712

713

714

715

716

717

19

21

23

25

27

29

31 AUDIXVP

33 AUDIXVP

35

37

39

41

742

754 AUDIXVP
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Sample Reports

Label Information Report

Print Menu Option: Labels
Sections: Telephone Personal Directory; Posted

Messages and Numbers

LABEL INFORMATION

Executive Telephone #

Name Number

Executive Telephone #

Name Number

Executive Telephone #

Name Number

MSG #

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

10:

14:

15:

Personal Directory

Display

Personal Directory

Display

Personal Directory

Display

POSTED MESSAGE

DO NOT DISTURB

OUT TO LUNCH

AT HOME

OUT SICK

IN A MEETING

IN CONFERENCE

WITH A CLIENT

WITH A CUSTOMER

AWAY FROM DESK

OUT ALL DAY

CUSTM MSG11

CUSTM MSG12

CUSTM MSG13

CUSTM MSG14

CUSTM MSG15

CUSTM MSG16

CUSTM MSG17

CUSTM MSG18

CUSTM MSG19

CUSTM MSG20
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Sample Reports

Tie Trunk Information Report

Print Menu Option: Trunk Info and TIE

TIE TRUNK INFORMATION

TRUNK 849

Direction: 2 Way

InType : Wink

Out Type : Wink

TRUNK 850

Direction: 2 Way

InType : Wink

Out Type : Wink

TRUNK 851

Direction: 2 Way

InType : Wink

Out Type : Wink

TRUNK 852

Direction: 2 Way

InType : Wink

Out Type : Wink

Slot/Port : 14/ 1

E&M Signal: TypelS

InMode : Rotary

OutMode : Rotary

Slot/Port : 14/ 2

E&M Signal: TypelS

InMode : Rotary

OutMode : Rotary

Slot/Port : 14/ 3

E&M Signal: TypelS

InMode : Rotary

OutMode : Rotary

Slot/Port : 14/ 4

E&M Signal: TypelS

InMode : Rotary

OutMode : Rotary

TIE-PBX

Dialtone :

AnsSupvr :

Disconnect:

TIE-PBX

Dialtone :

AnsSupvr :

Disconnect:

TIE-PBX

Dialtone :

AnsSupvr :

Disconnect:

TIE-PBX

Dialtone :

AnsSupvr :

Disconnect:

Remote

300 ms

300 ms

Remote

300 ms

300 ms

Remote

300 ms

300 ms

Remote

300 ms

300 ms
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Sample Reports

DID Trunk Information Report

Print Menu Option: Trunk Info and DID

DID

Trk

A

A

A

A

A

A

A

A

TRUNK INFORMATION

SS/PP Blk

841

842

843

844

845

846

847

848

13/ 1

13/ 2

13/ 3

13/ 4

13/ 5

13/ 6

13/ 7

13/ 8

DiscTime Type ExpDig Del Dig AddDig Signal InvDest

1 500ms Wink 4 3 1 TouchTone BkupExt

1 500ms Wink 4 3 1 TouchTone BkupExt

2 500ms Wink 3 0 Rotary BkupExt

2 500ms Wink 3 0 Rotary BkupExt

1 500ms Wink 4 3 1 TouchTone BkupExt

1 500ms Wink 4 3 1 TouchTone BkupExt

2 500ms Wink 3 0 Rotary BkupExt

1 500ms Wink 4 3 1 TouchTone BkupExt
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Sample Reports

GS/LS Trunk Information Report

Print Menu Option: Trunk Info and Loop/Ground

GS/LS TRUNK INFORMATION

Trk

801

802

803

804

805

806

807

808

809

810

811

812

813

814

815

816

817

.

.

.

880

SS/PP

2/ 1

2/ 2

2/ 3

2/ 4

4/ 1

4/ 2

4/ 3

4/ 4

5/ 1

5/ 2

5/ 3

5/ 4

5/ 5

5/ 6

5/ 7

5/ 8

6/ 1

Type

Loop

Loop

Loop

Loop

Loop

Loop

Loop

Loop

Ground

Ground

Loop

Loop

Loop

Loop

Loop

Loop

Ground

OutMode

TouchTone

TouchTone

TouchTone

TouchTone

Rotary

Rotary

Rotary

Rotary

TouchTone

TouchTone

Rotary

Rotary

Rotary

Rotary

TouchTone

Rotary

Rotary

15/ 1 Ground TouchTone

RelDisc

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

N/A

N/A

Yes

Yes

Yes

Yes

Yes

Yes

N/A

Yes

ChannelUnit

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

E-14 System Reports



Sample Reports

General Trunk Information Report

Print Menu Option: Trunk Info and General

GENERAL TRUNK INFORMATION

Trk

801

802

803

804

805

806

807

808

809

810

811

812

813

814

815

816

817

SS/PP RemAccess

2/ 1

2/ 2

2/ 3

2/ 4

4/ 1

4/ 2

4/ 3

4/ 4

5/ 1

5/ 2

5/ 3

5/ 4

5/ 5

5/ 6

5/ 7

5/ 8

6/ 1

No Remote

No Remote

No Remote

No Remote

No Remote

No Remote

No Remote

No Remote

No Remote

No Remote

No Remote

No Remote

No Remote

No Remote

No Remote

No Remote

Dedicated

Pool TlPrfx

70 Yes

70 Yes

70 Yes

Yes

Yes

Yes

Yes

Yes

890 Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

HldDisc Principal QCC Prty QCC Oper

Long 4

Long 4

Long 4

Long 4

Long 4

Long 4

Long 4

Long 4

Long 4

Long 4

Long 4

Long 4

Long 4

Long 4

Long 4

Long 4

Long 4

10

42
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Sample Reports

DS1 Information Report

Print Menu Option: T1 Info

DS1 SLOT ATTRIBUTES

Slot Type Format Supp Signal LineComp ClkSync Src Active

3 T1 D4 ZCS Rob_Bit 1 Prim Loop Yes

3 T1 D4 ZCS Rob_Bit 1 None Local Yes
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PRI Information Report

Print Menu Option: PRI Info

Sections: Network Selection, Special Service, Call-by-Call
and Dial Plan Routing Tables; PRI Information

PRI INFORMATION

System: By line

BchnlGrp #: Slot: TestTelNum: NtwkServ: Incoming Routing:

1 9 00011 By Line Appearance

Channel ID: 1

Line PhoneNumber NumberToSend

Network Selection Table

Entry Number: 0 1

Pattern to Match: 101**** 10***

Special Service Table

Entry Number: 0 1 2

Pattern to Match: 011 010 01

Operator: none none OP

Type of Number: I I I

Digits to Delete: 3 1 3

Call-By-Call Service Table

Entry Number: 0 1

Pattern 0: 777

Pattern 1: 212555

Pattern 2: 212

Call Type: BOTH BOTH

NtwkServ: No Service

DeleteDigits: 0 1

Entry Number: 5 6

Call Type: BOTH BOTH

NtwkServ: No Service

DeleteDigits: 0 0

2

101****

3 4

00 0

OP OP/P

N N

2 1

2

BOTH

2

7

BOTH

00111

0

3

5 6 7

1

none none none

I I N

1 0 0

3 4

BOTH BOTH

OUT WATS

0 0

8 9

BOTH BOTH

0 0
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ReportsSample

PRI Information Report - Continued

Dail Plan Routing Table

Entry Number:

NtwkServ:

Expected Digits: 0

Pattern to Match:

Digits to Delete: 0

Digits to Add:

0 1 2

OUT WATS Any service

0 11

222

1 0

22

3

11100

0

0

6 75Entry Number 4

NtwkServ: 11100

Expected Digits: 2

Pattern to Match: 2

Digits to Delete: 0

Digits to Add: 2

1 0 0

1 2 0

10 11Entry Number: 8 9

PRI INFORMATION

NtwkServ:

Expected Digits: 0

Pattern to Match:

Digits to Delete: 0

Digits to Add:

0 0

0

0

00

15

0

13

0

14

0

Entry Number: 12

NtwkServ:

Expected Digits: 0

Pattern to Match:

Digits to Delete: 0

Digits to Add:

0 0 0
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Sample Reports

Remote Access (DISA) Information Report

Print Menu Option: Rmote Access
Sections: General Options; System Default Class of

Restrictions (Non-TIE); System Default Class of
Restrictions (TIE); Barrier Code Administration

GENERAL OPTIONS (ACCESS CODE 889)

Barrier Code required for Non-TIE DISA lines: Yes
Barrier Code required for TIE DISA lines : No
Automatic Queuing enabled for DISA lines : Yes

SYSTEM DEFAULT CLASS OF RESTRICTIONS (NON-TIE)

Restriction .. UNRESTRICTED
ARS Restriction Level: 3
Allowed Lists ..
Disallowed Lists :

SYSTEM DEFAULT CLASS OF RESTRICTIONS (TIE)

Restriction .. UNRESTRICTED
ARS Restriction Level: 3
Allowed Lists ..
Disallowed Lists :

BARRIER CODE ADMINISTRATION

Barrier Code number :
Barrier Digits ..
Restriction ..
ARS Restriction Level:
Allowed Lists ..
Disallowed Lists :

Barrier Code number :
Barrier Digits ..
Restriction ..
ARS Restriction Level:
Allowed Lists ..
Disallowed Lists :

Barrier Code number :
Barrier Digits ..
Restriction ..
ARS Restriction Level:
Allowed Lists ..
Disallowed Lists :

1
2468
OUTWARD RESTRICTED
3

2
1234
UNRESTRICTED
3

16
9876
OUTWARD RESTRICTED
0
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Sample Reports

Operator Information Report

Print Menu Option:
Sections:

OPERATOR POSITIONS

PORT
ADDR. EXT # LABEL
----- ---------- ----— =======

1/ 1 10 OPERATR
1/ 5 14 EXT 14
2/ 1 18 EXT 18
2/ 5 22 OPERATR
6/ 1 42 EXT 42

GENERAL OPTIONS

Oper Info
Operator Positions; General Options; DSS
Options; QCC Operator Options; QCC Call
Types

CALL ALERT
TYPE (QCC ONLY)
---—---- ===== =====
QCC No
DLC N/A
DLC N/A
DLC N/A
DLC N/A

Length of hold reminder timer: 60 sec
DLC Automatic hold enabled : No

DIRECT STATION SELECTOR (DSS) OPTIONS"

BUTTON FIRST
NUMBER DIAL CODE
- - - - -- - - - - = = = = =

1 0
2 50
3 100

Operator Call Park codes: 881 882 883 884 885 886 887 888

QCC OPERATOR OPTIONS
Listed Directory Number for queue : 800
Held calls return to queue : No

Automatic hold enabled : No

Calls-in-queue alarm threshold : 0

Time until priorities are elevated: 0 sec
Message Center Operators :
One Touch Extend : AUTOMATIC

Rings before extended calls return: 4
Backup operator station. :
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Sample Reports

Operator Information Report - Continued

QCC CALL TYPES:
CALL TYPE

-------------------—----------------------------
Dial O Operator
Follow Forward
Unassigned DID
Listed Directory Number
Operator’s Extension
Returning
Group Coverage

Group # 1
Group # 2
Group # 3
Group # 4
Group # 5
Group # 6
Group # 7
Group # 8
Group # 9
Group # 10
Group # 11
Group # 12
Group # 13
Group # 14
Group # 15
Group # 16
Group # 17
Group # 18
Group # 19
Group # 20
Group # 21
Group # 22
Group # 23
Group # 24
Group # 25
Group # 26
Group # 27
Group # 28
Group # 29
Group # 30

PRIORITY OPERATORS
----------------======== ----------------

4 10
4 N/A
4 10
4 10
4 N/A
4 0

4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
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Allowed Lists Report

Print Menu Option: AllowList
Sections: Lists 1 through 7

ALLOWED LISTS

List : 0

Entry

Entry

Entry

Entry

Entry

Entry

Entry

Entry

Entry

Entry

.

.

.

0:

1:

2:

3:

4:

5:

6:

7:

8:

9:

List : 7

Entry

Entry

Entry

Entry

Entry

Entry

Entry

Entry

Entry

Entry

E-22

0:

1:

2:

3:

4:

5:

6:

7:

8:

9:

------

------

------

-----

------

------

------

------

------

------

------

------

------

------

------

------

------

------

------

------
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Access to Allowed Lists Report

Print Menu Option: AllowList To

ACCESS TO ALLOWED

FOR REMOTE

List 1

List 3

ACCESS

STNS

RACC

STNS

RACC

LISTS

17 & 18 MEAN TIE & NON-TIE RESTRICTIONS

10

1

33

17 18
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Disallowed Lists Report

Print Menu Options: DisallowLst
Sections: Lists 1 through 7

DISALLOWED LISTS

List : 0

Entry

Entry

Entry

Entry

Entry

Entry

Entry

Entry

Entry

Entry

.

.

.

0:

1:

2:

3:

4:

5:

6:

7:

8:

9:

----------

----------

List : 7

Entry

Entry

Entry

Entry

Entry

Entry

Entry

Entry

Entry

Entry

o:

1:

2:

3:

4:

5:

6:

7:

8:

9:

----------

----------

----------

----------

------------

----------

----------

----------

----------

----------

----------

----------

----------
----------

----------

----------

----------

----------
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Access to Disallowed Lists Report

Print Menu Option: DisallowTo

ACCESS TO DISALLOWED LISTS

FOR REMOTE ACCESS 17 & 18 MEAN TIE & NON-TIE RESTRICTIONS

List 1 STNS 33

RACC 9

List 3 STNS 33

RACC

System Reports E-25



Sample Reports

Automatic Route Selection Report

Print Menu Option: ARS
Sections: Tables

AUTOMATIC ROUTE SELECTION

ARS IS: ACTIVE ACCESS CODE:

TABLE 17: Default Toll Output Table

9

FRL

3

Pool Absorb

1)70-- 00

2)---- --
3)---- --

4)---- --

5)---- --

6)---- --

Pool Absorb

1)70-- 00

2)---- --

3)---- --

4)---- --

5)---- --

6)---- --

Other Digits Call type

BOTH----------------------
----------------------

Start

--:--

--:--

----------------------- -----

Pattern

A

A

A

A

A

A

Pattern

B

B

B

B

B

B

-----

--:--

--:--

--------------------

--------------------

--------------------

-----

-----

--:--

--:--

Start

--:--

-----

Other Digits Call type

BOTH

FRL

3--------------------

--:---------------------- -----

-----------------------
---------------------

-----

-----

-----

-----

--:--

FRL

3

--:--

--:----------------------

-------------------- --:--

TABLE 18: Default Local Output Table

Pool Absorb Other Digits

1)70-- 00 --------------------

2)---- -- --------------------

Call type

BOTH

Start Pattern

A

A

A

A

A

A

Pattern

B

B

B

B

B

--:--

--:--

--:--

--:--

--:--

--:--

-----

3)---- -- -------------------- -----

-----

-----

-----

4)---- -- --------------------

5)---- -- --------------------

FRL

3

6)---- -- --------------------

A Pool Absorb Other Digits

1)70-- 00 --------------------

2)---- -- --------------------

3)---- -- --------------------

Call type

BOTH

-----

Start

--:--

--:--

--:-------

4)---- -- -------------------- --:--

--:--

-----

5)---- -- -------------------- -----
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Automatic Route Selection Report - Continued

TABLE 19: Dial 0 Output Table

A Pool Absorb Other Digits

1) 70-- 00 --------------------

TABLE 20: N11 Output Table

01)411 02)611 03)811 04)911

Pool Absorb Other Digits

1) 70-- 00 --------------------

1) 70-- 00 --------------------

3

FRL

3

3

FRL

BOTH

Call

BOTH

BOTH

Call type Start Pattern
--:-- A

type Start Pattern

--:-- A

--:-- A
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Extension Directory Report

Print Menu Option: Ext Direct

EXTENSION DIRECTORY

Port

Addr

1/ 1

1/ 2

1/ 3

1/ 4

1/ 5

1/ 6

1/ 7

1/ 8

2/ 1

2/ 3

2/ 5

2/ 7

3/ 1

3/ 3

3/ 5

3/ 7

4/ 1

4/ 3

4/ 5

4/ 7

6/ 1

.

.

.

7/ 1

Ext # Label F H R M V R A

A B C I S S R

C I F I T S

E S W D G R R

10

11

12

13

14

15

16

17

18

20

22

24

26

28

30

32

34

36

38

40

42

OPERATR

EXT 13

EXT 14

EXT 18

OPERATR

AUDIXVP

AUDIXVP

AUDIXVP

EXT 42

N N N N

N N N N

N N N N

N N N N

N N N N

N N N N

N N N N

N N N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N N N N

54 EXT 54  N N N N

U 3

O 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

Port

Addr

1/21

1/22

1/23

1/24

1/25

1/26

1/27

1/28

2/ 2

2/ 4

2/ 6

2/ 8

3/ 2

3/ 4

3/ 6

3/ 8

4/ 2

4/ 4

4/ 6

4/ 8

6/21

7/2

Ext # Label

710

711

712

713

714

715

716

717

19

21

23

25

27

29

31

33

35 AUDIXVP

37

39

41

742

754

F H R M V R A

A B C I S S R

C I F C I T S

E S W D G R R

N N N N

N N N N

N N N N

N N N N

N N N N

N N N N

N N N N

N N N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N Y N N

N N N N

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

U 3

N N N N   U3
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System Directory Report

Print Menu Option: Sys Direct

SYSTEM DIRECTORY

Code Name

600 ABC Company

601 Jacques Smith

605 Travel Agency

Number

555-9999

5551212

912015556677

Display

YES

YES

YES
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Group Paging Report

Print Menu Option: Group Page

GROUP PAGING

Group # 793 STNS : 20 21 22 23 24 25

Group # 794 STNS : 15 16 17 18 19
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Extension Information Report

Print Menu Option: Ext Info plus extension number

EXTENSION INFORMATION

Extn SS/PP Type

10 1/ 1 MLX-20L + 1 DSS

Pool Access :

Page Group :

Primary Coverage :

Secondary Coverage :

Coverage Group :

Group Coverers :

NS Groups :

Group Calling Member:

Pickup Groups :

Allowed Lists :

Disallowed Lists :

Restrictions :

Auto Callback :

Call Waiting :

Abbreviated Ring :

Line Preference :

Shared SA Ring :

Receive Voice Calls :

Coverage Inside :

Forwarding to :

ARS Restriction :

Forced Account Code :

Microphone Disable :

Remote Forward Allow:

NS Exclusion :

Voice Announce Pair :

Voice/Data Pair :

BIS/HFAI :

Language :

70 890 891 892 893 894 895 896 897 898 899

5

773

10

UNRESTRICTED

OFF

ON

ON

ON

ON

ON

OFF

3

No

No

No

No

No

No

No

English
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Extension Information Report - Continued

EXTENSION INFORMATION

Extn
10

Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button
Button

SS/PP
1/ 1

34
33
32
31
30
29
28
27
26
25
24
23
22
21
20
19
18
17
16
15
14
13
12
11
10
9
8
7
6
5
4
3
2
1

Type
MLX-20L + 1 DSS

Blank
Blank
Blank
Blank
Blank
Blank
Blank
Blank
Blank
Blank
Blank
Blank
Blank
Blank
Forced Release
Pool Inspect
Headset Auto Answer
Join
Cancel
Alarm Status:
Night Service
Headset Status
Destination
Release
Position Busy
Send/Remove Message
Handset/Headset Mute
Source
Start
Call 5
Call 4
Call 3
Call 2
Call 1

Status None
Status None
Status None
Status None
Status None
Status None
Status None
Status None
Status None
Status None
Status None
Status None
Status None
Status None
Status None
Status None
Status Off
Status None
Status None
Status Off
Status Off
Status Off
Status None
Status None
Status Off
Status None
Status Off
Status None
Status None
Status None
Status None
Status None
Status None
Status None
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Sample Reports

Group Coverage Information Report

Print Menu Option: GrpCoverage

GROUP COVERAGE INFORMATION

Group # 2 Senders : 6802 6804

Group # 5 Senders : 10     11     12     13     14     18     19     20     42
44 45 47 6810

DIRECT GROUP CALLING INFORMATION

Group # : 770 Group Type : AutoLogout

Call Distribution Type : CIRCULAR

Delay Announcement Ext # : 11
Message Waiting Station : 20

Calls_in_queue Threshold : 1
External Alert ext # : 21

Overflow Threshold : 1

Overflow to DGC group # :

Group Coverage : 1

No. EXT # LABEL

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20

System Reports E-33



Sample Reports

Direct Group Calling Information Report

Print Menu Option: Grp Calling
Sections: Each programmed group

DIRECT GROUP CALLING INFORMATION

Group # : 782 Group Type : AutoLogout

Call Distribution Type : CIRCULAR

Delay Announcement Ext # :

Message Waiting Station :

Calls_in_queue Threshold : 1

External Alert ext # :

Overflow Threshold : 1

Overflow to DGC group # :

Group Coverage : 1

No. EXT # LABEL

1 12

2 13

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

LINES:
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Sample Reports

Night Service Information Report

Print Menu Option: Night Service

NIGHT SERVICE INFORMATION

OPERATOR

OPERATOR

OPERATOR

OPERATOR

Password

Current Day

Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

OPERATOR 10

14

18

22

42

..

: OFF

DGCG
STNS

DGCG
STNS

DGCG
STNS

DGCG
STNS

DGCG
STNS

#:
.. 10

#:
.. 14

#:
.. 18

#:
.. 22

#:
.. 42

Turn off at:
..
..
..
..
..
..
..

Emergency Allowed List:
0)
1)
2)
3)
4)
5)
6)
7)
8)
9)

NS Excluded STNS:
61 62 63 64 65

Turn on at:
..
..
..
..
..
..
..
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Sample Reports

Group Call Pickup Report

Print Menu Option: Call Pickup

GROUP CALL PICKUP

Group # 1 STNS : 10 11 12 13 14 15 16

Group # 2 STNS : 17 18 19 20

Group # 3 STNS : 21 22 23 24 25 26 27 28 29 30

Group # 4 STNS : 31

Group # 5 STNS : 32

Group # 6 STNS : 33

Group # 7 STNS : 34

Group # 8 STNS : 35

Group # 9 STNS : 36

Group # 10 STNS : 37
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Error Log Report

Sample Reports

Print Menu Option:

ERROR LOG

Last 10 System Errors:

Message

PRI SVC AUDIT TIMEOUT

TIMEOUT COLD START

PRI SVC AUDIT TIMEOUT

TIMEOUT COLD START

PRI SVC AUDIT TIMEOUT

PRI SVC AUDIT TIMEOUT

SOFTWARE COLD START

SOFTWARE COLD START

PRI SVC AUDIT TIMEOUT

SOFTWARE COLD START

Error Log

ss/pp

00/00

00/00

00/00

00/00

00/00

00/00

00/00

00/00

00/00

00/00

Cnt First Last Code

01/08 00:00:53 7001

01/11 00:04:08  0001

01/11 00:04:14 7001

01/21 00:22:14 0001

01/03 00:22:14 7001

01/04 00:22:14 7001

01/04 00:21:14 0003

01/04 00:21:14 0003

01/04 00:21:14 7001
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General System Programming
Sequence F
System Programming Sequence

This appendix lists the basic procedures, in the order in which they must be
performed, to program a new system. In some instances, you may need to
rearrange the system planning forms to match this order.

Basic System Operating Conditions

Select the system programming position

System → SProg Port
Select the system language

More → Language → SystemLang
Select the system mode

System → Mode
Enable Automatic Maintenance Busy

System → MaintenBusy
Set the system time

System → Time
Set the system date

System → Date

System Programming Sequence F-1



General System Programming Sequence

System Renumbering

■    Select the system numbering plan

SysRenumber → Default Numbering
■    Single renumbering

SysRenumber → Single
■    Block renumbering

SysRenumber → Block
■    DSS console page buttons

SysRenumber → Single → More → DSS Buttons

Identify System Operator Positions

■    Identify QCC system operator positions

Operator → Positions → Queued Call
■    Identify DLC system operator positions

Operator → Positions → Direct Line

Lines and Trunks

Specify type of trunk on 400 or 800 GL/LS module

LinesTrunks → LS/GS/DS1
Identify dial signaling for loop-start/ground-start trunks

LinesTrunks → TT/LS Disc → Outmode
Classify disconnect signaling reliability for loop-start trunks

Lines Trunks → TT/LS Disc → LS Disconnect
Specify toll prefix requirements

LinesTrunks → Toll Type
Specify Hold Disconnect interval

LinesTrunks → More → HoldDiscnct
Assign the QCC queue priority

LinesTrunks → More → QCC Prior
Identify QCC operator to receive calls

LinesTrunks → More → QCC Oper
Assign trunks to pools

LinesTrunks → Pools
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General System Programming Sequence

Complex Lines

■    Program DS1 trunks

LinesTrunks → LS/GS/DS1
■    Program tie lines

LinesTrunks → TIE Lines
■    Program DID trunks

LinesTrunks → DID
■    Program PRl trunks

LinesTrunks → PRI

Telephones

Many programmers prefer to program Auxiliary Equipment before
programming Telephones.

Assign trunks to telephones

Extensions → LinesTrunks
Copy trunk assignments

Extensions → Line Copy
Identify Principal User for Personal Line

LinesTrunks → More → PrncipalUsr
Assign ring, voice, outgoing only, shared buttons

More → Cntr-Prg
Copy telephone button assignments

More → Cntr-Prg
Identify analog multiline telephones with BIS or HFAI
Extensions → BIS/HFAI
Identify analog multiline telephones requiring Voice Announce to Busy

Extensions → VoiceSingl
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General System Programming Sequence

Auxiliary Equipment

■    Program Music-on-Hold

AuxEquip → MusicOnHold
■    Program loudspeaker paging

AuxEquip → Ldspkr Pg
■    Program a fax port

AuxEquip → Fax
■    Identify the jack used for maintenance alarms

AuxEquip →
■    Program Voice

AuxEquip →

MaintAlarms
Mail and Automated Attendant

VMS/AA → TransferRtn

Print Reports

■ Print system reports to simplify checking your work and to provide a
paper copy of system configuration
More → Print

F-4  System Programming Sequence



Programming Special Characters G
This appendix provides the special characters used in dialing sequences for
numbers dialed automatically. The characters allowed depend on the type of
telephone. Ask your System manager which special characters are needed
and when to use them.
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Programming Special Characters

Single-Line Telephones

Some dialing sequences need special characters. For example, you would
press and release either the Recall or Flash button or the switchhook to
insert a pause in a dialing sequence after a dial-out code to allow the system
to seize an outside line before dialing the number.

Table G-1.  Special Characters for Single-Line Telephones

Press... Means...
Recall, Flash Pause. Inserts 1.5 second pause in the dialing
or switchhook sequence. Multiple consecutive pauses are

allowed.

# End of Dialing. Used to signal the end of the
dialing sequence or to separate group digits,
e.g., account code from number dialed.
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Programming Special Characters

Analog Multiline Telephones

Some dialing sequences need special characters. For example, you would
press Hold to insert a pause (p) after the dial-out code in a dialing sequence
to allow the system to seize an outside line before dialing the number. A
pause can also be used to separate a phone number from an extension
number.

Table G-2.  Special Characters for Analog Multiline Telephones

Press... See*... Means...
Drop† s Stop. Inserts a stop within a sequence of

automatically dialed numbers, For example, an
outside Auto Dial button may be programmed with
a password then a Stop, followed by a phone
number. To use Auto Dial with a Stop in the
sequence, press the button to dial the password,
listen for the dialing and connection, and press the
button again to dial the phone number.

Hold p

Conference† f

## #

Pause. Inserts 1.5 second pause in the dialing
sequence. Multiple consecutive pauses are
allowed.

Flash. Sends a switchhook flash. Must be the first
entry in the dialing sequence.

End of Dialing for Auto Dial buttons. Used at the
end of a dialing sequence to indicate you have
finished dialing or to separate one group of dialed
digits from another.

# # End of Dialing. Used at the end of a dialing
sequence to indicate you have finished dialing or to
separate one group of dialed digits from another.

* Display phones only.
† Not available on MLC-5 cordless phones.
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Programming Special Characters

MLX Non-Display Telephone

Some dialing sequences need special characters. For example, you would
press Hold to insert a pause in a dialing sequence after a dial-out code to
allow the system to seize an outside line before dialing the number. A pause
can also be used to separate a phone number from an extension number.

Table G-3.  Special Characters for MLX Non-Display Telephone

Press... Means...
Drop Stop. Halts the dialing sequence to allow the

system to respond.

Hold Pause. Inserts 1.5 second pause in the dialing
sequence. Multiple consecutive pauses are
allowed.

Conf Flash. Sends a switchhook flash. Must be
first entry in the dialing sequence.

## End of Dialing for Extension Programming
Used at the end of a dialing sequence to
indicate you have finished dialing or to separate
one group of dialed digits from another, for
example, account codes from number dialed.

the

only.

# End of Dialing. Used to signal the end of the
dialing sequence or to separate group digits,
for example, account code from number dialed.

G-4  MLX Non-Display Telephone



Programming Special Characters

MLX Display Telephones

When you program Personal Directory listings, Auto Dial buttons, or Personal
Speed Dial codes, you are storing a sequence of numbers to be dialed
automatically.

Some dialing sequences need special characters. For example, you would
press Hold to insert a pause in a dialing sequence after a dial-out code to
allow the system to seize an outside line before dialing the number. A pause
can also be used to separate a phone number from an extension number.

Table G-4.  Special Characters for MLX Display Telephones

Press... See... Means...
Drop s Stop. Halts dialing sequence to allow for system

response.

Hold p Pause. Inserts 1.5 sec. pause in dial sequence.
Multiple consecutive pauses allowed.

Conf f Flash. Sends switchhook flash. Must be first entry
in sequence.

## # End of Dialing for Extension Programming only.
Used at the end of a dialing sequence to indicate
you have finished dialing or to separate one group
of dialed digits from another, for example, account
codes from number dialed.

# # End of Dialing. Used to signal end of dial
sequences or to separate group digits, for example,
account code from number dialed.
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Index

1S signaling 6-5
1 + 7 digit dialing

requirements 15-1 — 15-2
100D module 13, 5-2
2-digit numbering 2-1, 2-3
3-digit numbering 2-1, 2-3

A

Abbreviated Ring 12-5
Account Code Entry, Forced 11-9
Add Digits 7-7
Allowed lists 14-23 — 14-24, 14-31,

14-35
AMI zero code suppression 5-6
Analog multiline telephones

general instructions for
programming C-9

with simultaneous
voice/data 9-16, 19-3

with voice announce to busy 9-14
without built-in

speakerphones 9-12
Answer supervision time 6-8
ARS Restriction, extension

level 11-8
ARS tables 15-3
ASN, AT&T Switch Network 5-2
Assign allowed lists to

telephones 14-24
Assign disallowed lists to

telephones 14-26
Assign intercom or system access

buttons 9-8
Assign trunks or pools to

telephones 9-2

AUDIX Voice Power 4-6, 10-1, 10-8,
13-19

Autodial buttons 14-4
Automated Attendant 10-1, 10-8

Calling Group 20-3
Automatic Call Completion 12-15
Automatic Callback

interval 14-11
Remote Access 14-30

Automatic Hold, DLC 12-3
Automatic Hold/ Automatic

Release 12-6
Automatic Log In 13-19
Automatic Log Out 13-19
Automatic maintenance busy 1-9
Automatic Number Identification 8-9
Automatic or manual extended call

completion 12-15
Automatic Route Selection 1-7, 2-5,

4-18,  6-3, 15-1
ARS Restriction Level 11-8,

14-31, 14-35, 15-7
Automatic signaling start 6-3
Auxiliary Equipment 10-1

B

Barrier codes 14-27, 14-34
Basic system operating

conditions 1-1
B-channel groups 8-4
Behind switch mode 1-7, 14-21
Bipolar 8 Zero Suppression 5-6
BIS capability 9-12
Block Assignment, DID trunks 7-2
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Index

Block renumbering 2-7
Board renumbering 1-6
Built-in speakerphone 9-12
Buttons

console 4
diagrams D-1 — D-5

C

Cable loss 5-8
Call

Answer Calling Group 20-3
by Call Service table 8-23
by Call services 1-7
forwarding, remote 11-11
Management System (CMS) 3-1,

3-5, 4-6, 13-7, 14-12
park return time 14-9
pickup groups 13-2
Report 14-14
restrictions 11-4, 16-4

Remote Access 14-31, 14-35
transfer to outside numbers 4-6
type queue priority level 12-12
types by operator 12-10

Callback 4-11
Calls-in-queue alarms 13-17, 13-18
Calls-in-queue alert 12-9, 13-18
Camp-on return time 14-8
Centralized telephone

programming 6
Channel emulation 5-2
Channel service unit 5-10
Circular hunting pattern 13-11
Clock activation 5-9
Clock synchronization 5-9

CMS supervisor 3-6
Codes, feature, general instructions

for using C-3 — C-4
Cold start 1-2
Common-channel signaling 5-7
Conference 14-21
Console

overlay 5
programming 2-5

Copy call restrictions 11-5
Copy line/trunk assignments 9-6
Copy options for lines/trunks 4-20
Copy telephone number to send,

PRI 8-7
Counters, PRI 8-11 — 8-13
Cover buttons 14-10
Coverage

Delay Interval 13-6
Delay Ring 20-3
Group 20-3
patterns 4-12

D

D4 compatible frame 5-5
Data features 19-1
Data hunt groups 13-19
Data ports 13-19
Date, system 1-11
Dedicated feature buttons, general

instructions for using C-2, F-6
Default

local tables 15-3
toll tables 15-3

IN-2 Index



Index

Delay
Announcement 13-12
Ring 20-3
ring interval 14-10
start 6-3

Delete Digits 7-6
Dial

0 calls 12-10
0 table 15-12
Codes 14-21
mode, tie trunk 6-6
out code 11-3
plan routing 1-7, 8-8, 8-15
tone, inside 14-17

Dialed Number Identification Service
(DNIS) 6-3

DID calls to Invalid
Destination 12-10

DID trunks 1-7, 4-20, 7-1
add digits 7-7
block assignment 7-2
delect digits 7-6
disconnect time 7-4
expected digits 7-5
invalid destination 7-9
signaling 7-8
type 7-3, 1-7, 4-20

Digit absorption 15-8
Direct Station Selector (DSS) 2-9

page buttons 2-9
Direction, tie trunk 6-2
Disallowed lists 14-25 — 14-26,

14-31, 14-35
Disconnect

interval 4-10
signaling reliability 4-6, 11-11
time 6-9, 7-4

DLC operator automatic hold 12-3

DLC operator position 3-1, 3-5
Drop 14-21
DS1 facility 5-1 — 5-2
DSS buttons 14-4
DSS page button assignment 2-9

E

Elevate priority 12-8
E&M signal 6-5
Emergency Allowed List 16-4
Emulation 5-2
English 1-5, 11-2, 18-2
ES States 14-12
Exclusion List 16-4
Expected Digits 7-5
Extended Call Completion 12-15
Extended super frame 5-5
Extension

directory 17-2
Forced Idle 13
language 1-5, 11-2
programming 6
status 1-2, 13-7, 14-12
Trunk Idle 12

External Alert 13-18

F

Facility restriction level 15-7
Fax 10-5, 13-19

Response Calling Group 20-3
FCC registration 4-2
Feature codes, general instructions

for using C-3 — C-4
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Index

Features
programming C-7
using F-8, C-2 — C-4, F-6

Flexible numbering 2-1
Forced account code entry 11-9
Forward/Follow Me calls 12-10
Frame format 5-5, 8-2
Framing mode 5-2, 5-5
French 1-5, 11-2, 18-2

G

General Purpose Adapter
(GPA) 10-5

Generic
VMI group type 13-19
VMI ports 10-8

Ground-start trunks 1-7, 4-2, 11-11
Group calling 13-1, 17-5

calls-in-queue alarm
threshold 13-17

delay announcement 13-12
external alert for calls-in-queue ,

alarms 13-18
hunt type 13-11
labels 17-5
member assignments 13-7
message waiting indicator 13-16
optional features 13-10
overflow and threshold 13-14
trunk or pool assignments 13-9

Group calling labels 17-5
Group coverage 13-1

delay interval 13-6
member assignments 13-4
receiver 13-4, 13-13

Group paging 13-3
Group type 13-19

H

HFAI capability 9-12
Hold

disconnect interval 4-10
return 12-5
timer 12-5

operator 12-2
Home button 4
Host system dial codes 14-21
Hotel Mode 14-12
Hunt type 13-11
Hybrid/PBX mode 1-7

I

Idle line access 2-5
Idle states 11-14
Immediate start 6-3
Incoming routing, PRI 8-8
Information Service Calling

Group 20-3
Inside dial tone 14-17
Inspect

button 4
feature A-1, 4-20

Integrated Administration 20-1
Integrated Solution II/III 10-8
Integrated Voice Power 10-8
Integrated VMI Ports 10-8
Intercom buttons 9-8
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Index

Intercom or system access button
assignment 9-2

International calling 8-20
Invalid destination 7-9, 12-10, 14-19

J
Jack, system programming 1-3

K

K counter 8-11
Key mode 1-7

L

Label trunks 17-3
Labeling 17-1
Language 1-5

extension 11-2
report 18-2
SMDR 14-13

LED displays B-1
Line buttons 9-2 — 9-3
Line compensation 5-8
Linear hunting pattern 13-11
Lines and trunks 4-1
Listed directory number 2-5, 12-10
Loop-start trunks 4-2, 4-6, 4-10,

4-20
Loudspeaker page 9-2
Loudspeaker paging 10-2 — 10-3,

10-7

M

Maintenance
alarms 9-2, 10-2, 10-7
busy 1-9

Manual call completion 12-15
Menu

button 4
hierarchy A-1

MERLIN II Communications
System 2-1

MERLIN MAIL 4-6, 10-1, 10-8,
13-19

Message center operation 12-14
Message Drop Calling Group 20-3
Message waiting

fax 10-5
indicator 13-16

Microphone operation 11-10
MLC-5 9-3
MLX telephones

general programming
instructions C-2 — C-3, C-10 —
C-15

MLX-20L telephones 2 — 3, 6
Mode of operation 1-7
Modem, built-in 6
More button 4
Music-on-Hold 9-2, 10-1, 10-7, 14-6

N

N11 special numbers tables 15-10
N200 counter 8-11
N201 counter 8-11
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Index

Network selection tables 8-19
Network service 8-6
Next key F-1
Night service 16-1

with group assignment 16-2
with outward restriction 16-4
with time set 16-6

No ring 4-12
Numbering plan 2-3

O

One-touch
hold 14-4
transfer 12-15, 14-4
transfer/hold 14-4

Operator Automatic Hold 12-3
Operator features, optional 12-1
Operator hold timer 12-2
Operator positions 3-1 — 3-3

DLC 3-1, 3-5
primary 3-3 — 3-4
QCC 3-1, 3-4

Operator to receive call types 12-10
Operator-assisted calls 8-20
Optional

group-assigned features 13-1
operator features 12-1
telephone features 11-1

Other digits 15-9
Outmode Signaling for Loop/Ground

Start Trunks 4-3
Outward restriction 11-4, 14-31,

14-35
Overflow threshold 13-4
Overlay 5

P

Page buttons, DSS 2-9
Paging, group 13-3
Park 2-5
Park zone 2-9
Personal line 4-12
Phantom extensions 20-2
Pickup groups 13-2
Pool

button 9-2
dial-out code 11-3
routing 15-6
trunks 1-9

Pools 1-7, 4-18
Position busy backup 12-17
Posted message 17-4
PRI facilities 1-7, 5-2, 8-1 — 8-2,

15-13
B-channel groups 8-4
call by call service table 8-23 —

8-24
copy telephone number to

send 8-7
dial plan routing 8-15 — 8-18
incoming routing 8-8
network selection tables 8-19
network service 8-6
special services table 8-20 — 8-22
telephone number 8-3
telephone number to send 8-9
terminal equipment identifier 8-14
test telephone number 8-10
timers and counters 8-11 — 8-13

Primary operator 2-3, 3-4
Primary operator position 3-3 — 3-4
Principal user for personal line 4-12
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Index

Print report language 1-5
Print reports 18-1
Priority, elevate 12-8
Priority level, call type 12-12
Procedure

causing system restart 1-6
for qualified support personnel

only 1-2, 1-6
Hybrid/PBX only 4-14, 4-16, 4-18,

7-1 — 7-9, 8-15, 15-2 — 15-3,
15-5 — 15-10, 15-12 — 15-13

Integrated Administration 13-4,
13-6, 13-13, 17-2 — 17-6

Release
1.1 11-2, 14-13, 18-2
1,1, 2.0 only 1-5
2.0 11-2, 14-13, 18-2, 20-1

Programming 6
basics 7-8
buttons C-2 — C-3, C-10 — C-15
console 2-5
how to begin F-1
menu options 9
sequence F-1 — F-4
special characters G-1 — G-6

Q

QCC features 1-7, 12-5 — 12-10,
12-12, 12-14 — 12-17

QCC operator
position 3-1, 3-4
to receive call types 12-10
to receive calls 4-16, 12-10

QCC optional features 12-4
QCC queue priority level 4-14,

12-12

Queue over threshold 12-7
Queue priority level 4-14

R

Recall timer 14-22
Redirect outside calls to unassigned

extension numbers 14-19
Reliable disconnect 4-6, 4-10
Reminder service cancel 14-18,

20-3
Remote access 2-5, 4-16, 14-27 —

14-28
automatic callback 14-30
barrier codes 14-34
trunk 10-2, 10-7
trunk assignment 14-29
with barrier codes 14-35
without barrier codes 14-31

Remote call forwarding 4-6, 4-12,
11-11

Renumbering 2-1 — 2-2
Reports 18-1
sample E-1 — E-38

Report language 18-2
Restart 1-2
Restriction

level, ARS 11-8
remote access 14-31, 14-35

Restrictions 11-4
Return ring interval 12-16
Robbed-bit signaling 5-7
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Rotary
line operation 4-5
signaling 4-3, 7-8
trunk digit transfer 4-5
trunks 6-6

Routing
by dial plan 8-8, 8-15
by line appearance 8-8

RS232 6

S

Select system numbering plan 2-3
Set up space numbering plan 2-1,

2-3
Signaling, DID 7-8
Signaling mode 5-7
Simultaneous voice and data 9-16,

19-3
Single renumbering 2-5
SMDR 1-12

call length 14-15
call report format 14-14
calls recorded on call

report 14-16
language 14-13
report language 1-5

Spanish 1-5, 11-2, 18-2
Speakerphone, built-in 9-12
Special

characters G-1 — G-6
extension numbers 2-12
numbers tables 15-10
services tables 8-20

Speed dial directory 17-6
SPM 6

Start and stop times for
subpatterns 15-5

Start-up procedures 1-1
Subpatterns 15-5
System

access buttons 1-7, 9-8
busy 11
date 1-11
features 14-1
language 1-5
operator position 3-1
programming 6

hierarchy A-1
jack 1-3
position assignment 1-3

renumbering 2-1 — 2-2
restart 1-2
speed dial directory 17-6
time 1-12

T

T1 5-2
T1 facilities 6-3
T200 timer 8-11
T203 timer 8-11
T303 timer 8-11
T305 timer 8-11
T308 timer 8-12
T309 timer 8-12
T310 timer 8-12
T313 timer 8-12
T316 timer 8-12
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Telephones 9-1
Features 9-1
MLX-20L  2 — 3
Number, PRI 8-3
Number to send, PRI 8-9
General feature use
instructions C-2 — C-4

General programming
instructions C-10

Terminal equipment identifier
(TEI) 8-14

Test telephone number, PRI 8-10
tie trunks 6-1, 4-20
answer supervision time 6-8
dial mode 6-6
dial tone 6-7
direction 6-2
disconnect time 6-9
type 6-3

Time, system 1-12
Timed flash 14-22
Timers and counters 8-11

factory settings 8-13
Toll

prefix 4-8
restriction 14-31, 14-35
type 4-8

Touch-tone signaling 4-3, 7-8
Transfer 14-21

audible 14-6
one-touch 14-4
return time 14-3, 20-3
type of 14-7

Trunk
buttons 9-3
type, DID 7-3

Trunks
labeling 17-3

to pools assignment 4-18
Type

5 signaling 6-5
group 13-19
of DS1 facility 5-2, 8-2
of transfer 14-7
of trunk 4-2

U
Unassigned extension numbers,

redirect outside calls 14-19
Unreliable disconnect 4-6
Unrestricted 14-31, 14-35

V
VMI ports 10-8
VMS transfer return interval 20-3
Voice

announce to busy 9-14
and/or data routing 15-13
mail calling group 20-3
messaging system (VMS) 10-1,

10-8, 13-19
Voice/data 9-16, 19-3

W
Wink start 6-3

Z

Zero code suppression 5-2, 5-6, 8-2
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